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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and
conditions of this legal disclaimer before you read or use this document. If you have
read or used this document, it shall be deemed as your total acceptance of this legal

disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website
or other Alibaba Cloud-authorized channels, and use this document for your
own legal business activities only. The content of this document is considered
confidential information of Alibaba Cloud. You shall strictly abide by the

confidentiality obligations. No part of this document shall be disclosed or provided
to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted,
or disseminated by any organization, company, or individual in any form or by any
means without the prior written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades
, adjustments, or other reasons. Alibaba Cloud reserves the right to modify
the content of this document without notice and the updated versions of this

document will be occasionally released through Alibaba Cloud-authorized
channels. You shall pay attention to the version changes of this document as they
occur and download and obtain the most up-to-date version of this document from
Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud
products and services. Alibaba Cloud provides the document in the context that
Alibaba Cloud products and services are provided on an "as is", "with all faults
" and "as available" basis. Alibaba Cloud makes every effort to provide relevant
operational guidance based on existing technologies. However, Alibaba Cloud
hereby makes a clear statement that it in no way guarantees the accuracy, integrity
, applicability, and reliability of the content of this document, either explicitly
or implicitly. Alibaba Cloud shall not bear any liability for any errors or financial
losses incurred by any organizations, companies, or individuals arising from
their download, use, or trust in this document. Alibaba Cloud shall not, under any
circumstances, bear responsibility for any indirect, consequential, exemplary,

incidental, special, or punitive damages, including lost profits arising from the use



or trust in this document, even if Alibaba Cloud has been notified of the possibility
of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to
works, products, images, archives, information, materials, website architecture,
website graphic layout, and webpage design, are intellectual property of Alibaba

Cloud and/or its affiliates. This intellectual property includes, but is not limited
to, trademark rights, patent rights, copyrights, and trade secrets. No part of the
Alibaba Cloud website, product programs, or content shall be used, modified

, reproduced, publicly transmitted, changed, disseminated, distributed, or
published without the prior written consent of Alibaba Cloud and/or its affiliates

. The names owned by Alibaba Cloud shall not be used, published, or reproduced
for marketing, advertising, promotion, or other purposes without the prior written
consent of Alibaba Cloud. The names owned by Alibaba Cloud include, but are
not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other brands of Alibaba
Cloud and/or its affiliates, which appear separately or in combination, as well as
the auxiliary signs and patterns of the preceding brands, or anything similar to
the company names, trade names, trademarks, product or service names, domain
names, patterns, logos, marks, signs, or special descriptions that third parties

identify as Alibaba Cloud and/or its affiliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions

Table -1: Style conventions

Style Description Example
This warning information
indicates a situation that will Danger:
cause major system changes, Resetting will result in the loss of
faults, physical injuries, and other | user configuration data.
adverse results.
This warning information
indicates a situation that may . Warning:
cause major system changes, Restarting will cause business
faults, physical injuries, and other | interruption. About 10 minutes are
adverse results. required to restore business.
This indicates warning informatio
n, supplementary instructions, Notice:
and other content that the user Take the necessary precautions
must understand. to save exported data containing

sensitive information.

This indicates supplemental
instructions, best practices, tips, Note:
and other content that is good to | You can use Ctrl + A to select all
know for the user. files.

> Multi-level menu cascade. Settings > Network > Set network

type

Bold It is used for buttons, menus Click OK.
, page names, and other Ul
elements.

Courier |Itis used for commands. Runthe cd / d C :/ windows
font command to enter the Windows
system folder.

Italics |Itisused for parameters and bae log list --
variables. instanceid Instance_ID

[] or [a|b] |Itindicates that it is a optional ipconfig [-all|-t]
value, and only one item can be
selected.




Style

Description

Example

{} or {a|b}

It indicates that it is a required
value, and only one item can be
selected.

swich {stand | slave}
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1 Console

1.1 Features

1.1.1 Console overview

After you log on to the DataV console, you can edit visualization projects and manage

your data sources.

WELCOME TO DATAV

Empowering Intelligent City

&t Data Sources

= Project Folders MNew Project(s) Available

All Projects

Ungrouped

+

Create Project

Unpublished

Menu bar

&t Data Sources

You can manage projects and data sources by clicking the corresponding tabs on the

top navigation bar. If you are a Developer Edition user, click Widgets to view all the

widgets created by you.



My visualizations

= Project Folders

New Project(s) Available Q. SortbyData ..~

Al Projects

Ungrouped

On the Projects page, you can:

- view all the visualization projects created by you, and the number of projects
available. The total number of projects you can create varies with the editions. For

more information about editions, see What is DataV.
- group your projects.
- sort your projects.

- search for projects by name.
Help

The Help section provides you with more information about DataV. You can read
DataV documents and open a ticket by clicking Docs and Service Request to learn

more about DataV’ s features and usage techniques..
3, U daiw = Help=~
2 / Docs

- — R

[F] Service Request
L 4

E] Community & Forum

L
t.

1.1.2 Manage your workspaces
This topic describes how to use the workspace management function of DataV to
manage different projects and user permissions between different projects. Each

workspace corresponds to a DataV console.
Use workspaces

1. Log on to the DataV console.


https://datav.alibabacloud.com/

2. From the Default Workspace drop-down list in the upper-right corner of the page,

select Workspace Management.

& Default Workspace =

test?

Default Workspace

3. Create and configure a workspace.

On the Workspaces page, you can manage workspaces. Specifically, you can switch,
create, view, rename, or delete a workspace as needed. For detailed information,

see Manage workspaces.

After you create and configure a workspace, you can return to the DataV console

and refresh the console page.

E] Note:

After you refresh the console page for the first time, the default workspace is
displayed.
4. Select a workspace from the Default Workspace drop-down list and switch between

workspaces.

You can also copy projects from one workspace to another. For detailed

information, see Copy a project to the other workspace.

Manage workspaces

On the Workspaces page, you can:



- Switch between different workspaces by clicking the workspace name.

Workspaces

My Workspace Basic Information

Workspacel Project Quota

Default Wor... 0 +  Left Quota: C

Favorite Quota

L t Left Quota: 0

- Create a workspace by following these steps:

-

Note:
By default, the Basic Edition of DataV provides one workspace, the Enterprise
Edition allows you to create one workspace, and the Developer Edition allows you

to create four workspaces.

1. Click + on the right of My Workspace.

2. Enter the following information:

- Name: Enter a name for the workspace.

-

Note:
The workspace name must be unique.

- Project Quota: Click + or -, or enter a value to adjust the project quota.

-

Note:
The Enterprise Edition allows you to create 20 projects, and the Developer
Edition allows you to create 40 projects.
- Favorite Quota: Click + or -, or enter a value to adjust the quota of your

favorite projects.

-

Note:



The Enterprise Edition allows you to add 20 projects to your favorites, and

the Developer Edition allows you to add 40 projects to your favorites.

3. Finish or cancel creating the workspace.

- To finish creating the workspace, click Create.

- To cancel creating the workspace, click Cancel.

Workspaces

My Workspace + Basic Information

Workspacel Name

Default Wor...

Project Quota

e T Left Quota:

Favorite Quota

e T Left Quota:




- View and configure a workspace. Click the name of a workspace and configure the

workspace by following these steps:
- Configure the basic information about the workspace.

Click + or -, or enter a value to set the Project Quota and Favorite Quota.

- Manage workspace members.
The permissions of different members are as follows.

Permission Alibaba Cloud account RAM administrator RAM developer
Access the management page of a
waorkspace

Create a workspace

Delete a workspace

Adjust the project quota in a workspace
Adjust the favorite quota in a workspace
Manage members in a workspace
Delete a project in a workspace

Delete a favorite project in a workspace
Delete a data source in a workspace
Delete a group in a workspace

Delete other data sources in a workspace
Create a project in a workspace

Edit (add, delete, or share) a projectin a
warkspace

Rename a project in a workspace
Create or edit other resourcesina
waorkspace

Grant permission to a widget package
Upload a widget to a widget package

A

= = = =
| | [ | | [ | | =

- =
- =

=< =l =

B Add a RAM administrator. In the Administrator field, enter the username or
the ID of the target RAM user and click Add.

B Add a RAM developer. In the Developer field, enter the username or the ID of
the target RAM user and click Add.

B Delete a workspace member. In the member list, locate the target workspace

member and click the Delete icon.



Workspaces

My Workspace -+ Basic Information

Workspacel Project Quota

Default Wor... - U +  Left Quota:

Favorite Quota

B E T Left Quota:

Members

Administrator

Search name or aliyunld

Developer

Search name or aliyunld

- Rename a workspace. Move the pointer over the workspace name and click the

Edit icon.

My Workspace

Default Wor...

)

_ [:] Note:



Once a workspace is deleted, it cannot be recovered.

Delete a workspace. Move the pointer over the workspace name and click the

Delete icon.

ces

My Workspace

Default Wor...

E] Note:

Only the Alibaba Cloud account administrator has the permission to delete
a workspace. Before the administrator deletes a workspace, make sure the

workspace does not have any projects, data sources, groups, or favorite widgets.
Copy a project to the other workspace

In the DataV console, you can copy a project from a workspace to another workspace

by following these steps:

1. Move the pointer over the target project and click Copy to Workspace.

Project(s) to Be Created

_I_

Create Project

Copy To Workspace

Unpublished




2. Select the target workspace and click OK.

Workspacel

Workspace2

3. Switch to the target workspace and view the project that you have copied.

() Data Sources i Resources

= Project Folders Project(s) to Be Created

All

Ungrouped

+

Create Project

testbyquwenjie Unpublished

1.1.3 Project folders

The project grouping feature allows you to reorganize DataV projects for improved

functionality.
Procedure

1. Log on to the DataV console, to go to the Projects pane.
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2. Click + on the right side of Project Folders.

= Project Folders

All Projects

Ungrouped

3. Enter a group name to create a new group.

E] Note:

To delete a group, click the trash bin icon. Associated projects will then be

ungrouped.

= Project Folders

All Projects

Ungrouped

TEST




4. Move the pointer over the project you want to group, click the four arrows icon,

and drag the project to the group that has been created on the left side of the page.

= Project Folders New Project(s) Available

All Projects
Ungrouped

TEST

+

Create Project

Move

test13 Unpublished

5. Click OK.

Are you sure to move this project to "TEST™?

6. Click the group to view the projects that it contains.

All Projects
Ungrouped

TEST

+

Create Project

Unpublished

1.1.4 Sort projects

DataV updates enable you to sort projects by Name, Time Created, and Time Modified.

Procedure

1. Log on to the DataV console to go to the Projects panel.
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2. Move the pointer over the Sort by Data Modified (by default) button on the far right
of the page, and click a sort type.

a

Sort by Name
Sort by Time Created

Sort by Data Modified

abby test Unpublished

E] Note:

DataV provides three types of sorting methods Name, Time Created, and Data
Modified.

1.1.5 Search for projects by name
The DataV provides a search box. You can search for a big screen project by entering

its name.
Procedure

1. Log on to the DataV console to go to the Projects pane.
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2. In the search box on the right side of the page, enter the name of the project that

you want to find.

The project with the corresponding name is matched, as shown in the following

figure.

Q, | [Sortby Data ...~

test13 Unpublished

1.2 Editor overview

In the Projects pane, select a project. On the project editor page, you can view a

project, edit a project, and manage various widgets.

Big Data DevOps Monitor Dashboard

Total Task Volume. Tasks Taking Long Response Time Tasks Taking Most Computing Resources

232,425 =
N

20189910 1001:57

Disk Space and Utilization Ratio
342 Page Fit Type Fit Width

Full Screen

Total Data Sheet Volume Average Data Sheat Capacity
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Average Data Sheet Size
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number-title-flo..

main-title_90LYO
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The Layers list helps you view and manage the order of layers for your project. In
DataV, each widget added in a canvas forms a layer. You can manually adjust the

position of each widget.
Toolbar

You can view the toolbar at the top of the editor page. You can use functions provided

in the toolbar to modify, enhance, preview, and publish your project.

Big Data DevOps Monitor Dashboard
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Page settings

To view the Page Settings pane, click the blank area of a canvas, and the Page Settings

pane is displayed on the right side of the page.

Big Data DevOps Monitor Dashboard

Total Task Volume. Tasks Taking Long Response Time Tasks Taking Most Computing Resources

)

20189910 1001:57

2y

T3.42% 7342% Page Fit Type it Width | | Fit Height

J

Total Data Sheet Volume Average Data Sheat Capacity Mast Frequantly Visited Nodes.
232,425 232,425

Average Data Sheet Size

232,425

In the Page Settings pane, you can adjust the page and grid size of a project, set a
background image, and select a Fit Type. Enterprise Edition users can remove the

DataV watermark, an exclusive function for Enterprise Edition.
Page size

You can set the screen resolution in the Page  Size field. The default
resolution is 1920 x 1080.

Background image

You can upload an image of up to 1 MB as the background of a project.

Fit type

The selection of the zoom mode corresponds to how a project is displayed.

If your project cannot be displayed on standard screen sizes, we recommend that
you use Full Screen mode.

Grid size

The grid size is the smallest movement unit of a widget on a canvas. The borders
of widgets automatically expand to the edges of grids based on the grid size. The

smallest smooth movement value is 1 pixel.



- Project cover
You can click Capture Thumbnail to automatically capture an image as a thumbnail

on the My Project page.

- DataV watermark (Enterprise Edition)

Deselect to remove the DataV watermark.

Widget settings

On the right-side of the page, click any widget on a canvas to view Style, Data, and

Interaction tabs. Here, you can configure the style and data sources of each widget.
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2 Manage projects

2.1 Create a project

You can create up to five projects using DataV Basic Edition and up to 20 projects

using our DataV Enterprise Edition.

1. Log on to the DataV console.

2. To create a new visualization project select Projects > Create Project.

To display all your projects and all available projects click All Projects.

| T
A | — herh L= )

& Data Sources

= Project Folders New Project(s) Available

All Projects
Ungrouped

TEST

+

Create Project

Unpublished abby test Unpublished test coms_cop.. Unpublished

8 Published test-yaxis Unpublished test11 Unpublished S 8 Published

3. Select a template from the list on the left side of the page.

Choose a Template

5’| Global Trade Ove
= | rview
Scale 153
| 1'BB@x12epx

Global Logistics
Scale 153
Ll | 1EEEXIPEDRX

Data Billboard
Scale 43
1B24x1E8pX

| DevOps Monitor
Scale 1639
1S22x1882px

-.| 192@x12EBpX

Global Business
Overview

Scale 153
1S2@X128BpX

2016 11/11 Glob
al Shopping Fe...
Scale 1563

1822x1888px

- | Internet Finance
Overview Click to start building your own dashboard!
Scale 159
1S2@X1B88BpX
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4. Click Create.

5. Enter the name of a visualization project and click Create.

The project editor page will be displayed.

2.2 Edit a project
Procedure
1. Log on to the DataV console.

2. Click Projects to enter the visualization project management page.

3. Click Edit to enter the visualization project editor page.

& Data Sources
e

= Project Folders =+ New Project(s) Available

All Projects 42
Ungrouped 2

TEST 1

+

Create Project

test coms_cop... Unpublished

test11

2.3 Rename a project

Procedure

1. Log on to the DataV console.

2. Click Projects to enter the visualization project management page.
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3. Select a project, and then click the pen icon or project name to modify.

&5 Data Sources

= Project Folders New Project(s) Available

All Projects

Ungrouped

TEST
+

Create Project

Unpublished

4. Enter a new name.

E] Note:

The name of projects can be the same.

2.4 Transfer a project to other users
This function is only available for users of the Enterprise Edition or later editions.
Procedure

1. Log on to the DataV console.
2. Click Projects to enter the visualization project management page.

3. Select a visualization application.
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4. Click the Transfer Project icon.

5o Data Sources

= Project Folders New Project(s) Available

All Projects
Ungrouped

TEST

+

Create Project
Transfer Project

tesi13 Unpublished

5. Enter the Transfer ID of the other user.

Transfer ID

Enter the other user' transfer 1D (i

Enter the other user's authenticaton code{User
authentication code can be found under User Info menu at
top right conner.) You can directly transfer a copy of
current project to another user’s account, with both style
and data configuration.To avoid data leakage, please
check the code carefully.(This function is only available in
enterprise edition or above.)

Copy history

Transfer ID

6. Click Copy to transfer the copy of a project to the other user.



2.5 Duplicate a project
The duplicate function will generate a project copy named “xxx_Copy” and has the

following functions:

- Create projects with the same style.
- Use copies for modifications and updates in a development or testing environment

without interrupting the online application.
Procedure

1. Log on to the DataV console.
2. Click Projects to enter the visualization project management page.

3. Select a visualization project and click Duplicate.

&5 Data Sources

= Project Folders New Project(s) Available

All Projects
Ungrouped

TEST

+

Create Project

Unpublished

2.6 Delete a project

@ Notice:

A deleted project cannot be restored. Proceed with caution before deleting a project.

Procedure

1. Log on to the DataV console.
2. Click Projects to enter the visualization project management page.

3. Select a visualization project.
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4. Click the trash bin icon in the upper right corner of a selected project to delete the

project.

&b Data Sources

= Project Folders New Project(s) Available

All Projects
Ungrouped

TEST

_|_

Create Project
Delete

Unpublished

2.7 Preview a project

Procedure

1. Log on to the DataV console.
2. Click Projects to enter the visualization project management page.

3. Select a visualization project and then click Preview.

& Data Sources

= Project Folders New Project(s) Available

All Projects
Ungrouped

TEST

_|_

Create Project

$

test13 Unpublished

2.8 Publish a project

Procedure

1. Log on to the DataV console.
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2. Click Projects.
3. Select a project and click Publish.

& Data Sources

= Project Folders New Project(s) Available

All Projects

=
U ngrouped =
Publish

TEST

_|_

Create Project

Unpublished




4. Turn on the Publish button. Other users have access to a project through the

Sharing URL shown in the following sharing link.

Publish:& @ Tutorial

Part 1. Sharing Configuration
Sharing URL

Password Protection :I| Token Protection 'E:'

. Click to enable password protection

Part 2. History Verisons *I:

Select a version to share:
Type

Shared Current Version

E] Note:

If the Publish switch is turned on, it indicates that the project has been published,
otherwise the project is not published.

5. Before publishing a project, you can set Sharing Configuration and History Versions.
Sharing configuration

A random sharing link is generated when the Publish button is turned on. This
sharing link changes each time it is turned on and the previous sharing link becomes

invalid immediately and cannot be restored.



The three modes of the publishing function are as follows:

- Public sharing
- Password protection sharing

- Token protection sharing

Select a mode that fits your needs to help internal and external users have access to

visualization projects.
Password protection sharing (for Enterprise Edition)

1. In the publish window, click Password Protection and turn on the button.

2. Enter a password. The password must contain at least 6 characters and satisfy the

following three conditions:

- Uppercase letters A to Z
- Lowercase letters a to z

- Arabic numerals 0 to 9

If a password is successfully set, The password has been set will be displayed,
otherwise the color of the password input box becomes red.

3. Choose whether to enable the Password/Token Expiration: 32 Hours button.

- When this verification mode is enabled, after a visitor enters a password and
successfully accesses a large screen, the visitor can access the large screen
again within 32 hours without the password. The visitor needs to re-enter the
password after 32 hours.

- When this verification mode is disabled, the visitor needs to re-enter the

password after one minute.

When the visitor attempts to access the URL again, the system requests the password.



This is a private project, please enter the password.

I

Token protection sharing (for Enterprise Edition)

If you want to integrate a project with your permission system, you can choose this
mode.

Log on to the DataV console.

Click Projects.

Select a project and click Publish.

Click Token Protection in the publish window and turn on the button.

AR o A

Choose whether to enable the Password/Token Expiration: 32 Hours button.

- When this verification mode is enabled, after a visitor successfully accesses a
large screen through a token verification, the visitor can access the large screen
within 32 hours without a token verification. The visitor needs to perform the
token verification again after 32 hours.

- When this verification mode is disabled, the visitor needs to perform the token

verification again after 1 minute.

When you enable Token Protection, DataV generates a token for you. You need to keep

it for future use.

When a visitor directly visits the page by using the page URL, the visitor receives an

Access Denied message, which means the access has been rejected.
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To enable visitors to open this page, follow these steps:

Note:
To prevent replay attacks, make sure that your server time is UTC +8. DataV only
provides one minute error, and if the time error exceeds one minute the validation

fails.

1. Publish a project and record the code of the project. This is the last part of the URL.
2. Connect the code and the current time, accurate to a millisecond (ms) with a

vertical bar (|).

3. Use the token to encrypt the preceding string through HMAC-SHA256 base64.

4. Name the time and the encrypted signature as _datav_time and _datav_signature
respectively.

5. Insert the time and the encrypted signature in the querystrin g oftheurl one

by one.

The example is as follows:

PHP:
<? php
$ token = " kBwoX9rFX9 v4zb0TOGjd _wr65DZ3P_ Ww ";
$ screenID = " 03dlb68fae b09671046d 1ef43f588c 33 ";
$ time = time ()* 1000 ;
$ stringToSi gn = $ screenID .' |'.$ time ;
$ signature = wurlencode ( base64_enc ode ( hash_hmac (' sha256 ',
$ stringToSi gn , $ token , true )));
$url =" http :// local . datav . aliyun . com : 9999 / share /".
$ screenID ."? _datav_tim e =".$ time ."& _datav_sig nature =".$
signature ;
?7 >

< +dframe width = 100 % height = 100 % src ="<? =$ url ? >"/>

NODE.]S:
const crypto = require (' crypto ');
var token = " Ev97TwOUSAt Jusc3Vsd90 2ngr_vfVFH 67 ";
var screenID =" 14c5448c00 ecde02b065 c231d1659f 38 ";
var time = Date . now ();
var stringToSi gn = screenID +'|'+ time ;
var signature = crypto . createHmac (' sha256 ', token ). update
( str ). digest (). toString (' base64 ');
var url =" http :// datav . aliyun . com / share /"+ screenID

+"? _datav_tim e ="+ time +"& _datav_sig nature ="+ encodeURIC
omponent ( signature );

Java:

package com . company ;
import java . security .x*;



import java . util . Date ;
import javax . crypto .x*;
import javax . crypto . spec . SecretKeyS pec ;
import org . apache . commons . codec . binary . Base64 ;
import java . net . URLEncoder ;
public class TokenTest {
public static String getSignedU rl ( String screenID ,
String token ){

Date date = new Date ();

Long time = date . getTime ();

String stringToSi gn = screenID + "|" + time ;

String signature = HMACSHA256 ( stringToSi gn . getBytes
(), token . getBytes ());

String url =" http :// datav . aliyun . com / share /"+

screenID +"? _datav_tim e ="+ time +"& _datav_sig nature ="+
signature ;
return url ;

}

[ *x*
* Sha405 encryption with Java Native Summary
* @ Param STR encrypted message

* @ return

*/
public static String HMACSHA256 ( byte [] data , byte []
key )
{
try {
SecretKeyS pec signingKey = new SecretKeyS pec (
key , " HmacSHA256 ");
Mac mac = Mac . getInstanc e (" HmacSHA256 ");

mac . init ( signingKey );
return URLEncoder . encode ( byte2Base6 4 ( mac
doFinal ( data )));
} catch ( NoSuchAlgo rithmExcep tion e ) {
e . printStack Trace ();
} catch ( InvalidKey Exception e ) {
e . printStack Trace ();

return null ;

}
private static String byte2Base6 4 ( byte [] bytes ){
return Base64 . encodeBase 64String ( bytes );
}

public static  void main ( String [] args ) throws
Exception {
System . out . println ( getSignedU rl (" screenId ", "
token "));

}
}
History versions (unavailable for Basic Edition)
A snapshot of the project content is taken when creating a version. Any edits to the

archived project content cannot be synchronized to history snapshots, but can be

used as a backup for previewing stable versions.

When the history snapshot feature is enabled for the first time, it is defaulted to
Current Version as shown in the following figure. Refresh the shared link to see the

current version.



Publish: . @ Tutorial

Part 1. Sharing Configuration
Sharing URL

Password Protection 'Il Token Protection ':B'

. Click to enable password protection

Part 2. History Verisons ®

Select a version to share:

Status Type

Shared Current Version

E] Note:

The history versions can be switched with each other. The rollback feature is not

supported.
1. Click Create Version. The current project configurations are saved as a snapshot.

- Enter a note in the Note column.
- The snapshot data is still retained when the Publish feature is disabled.

2. To add new snapshots click Create Version again. Currently only three valid

snapshots can be saved.

3. To delete extra snapshots click Delete.



4. To switch among snapshots and the real-time version , select a radio button in the

Status column, as shown in the following figure.

Password Protection ‘I'l Token Protection 'fz'

. Click to generate a random token
Part 2. History Verisons *I:
Select a version to share:
Type
Current Version

Shared

2018/8/28 F4:57:26 p
Snapshot =

5. To view the project content of the selected snapshot version, refresh the sharing

page.



3 Manage data sources

3.1 Database whitelist settings

Before you can add a data source, you must configure a whitelist for your database to

ensure that DataV has access to it.

- If you are using a data source from Alibaba Cloud RDS database, see Set whitelist.
Add the following IP addresses to the whitelist of your RDS database.

- If you are using a data source from Alibaba Cloud ECS database, you must add
the following IP addresses to the whitelist of the ECS security group rules, system
firewalls, and your database.

- If you are using a data source from the database on a local physical machine, you
must add the following IP addresses to the whitelist of the system firewalls of this

physical machine, the network firewalls, and your database.

According to your database connection scenarios, add following IP addresses to the

whitelist of your database.
Singapore
- Internet:

- 47.88.235.235/0
- 47.74.136.56/0
- 47.88.250.141/0
- 47.88.235.217/0
- 47.74.136.64/0
- 47.74.136.22/0
- 47.74.136.12/0
- 47.88.235.207/0
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- Intranet classic network (you must modify 11 network segment routing):

11.193.8.8/0

- 11.192.152.94/0
- 11.193.8.55/0

- 11.193.8.59/0

- 10.152.165.219/0
- 11.192.152.89/0
- 11.192.152.117/0
- 11.193.8.60/0

- Intranet VPC network:
100.104.13.0/24
Malaysia
- Internet:

47.254.212.25/0

- Intranet classic network:

11.193.189.75/0
11.193.189.69/0
11.193.189.73/0
11.193.189.72/0

- Intranet VPC network
100.104.133.64/26
Japan (Tokyo)
- Internet:

- 47.91.9.73/0
- 47.91.13.92/0
- 47.91.9.1/0

- 47.91.9.42/0



- Intranet classic network:

11.192.149.155/0
11.192.149.118/0
11.192.147.75/0
11.192.149.66/0

- Intranet VPC network:
100.104.175.0/24
Germany
- Internet:

- 47.91.83.106/0
- 47.91.82.104/0
- 47.91.84.120/0
- 47.91.84.16/0
- 47.91.84.36/0

- Intranet classic network

- 11.192.169.2/0

- 11.192.168.143/0

- 11.193.107.16/0

- 11.192.170.80/0

- 11.192.170.221/0
- Intranet VPC:

100.104.244.192/26
Solution to disconnection of 11 network segments.

If you encounter the disconnection of 11 network segments, execute the following

command to add arouterin / etc / rc . local .

sudo route add - net 11 .06 .0 .0/ 8 gw 10 . 152 . 28 .
247

Note:
The IP address behind gw is the server gateway.



If the problem is unresolved, you can open a ticket and send it to ECS to inform
Alibaba Cloud technical support engineers that the 11 network segments are unable

to access your server.

3.2 Add data sources

3.2.1 Overview
Log on to the DataV console, and select Data Sources in the left-side navigation pane to
manage data sources.

DataV supports access to the following data sources:

- Database

- CSV file and static JSON
- API

- Others

Databases
DataV supports the following types of databases:

- RDS for MySQL

* RDS for PostgreSQL

* RDS for SQLServer

+ Table Store

* Oracle

+ MySQL-compatible database
If you are not using Alibaba Cloud and want to connect DataV to your own database
, you must use the Internet IP address of the database to establish connection. We

currently do not support IP whitelists. We recommend using an Alibaba Cloud

database connection agent tool provide if you have any security concerns.
CSV and Static JSON
DataV supports the following types of static data:

- CSVfile

- Static JSON
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DataV currently does not support reading large data files from other file storage you

may have.
APIs
DataV supports the following types of APIs as data sources:
- POP API

- Alibaba Cloud API Gateway

You can directly copy and paste an API address into the Data configuration panel. If

your API has an authentication process, you must encapsulate the API in Alibaba Cloud

API Gateway, and access it through configurations of Alibaba Cloud API gateway.


https://www.alibabacloud.com/product/api-gateway/
https://www.alibabacloud.com/product/api-gateway/
https://www.alibabacloud.com/product/api-gateway/

—
-

Basic Line Chart

® Field not found

® Field not found

= Optional

Data Source Type

API

URL :

Configure callback parameter to URL, for
instance: http://apitest?value=:value

Initiate a request from a server (HTTP
proxy )

Cookie required (For use when proxy is
not selected and cookie is required)

Data filter:

Auto Data Request: Every




Others

DataV data proxy service provides an open source database proxy service for you to
deploy on your ECS. The data proxy service reduces the risks that may arise from the

exposure of the Internet IP address of your database.

For more information about the deployment and installation of DataV data proxy

services, see DataV proxy configuration in Linux.



3.2.2 Add RDS for MySQL

RDS for MySQL for intranet
- Procedure

1. Log on to the DataV console and select Data Sources > Add Source.
2. Select RDS for MySQL from the Typedrop-down list.

3. Click the secondary drop-down list and select Intranet.

Type

RDS for MySQL

Intranet north east

Intranet

Mame

4. Enter the database information in the New Data Source dialog box.

Database type connections for Alibaba Cloud intranet IP connections of East
China 1, East China 2, North China 2 and Internet IP connections are currently

supported. IP whitelists are not supported.

If you want to create a new database, see Create a Database.
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Type

RDS for MySQ

Intranet north east

- Name: Displays the name of the data source.

- Host: The URL of your database. This cannot be the URL of your official

website or your local IP. It must be a URL that the DataV server can use to



access your database through the Internet or intranet from the Alibaba Cloud

data.
- Username: The username that you use to log on to your database.
- Password: The password that you use to authenticate your database account.
- Port: The IP address port number of your database.

- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.

. Click OK when the connection test is verified.

When a data source is added, it will be displayed in the data source list.



RDS for MySQL (Internet)
- Procedure

1. Log on to the DataV console and select Data Sources > Add Source.
2. Select RDS for MySQL from the Type drop-down list.

3. Click the secondary drop-down list and select Internet.

If you want to set an Internet address, see Set Internet and intranet Address.

4. Enter the database information in the New Data Source dialog box.

Type

RDS for My5Q)

Internet

Port

3306

Database

- Name: Displays the name of the data source.

- Host: The URL of your database. This cannot be the URL of your official

website or your local IP. It must be a URL that the DataV server can use to
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access your database through the Internet or intranet from the Alibaba Cloud

data.
- Username: The username that you use to log on to your database.
- Password: The password that you use to authenticate your database account.
- Port: The IP address port number of your database.

- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.

. Click OK when the connection test is verified.

When a data source is added, it will be displayed in the data source list.



3.2.3 Add RDS for PostgreSQL

RDS for PostgreSQL (for intranet)
- Procedure

1. Log on to the DataV console and select Data Sources > Add Source.
2. Select RDS for PostgreSQL from the Type drop-down list.
3. Click the secondary drop-down list and select Intranet.

4. Enter the database information.

If you want to create a new database, see Create a Database.

Type

RDS for PostgreSQL

Intranet north east

- Name: Displays the name of the data source.
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- Host: The URL of your database. This cannot be the URL of your official
website or your local IP. It must be a URL that the DataV server can use to
access your database through the Internet or intranet from the Alibaba Cloud

data.
- Username: The username that you use to log on to your database.
- Password: The password that you use to authenticate your database account.
- Port: The IP address port number of your database.

- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source
connection automatically.

. Click OK when the connection test is verified.

When a data source is added, it will be displayed in the data source list.



RDS for PostgreSQL (Internet)
- Procedure

Log on to the DataV console and select Data Sources > Add Source.
Select RDS for PostgreSQL from the Type drop-down list.

Click the secondary drop-down list and select Internet.

b=

Enter the database information.

If you want to create a new database, see Create a Database.

Type

RDS for PostgreSQL

Internet

Database

- Name: Displays the name of the data source.

- Host: The URL of your database. This cannot be the URL of your official

website or your local IP. It must be a URL that the DataV server can use to
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access your database through the Internet or intranet from the Alibaba Cloud

data.
- Username: The username that you use to log on to your database.
- Password: The password that you use to authenticate your database account.
- Port: The IP address port number of your database.

- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.

. Click OK when the connection test is verified.

When a data source is added, it will be displayed in the data source list.



3.2.4 Add RDS for SQLServer

RDS for SQLServer (intranet)
- Procedure

1. Log on to the DataV console and select Data Sources > Add Source.
2. Select RDS for SQLServer from the Type drop-down list.
3. Click the secondary drop-down list and select Intranet.

4. Enter the database information.

Type

RDS for SQLServer

Intranet north east

Username

Database

- Name: Displays the name of the data source.
- Host: The URL of your database. This cannot be the URL of your official

website or your local IP. It must be a URL that the DataV server can use to
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access your database through the Internet or intranet from the Alibaba Cloud

data.
- Username: The username that you use to log on to your database.
- Password: The password that you use to authenticate your database account.
- Port: The IP address port number of your database.

- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.

. Click OK when the connection test is verified.

When a data source is added, it will be displayed in the data source list.



RDS for SQLServer (Internet)
- Procedure

1. Log on to the DataV console and select Data Sources > Add Source.
2. Select RDS for SQLServer from the Type drop-down list.
3. Click the secondary drop-down list and select Internet.

4. Enter the database information.

Type

RDS for SQLServer

Internet

Database

- Name: Displays the name of the data source.

- Host: The URL of your database. This cannot be the URL of your official

website or your local IP. It must be a URL that the DataV server can use to
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access your database through the Internet or intranet from the Alibaba Cloud

data.

Username: The username that you use to log on to your database.

Password: The password that you use to authenticate your database account.
Port: The IP address port number of your database.

Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.

5. Click OK when the connection test is verified.

When a data source is added, it will be displayed in the data source list.

3.2.5 Add compatible MySQL

Procedure

1. Log on to the DataV console, and select Data Sources > Add Source.

2. Select MySQL Compatible Database from the Type drop-down list.
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3. Enter the database information.

Type

MySQL Compatible Database

Mame

insecureAuth

- Name: Displays the name of the data source.

- Host: The URL of your database. This cannot be the URL of your official website
or your local IP. It must be a URL that the DataV server can use to access your
database through the Internet or intranet from the Alibaba Cloud data center.

- Username: The username that you use to log on to your database.

- Password: The password that you use to authenticate your database account.

- Port: The IP address port number of your database.

- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.



4. Click OK when the connection is verified.

3.2.6 Add DataV Data Proxy Service

DataV Data Proxy Service is a database connection tool that provides highly secure
connections. If you are concerned about data privacy and security issues, you can use
DataV Data Proxy Service. If your data cannot be accessed through the Internet, or
you are not using Alibaba Cloud database services, you must expose the Internet IP

address of your database to establish the connection.
Procedure

1. Use the HTTP protocol to enter the DataV console, and select Data Sources > Add
Source.

2. Select DataV Data Proxy Service from the Type drop-down list.

Note:

- This service SDK only provides HTTP services. If you need HTTPS services, you

must apply for an HTTPS certificate recognized by Google Chrome.

- We recommend you enable HTTP services until the HTTPS certificate is applied
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3. Enter the database information.

Type

DataV Data Proxy Service

Mame

This approach requires you deploy open source code
nn FrS Checl hutnnial-

- Name: Displays the name of the data source.

- Host: The IP address of your server. If you are using an ECS server, you should
configure it as the public IP of the ECS server.

- Port: The Port is automatically generated after the code package is downloaded
and installed.

- Key: The Key is automatically generated after the code package is downloaded
and installed.

- Secret: The Secret is automatically generated after the code package is

downloaded and installed.

To obtain a Key and a Secret, see DataV Proxy Configuration in Linux.



- Database: The name of the currently selected database.

If all the parameters are configured, the system will test the data source
connection automatically.

4. Click OK when the connection is verified.

3.2.7 Add Oracle

Procedure

1. Log on to the DataV console, and select Data Sources > Add Source.

2. Select Oracle from the Type drop-down list.
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3. Enter the database information.

Type

Oracle

Mame

Before submitting, please ensure:
1. the database is accessible to Internet. (IP Whitelist

= oD e o ad] b b Jd=nHh

- Name: Displays the name of the data source.
- Host: The URL of your database. This cannot be the URL of your official website
or your local IP. It must be a URL that the DataV server can use to access your

database through the Internet or intranet from the Alibaba Cloud data center.
- Username: The username that you use to log on to your database.
- Password: The password that you use to authenticate your database account.
- Port: The IP address port number of your database.

- Service Name: The service name of the currently selected database.

If all the parameters are configured, the system will test the data source

connection automatically.



4. Click OK when the connection is verified.

When a data source is added, it will be displayed in the data source list.

3.2.8 Add CSV files

Procedure

1. Log on to the DataV console, and select Data Sources > Add Source.

2. Select CSV file from the Type drop-down list.
3. Upload a CSV file.

E] Note:

Each CSV file must be smaller than 512 KB, click here to download the sample CSV
file.

Type

CSV file

Please name this data source

Upload the file

4. Click OK.
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3.2.9 Add static JSON

Procedure

. Log on to DataV console, selectProjects > Create Project.

. Select a template from the menu on the left side of the screen.
. Click Create to begin a visualization creation.

. Select a widget to add to your canvas.

. Click Data on the right side of the page.

AN U A W N

. Click the Data Source Typedrop-down arrow and select Static Data.

Flat Map with 3D Effects
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Disk Spade and Utilization Ratic Field  Mapping

88718 /79%
m

s
s
[

Oinline Noda Crumt and Ratin

7. Paste the static JSON file.

E] Note:

Each file must be smaller than 600 KB.

3.2.10 Add an OSS data source

Alibaba Cloud Object Storage Service (0SS) allows you to save and use unstructured data

(text, image, audio, and video files) through the network at any time.
Procedure

1. Choose Data Sources > Add Source.
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2. From the Type drop-down menu, select OSS .



3. Enter the 0SS data source information, as shown in the following figure.

- Name: The display name of the data source. You can customize the display name
as needed.

- AKID: The AccessKey ID of the account that can access OSS.

- AK Secret: The AccessKey Secret of the account that can access OSS.

- Region: The region to which the target OSS data source belongs. To obtain the

region information, log on to the 0SS console and click the target bucket name.

Domain Names
Endpoint (&

Internet Access (@ oss-cn-shanghaifaliyuncs.com

Classic Network Access from ECS (Internal Network) (3 oss-cn-shanghai-internal.aliyuncs.com

VPC Network Access from ECS (Internal Network) (3 oss-cn-shanghai-internal.aliyuncs.com

Set region to oss-cn-shanghai. As shown in the preceding figure, the OSS bucket

is in Shanghai.


https://oss.console.aliyun.com/

The system automatically tests connectivity after the data source information is set

4. After the connectivity test is successful, click OK.
The data source is automatically displayed in the data source list.
Use the OSS data source

1. In the DataV console, click Projects, select the target project, and click Edit.

2. On the displayed page, select a widget. In the data pane, select OSS for Data Source
Type.

3. From the Select Data Source drop-down menu, select the OSS data source you have

configured before.

4. In the File Path area, enter the target file path. The format must meet the following

requirements:

- The file must be in the JSON format.

- The file path format is as follows: oss://bucket/file. For example, if your bucket
name is myBucket and your file name is test.json, you need to enter oss://
myBucket/test.json.

5. Click View Data Response to view the effect.

3.2.11 Add a Table Store data source

Table Store is a NoSQL database service built on Alibaba Cloud's Apsra distributed

operating system.
Procedure

1. Choose Data Sources > Add Source.

2. From the Type drop-down menu, select TableStore.



3. Enter the Table Store data source information, as shown in the following figure.

Type

TableStore

MName

AK Secret

Internet

Before submission, ensure: 1. The database is
Internet-facing.

4. The database is not blocked by the firewall.

2. The domain name of the database can be parsed.
3. The instance of the database has been started.

- Name: The display name of the data source. You can customize the display name
as needed.

- AKID: The AccessKey ID of the account that can access Table Store.

- AK Secret: The AccessKey Secret of the account that can access Table Store.

- Internet: The endpoint of Table Store. You can enter an endpoint according to the

Table Store instance to be accessed.

The system automatically tests connectivity after the data source information is set



4.

After the connectivity test is successful, click OK.

The data source is automatically displayed in the data source list.

Use the Table Store data source

1.
2.

In the DataV console, click Projects, select the target project, and click Edit.

On the displayed page, select a widget. In the data pane, select TableStore for Data
Source Type.

. From the Select Data Source drop-down menu, select the Table Store data source

you have configured before.

. From the Select Action drop-down menu, select either of the following actions:

- getRow: Corresponds to the GetRow API of Table Store. For more information,
see GetRow API.
- getRange: Corresponds to the GetRange API of Table Store. For more

information, see GetRange API.

. In the Select Action area, enter a SQL statement. The SQL statement must meet the

following requirements:

- Parameters in the SQL statement must be in the JSON format.

- If you select getRow, the system reads data from a row according to the specified

primary key.

The following is an example of the parameter format:

" table_name ": " test ",
" rows ": {

"Hqd " 2

Ty

" columns ": [

n -id Il’

" test "

]



The parameters in the SQL statement:

- table_name :The name of the table to be queried.
- rows :The conditions for filtering a row. Only the rows that meet the

conditions are displayed. To add a column as a condition, you must create an

index for the column first.
- columns :The name of columns to be displayed.

- The getRange action is used to read data with specified primary keys. The

parameter format is as follows:

{

" table_name ": " test ",
" direction ": " FORWARD ",
" columns ": [

" o5d n,

n test n

1,

" range ": {

" limit ": 4 ,

" start ": {

"Hqd ": " InfMin "

I

n end ll: {

"Hqd ": 3

}

}

}

- table_name :The name of the table to be queried.

direction :The query sequence.
- columns :The name of the column to be displayed.

- limit : The maximum number of rows to be displayed.

start :The start column in the displayed result. You must create indexes
for the relevant columns.
- end :The end column in the displayed result. You must create indexes for

the relevant columns.

Note:
You canuse InfMin and InfMax toindicate the minimum and maximum

values of the start and end parameters.

6. Click View Data Response to view the effect.



Example
1. Prepare data for the Table Store data source.

Log on to the Table Store console, create an instance, and read or write data. In the
following example, an instance named test1948 is created. This instance has three
rows of data and each row has two columns named id (primary key in integer

format) and test (in string format).

4 test


https://ots.console.aliyun.com/

2. Configure the data source, as shown in the following figure.

Type

TableStore
Mame
table store data

AKID

AK Secret

Intermet

hitps-ftest1924/cn-hangzhou.ots aliyuncs.com

Before submission, ensure: 1. The database is
Internet-facing.

4. The database is not blocked by the firewall.

2. The domain name of the database can be parsed.
3. The instance of the database has been started.




3. Query parameters.

getRow:

Data Source Type

TableStore
Select Data Source :
table store data
Select Action :

getRow

"table name": "test",
"rows": {
"id": 2
}a
"columns™: [
“id",
“"test”

The data response is as follows.

Use Filter

Data Response

[ r

getRange:



Data Source Type
TableStore

Select Diata Source :
table store data

Select Action :

getRange

"table name": "test",

"direction™: "FORWARD",
"columns™: [

m idllJ

lltESt Ll

]

ange”: {
"limit™: 4,
"start™: {

"id": "InfMin”

The data response is as follows.

Use Filter

Data Response

|

I
L




Note:
When you query the getRange parameter,if youset start to id : InfMin
and end to id : 3 ,thevalues 1 and 2 aredisplayed for id .The reason
for this is that the getRange parameter does not containthe end row, whose

id is 3 , because it is not within the range specified.

3.2.12 Add an API data source
An API is provided by Alibaba Cloud to call other APIs. In DataV, this API is often used
to call other Alibaba Cloud APIs to obtain and display data.

Procedure

1. Choose Data Sources > Add Source.

2. From the Type drop-down menu, select POP API .



3. Enter the API data source information, as shown in the following figure.

Type

POP API

MName

EndPoint

APIVersion

AppSecret

- Name: The display name of the data source. You can customize the display name
as needed.

- EndPoint: The endpoint of the POP API. You can obtain an endpoint from the
API documents of Alibaba Cloud products. For example, the default endpoint of



ECSis ecs . aliyuncs . com , and the endpoint of CloudMonitor in Hangzhou
regionis metrics . cn - hangzhou . aliyuncs . com .

- APIVersion: The API version of an Alibaba Cloud product. You can obtain an API
version from the API documents. For example, the AP/ version of CloudMonitor is
2017 - 063 - 01 .
- AppKey: The AccessKey ID of the account that can call the POP API.
- AppSecret: The AccessKey Secret of the account that can call the POP API.

The system automatically tests connectivity after the data source information is set

4. After the connectivity test is successful, click OK.
The data source is automatically displayed in the data source list.
Use the API data source

1. In the DataV console, click Projects, select the target project, and click Edit.

2. On the displayed page, select a widget. In the data pane, select POP API for Data
Source Type.

3. From the Select Data Source drop-down menu, select the POP API data source you
have configured before.

4. In the Interface Name dialog box, enter the target API name (that is, the value of
the Action parameter). You can obtain an API name from the API list of an Alibaba

Cloud product, such as QueryMetri cList of CloudMonitor.

5. In the Path of Responses dialog box, enter part of the POP API response.

The following is an example of the POP API response:

{
" data ": [

{
n X ll: l ,
n y ll: 2

I

{
n X ll: 2 5
n y ll: 4

}

[



Iy
{
n X II: 2 ,
n y ll: 4
}

You can leave this field empty and convert data by using the data filter as needed.

6. Set the query parameters.

- The parameters must be POP API parameters and in the JSON object format.

- You must set the parameter names according to the input parameters of Alibaba
Cloud APIs.

- You must set the callback ID in the value of a JSON object.

The following is an example of how to use the QueryMetricList APIof

CloudMonitor:
// Use the callback ID : myInstance Id

{
" Period ": 600 ,
" StartTime ": " 2018 - 11 - 20 11 : 30 : 60 ",
" EndTime ": " 2018 - 11 - 21 11 : 30 : 00 ",
" Metric ": " cpu_idle ",
" Project ": " acs_ecs_da shboard ",
" Dimensions ": "{ dinstanceld :': myInstance Id '}"

}

7. Click View Data Response to view the effect.

3.2.13 Add a Log Service data source

Log Service (formerly known as SLS) is an all-in-one service for real-time data

management. With Log Service, you can collect, subscribe, transfer, and search for

massive data.
Procedure

1. Choose Data Sources > Add Source.

2. From the Type drop-down menu, select Log Service.



3. Enter the Log Service data source information, as shown in the following figure.

Type

Log Service

MName

AppSecret

EndPoint

- Name: The display name of the data source. You can customize the display name

as needed.
- AppKey: The AccessKey ID of the account that can access Log Service.
- AppSecret: The AccessKey Secret of the account that can access Log Service.

- EndPoint: The endpoint of Log Service. You can enter an endpoint according to
the network type and region to which the target Log Service instance belongs.

For more information, see Service endpoint.

For example, if the network type is VPC, you can set the EndPoint in Shanghai

region to https://cn-shanghai-intranet.log.aliyuncs.com.

The system automatically tests connectivity after the data source information is set

4. After the connectivity test is successful, click OK.

The data source is automatically displayed in the data source list.



Configure Log Service

For more information about how to activate, configure, and use Log Service, see Log

Service.

Use the Log Service data source

1. In the DataV console, click Projects, select the target project, and click Edit.

2. On the displayed page, select a widget. In the data pane, select Log Service for Data
Source type.

3. From the Select Data Source drop-down menu, select the Log Service data source
you have configured before.

4. In the Query area, enter the query parameters. The parameters support the

following formats:

- JSON object:
{
" projectNam e ": " test ",
" logStoreNa me ": " access - log ",
" topic ": " test ",
" from ": 1509897600 ,
" to ": 1509984000 ,
n query |I: nn s
" line ": 100 ,
" offset ": 0O
+

- Query syntax: Query syntax.

5. Click View Data Response to view the effect.

3.3 Edit data sources

After adding a data source, you can configure data and visualization widgets in the

project editor.

It is recommended to edit the data source on the Canvas Editor page. In addition, you

can add a filter to the data source or set the interval for automatic updates.
Procedure

1. Log on to the DataV console.
2. To create a new project, click Projects > Create Project.
3. Select a template and click Create.

4. Select a widget on the canvas.
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5. Click the Data tab on the right side and open the data editing menu of the selected
widget.

Basic Line Chart

Basic Line Chart Interface

Field Mapping

Disk Space and Utilization Ratio
Data Source Type

8818 /79%

1 Static Data
us

Sr
] [ 1
Online Node Count and Ratio "% @1e/81/01 80 08¢
L.
.‘u’____._
Most Frequently Visited Nodes Ux" 16/01/01 06:00:¢

Shang ha

B/81/81 88:80:¢

Data filter:

6. To see more source types, click the Data Source Typedrop-down list. Select a source

type that you need, for example, Static Data.
Data Source Type

Ctatic Data

Database

TableStore

POP API




7. Edit the content of the data source according to the sample in the following figure.

Mapping
In most cases, the system can automatically match the categories and values of a data

source to complete data mapping. For complex cases, you must manually enter fields
to complete data mapping.

After data are mapped successfully, the system displays Matched Successfully.

Field Mapping Status
» Matched
Successfully
» Matched
Successfully

= Optional

Add filter

You can add a data filter to a data source to display the data in a clearer manner.

Deselect to hide the filter function.



—
-

Basic Line Chart

Basic Line Chart Interface s Completed

Field Mapping Status
» Matched
Successfully

» Matched
Successfully

= Optional

Data Source Type

Ctatic Data

Data filter:

Auto Data Request: Every Second

1. To open the filter editing menu, click Add filter.



2. Select Use Filter.

Use Filter

Data Response Result
|

"2818/01/01 ©06:080:80",

ll_lll

"2818/01/01 ©06:080:80",

"2818/01/01 ©06:080:80",




3. To see available filters, click Select Filter.

Use Filter

“20l1e/01/01 60:00:

l|1u

“20l1e/01/01 60:00:

"2810/01/01 e0:00:08",

If there is an optional filter, the filter name is automatically displayed in the list. If

no filter is available, you must create a filter by following the instructions.
4. Click New Filter.

5. Enter a name for the filter.



6. Edit filter scripts based on the needs for displaying data.

Use Filter

+ Select Filter

Mame: MNew

function filter [datal {

data:

Data Response Result
[

T

"x": "20l1e/01/01 68:06:08",

u:_ m, mgqmw

- To preview the effect of the data filter, click Preview.
- To cancel the current filter settings, click Cancel.

- To complete adding filter, click OK.
Automatic updates

You can automatically update data through the automatic updates function by

entering the interval for updates.

Deselect Auto Data Request to hide the automatic updates function.



—
_—

Basic Line Chart

Basic Line Chart Interface

Field Mapping

Data Source Type

Ctatic Data

Data filter:

Auto Data Request: Every

» Completed

Status

» Matched
Successfully
» Matched
Successfully

= Optional

Second




3.4 Filter data sources

You can filter data sources by type.
Procedure

1. Log on to the DataV console.
2. Click Data Sources to go to the data source list.

3. In the right-side pane, click Sort by Data Source Type to show all data source types.

Sort by Da...+| Sortby Data ...~

All

test

anotherVPC

VPCTest

MyOracle

4. Click a type of data source to filter out only this type from all data sources.

3.5 Sort data sources

You can sort your data sources by Name , Time Created ,and Data Modified

Procedure

1. Log on to the DataV console.
2. Click Data Sources to display the data sources list.

3. In the right-side pane, move the pointer over Sort by Data Modified (displayed by
default) to show all sort types.



https://datav.alibabacloud.com/
https://datav.alibabacloud.com/

4. Select the sort type you want to use to order the data sources.

E] Note:

DataV provides three sort types: Name, Time Created, and Data Modified.

3.6 Remove data sources

You can remove data sources that you no longer use from the data source list.

@ Notice:

After data sources are removed, the data source cannot be restored.
Procedure

1. Log on to the DataV console.

2. Click Data Sources to display the data sources list.

3. Select a data source and click the trash bin icon to remove the date source.

£2 Projects

2018/8/21 F43:28:09

2017/12/27 F45:02:12
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4 Manage editor

4.1 Editor overview

The project editor is the main interface within DataV where you can adjust page
layouts, bind data sources and widgets, and publish projects. The following image

shows key components of the project editor (outlined in red):

r_' - 2 E < Global Business Overview W=
l Module Title

‘ Module Title Module Title

oo ||| s || o 232425 , $232425

$23242 | | $23242 | | s23242

Module Title Module Title

Module title

Module Title Module Title Module Title

$ 232425 $232425 $232425

- 1: Widgets

- 2: Canvas

- 3: Layers

- 4: Page settings
- 5: Publish area

4.2 Edit canvas
4.2.1 Widget layouts

DataV provides optimized features such as drag, scale and more.

In the canvas area, you can drag and drop widgets. DataV supports the following

features:

* Drag

- Scale



* Rotate

- Align

- Set opacity

+ Group

* Lock

- Hide

* Copy

- Delete

- Layer

* Right-click menu
- Thumbnail (Enterprise Edition or later)

- Shortcut keys
Drag
1. Select one or more widgets.

- To select a widget, click it.

- To select multiple widgets, hold down Ctrl for Windows or Command for Mac,
and click multiple widgets.
il
[:] Note:
In the left-side Layers list, you can use the same method to select one or more

widgets.



2. Hold down the left mouse button to drag and drop.
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Scale

1. Select one or multiple widgets, and then rest the pointer over the widget's border.
2. When the scale icon appears at the lower-right corner of a selected widget, adjust
the size of the widget (or widgets) by clicking and dragging the widget’ s border.

If multiple widgets are selected, the widgets will scale simultaneously in the same

direction.

Rotate

1. Select one or multiple widgets, and then rest the pointer over the widget's border.



2. When the rotation icon appears, hold down the left mouse button to rotate widgets.
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Align

1. When multiple widgets are selected, Alignment and Distribution icons are

displayed on the right side of the page.



2. Click the corresponding Alignment or Distribution button based on your needs.

Alignment methods include Align Top, Align Middle, Align Bottom, Align left,

Align Center and Align Right. Automatic distribution methods include Horizontally
, Vertical, and Average.

Layout

Alignment

c J ﬂ’][j—]E Distribution

Computing Resource Usage
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Set opacity

1. Select a widget. The Style panel appears by default on the right side of the page.



2. In Basic Attributes, select Others, and set the Opacity of a widget by clicking + or -

Basic Line Chart

CneEs

Basic Attnbutes

Computing Resource Usage Size

L.

b | I S— .

s ."\. ), R
el Position
»

F ]

[ —

Disk Space and Utilization Ratio

This function allows you to design a project freely according to your data visualizat
ion demands.

Right-click menu

In the left-side Layers list or on the canvas, right-click a widget to select Bring to front,
Send to back, Bring forward, Send, Copy, or Delete.

More right-click menu features are available for DataV Enterprise and later editions
including Group, Ungroup, Lock, and Hide.
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Thumbnail (Enterprise Edition or later)

DataV provides the thumbnail feature in the lower right corner of the canvas. You can

use this feature to scale your visualization project.

1. Adjust the slider, or click + or- under a thumbnail to scale the size of the canvas.
2. When your project screen exceeds the canvas size, you can drag the highlighted

blue border of a thumbnail to locate your project.




3. In the lower-right corner of a thumbnail, click E to turn the thumbnail off or
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Shortcut keys
Multiple shortcut keys are added in the new version of DataV. They are:
Group: Ctrl+G
Ungroup: Ctrl+Shift+G

Cancel grouping: Ctrl+Z
Copy and paste: Ctrl+C and Ctrl+V

4.2.2 Widget coordinates and guides
Coordinates

Add any widget to the screen, and then click the widget. Notice the blue guides
displayed in the upper-left corner of the widget.



This Is Title

These guides are used to locate the coordinates of the widget. You can adjust the

position of a widget by using the widget's coordinates.
Guides
Click any point on the ruler to show guides. Follow these steps:

1. Move the pointer to the left or top ruler.

2. Select a point on the ruler and click it to see a red guide.

E] Note:



To hide guides, click the icon in the upper-left corner of the canvas. Click
=

the icon again to reveal these guides.
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4.3 Manage layers

4.3.1 Switch views

In the upper-right corner of the Layers list are the List View and Thumbnail View two

icons.



- Click the List View icon to show all details of widgets in the Layers list, including

their styles and titles.

Layers
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- Click the Thumbnail View icon to show widget names in a thumbnail form.

Layers
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4.3.2 Move widgets

To move or order widgets, follow these steps:



Procedure

1. In the left-side Layers pane or on the Canvas, select one or more widgets.



2. Select any of the following methods to move the layer position of widgets.

- Click the icons above the Layers list.

Layers

ml-line-basic G...

Flat Map with 3D...

number-title-flo...

ml-bar-hori-caps...

ml-line-basic kX

ml-line-basic_aw...

pie-ranking_4ZTVx

There are four icons above the Layers list, Bring forward, Send backward, Bring

to front, and Send to back.

- Right-click to select a layer movement option.
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From top to bottom in the menu, layer movement options are Bring forward,

Send backward, Bring to front, and Send to back.

In the Layers list, click and drag selected widgets to change their positions.
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Bring forward: Move one or more widgets up one position.
Send backward: Move one or more widgets down one position.
Bring to front: Move one or more widgets to the top of the list.

Send to back: Move one or more widgets to the bottom of the list.



Functions of widget layer movement

The movement of widget layers can make the ordering of widgets more organized on

a large screen.

- The higher a widget is positioned in the list, the closer it is to the front of the

canvas.

- The lower a widget is positioned in the list, the closer it is to the back of the canvas.



5 Manage widgets

5.1 Widget overview
Widgets supported by DataV include:

- Charts

- Maps

- Media

- Text

- Networks
- Material
- Interact

- More widgets
Charts

Click Charts to display all basic charts, including Bar, Line, Pie, Scatter, and more.
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ECharts Waterfall Chart

Radar Chart - 11.11
Global Shopping...

il sowaTs
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Chart I
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Maps

Click Maps to display all map types, including 3D Globe (2018), Basic Flat Map, Flat
Map with 3D Effects, and Globe.



3DGlobe(2018) Basic Flat Map Flat Map with 3D

Effects

Globe

Media

Click Media to display all media widgets, including images and videos.

Fluorite Cloud Player Image Live Stream Player
(RTMP)

ad

Carousel Images

Text

Click Text to display all text widgets, including Carousel List 11, Table, Title, Marquee,

Text Box, and more.



Carousel List I

WORLD

Marguee Word Cloud Carousel List I

TXT
¥1,688,888 TXT

Ticker Board Text Box Percentage Bar Chart

Ctatus Card Label Board

Networks

Click Networks to display Network widgets.

ECharts Chord Diagramsn  ECharts Interactive Network Diagram
MNetwork Diagram




Material

Click Material to display Boarder, Customized Background, Decoration, and Logo
Wall.

¥

Customized Decoration

Background

Logo Wall

Interact

Click Interact to display all widgets, including Full Screen Switch, iframe, Timeline,
and Tab.

Interact

Full Screen Switch Timeline




More widgets

You can subscribe to third party widgets by clicking More Widgets in the toolbar.

Select Widget Library

0 =CHARTS

5.2 Add a widget

Procedure

1. Log on to the DataV console.
2. Select Projects > Create Project.

3. Select a template and click Create.


https://datav.alibabacloud.com/

4. Click one of the charts, for example, Basic Bar Chart (outlined in red).
=)
Add

ECharts Pictonal Bar ECharts Polar Chart ECharts Scatter Plot

O I

Arc Bar Chart Grouped Column Chart  Capsule Column Chart

Area Chart Area Chart with Ticker Basic Colurmn Chart
Board

Basic Bar Chart Capsule Bar Chart Grouped Bar Chart

The chart is automatically displayed on the canvas. You can hover your mouse over
a widget and, in the lower-right corner of the widget’ s border, click the scale icon

to resize the chart.

5.3 Add and manage your favorite widgets

This topic describes how to add a widget to your favorites, and how to view, rename,

use, and delete favorite widgets.

E] Note:



If you are using the basic edition of DataV, no widgets can be added to your favorites.
If you are using the enterprise edition, 20 widgets can be added to your favorites. If

you are using the developer version, 40 widgets can be added to your favorites.
Procedure

1. Log on to the DataV console.

2. On the Projects tab page, click Create Project, select a template, and then click

Create.

Note:

You can also select an existing project on the Projects tab page.

3. Add a widget to your favorites.

a. In the Layers pane on the left, or in the dashboard (the center blue area on the

page), select a widget.

Note:
If you are using the enterprise edition of DataV, you can select only one widget
at a time to add it to your favorites.

b. Right-click the widget and then click Favorite to add it to your favorites.

Note:
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The data indicated by the widget can be affected by the data source changes.
Therefore, we recommend that you use static data when you add a widget to

your favorites.
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4. View the widgets in your favorites.

In the upper-left corner of the page, click the Back icon. Then, choose Widgets >
Favorite Library.

£2 Projects (8) Data Sources

[¥] Favorite Library Project(s) to Be Created

M Widget Libraries

[Z] Development Guide

mHin 20 3/2 2 :43:35 2019/3/26 F4F1:43:26

E] Note:



The page displays the number of widgets that you can add to your favorites.
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Empowering Intelligent City

= Projects (5) Data Sources

[¥] Favorite Library Project(s) to Be Created
M Widget Libraries

[Z1 Development Guide

?

You have not favorited any widgets yet. Go to the Editor page of any project to add widgets as favorites.

5. Delete a widget from your favorites.

Click the Delete icon on the widget.

Delete

caro. .. 201973726 514




6. Rename a widget in your favorites.

Click the lower-left corner of the widget, and then rename the widget.
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7. Use a widget in your favorites.

a. Create a project and select a blank template.
b. In the top navigation pane, move your pointer to the Favorite icon, and then
select a widget.
= N @] ©

= Favorite To manage the widgets that you have favorited, go to the Manage Favorites
page.

ml-line-basic pie-ranking carousel-table

Add widgets to your favorites by group
You can group your widgets and add them to your favorites for later use.

The Group function helps you add more widgets to your favorites.

E] Note:

The Group function is only available in the developer edition of DataV. To use this

function, you must upgrade your DataV to the developer edition.
Procedure

1. In the Layers pane on the left, or in the dashboard (the center blue area on the
page), select two or more widgets as needed.
2. Right-click the selected widgets and select Group.

3. In the Layers pane on the left, or in the dashboard (the center blue area on the

page), select the grouped widgets.
4. Right-click the widgets and select Favorite.

E] Note:



Changing the data sources of your favorite widgets might cause the widgets to
become unavailable. Therefore, we recommend you use static data when you add

widgets to your favorites.
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For more information about how to add widgets to your favorites by group, see Add

and manage your favorite widgets.

5.4 Group widgets
You can group or ungroup multiple widgets within a project.
Group

1. Log on to the DataV console.

2. Select a project to go to the project page.
3. In the left-side Layerspane or on the canvas, hold down Ctrl for Windows (hold
down Command for Mac) and click multiple widgets to select the required amount

of widgets.

Move the pointer over the selected widgets to move the widgets simultaneously.

4. Right-click and choose Group (or click the n icon at the bottom of the Layers

list) to group the selected widgets to a group file.
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Ungroup

1. Right-click a group file.
2. Choose Ungroup.

Note:
In the Layers list or on the canvas, select one or more widgets, use the new

shortcut key Ctrl + G for grouping, and CTRL + Shift + G for ungrouping.

When you click Ungroup, all the widgets in the group file return to an ungrouped
state. Widgets are then independent of each other, and can no longer be moved

simultaneously.

5.5 Lock a widget

You can lock or unlock a widget by the following steps:
Procedure

Log on to the DataV console.
Go to Projects > Create Project.
Select a template, and then click Create.

In the Layers list or on the Canvas, select a widget.

ok D F

Right-click and choose Lock (or click the Lock icon at the bottom of the layers

list) , to set the widget status to locked.

Note:

When a widget is locked, a lock icon appears on the widget layer in gray.
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Layers

Image

Ticker Board

Decoration

Basic Line Chart ...

Paragraph_6ljOA

6. In the left-side Layers list, select a locked widget, right-click and choose Unlock (or
click theﬂ icon on the widget layer or at the bottom of the layers list) , to set the

widget status to unlocked
Lock layer function

- When a widget is locked, actions that take place on the visualization screen do not

affect the widget.
- Once a widget is locked, it cannot be modified until it is unlocked.

- This function can help avoid accidents or misoperations when there are too many

widgets on the screen.

5.6 Hide a widget

You can hide or display widgets through any of the following methods:
Procedure

1. Log on to the DataV console.

2. Go to Projects > Create Project, and access the visualization page.
3. Select a template, and then click Create.

4. Select a widget from the Layers list or on the Canvas.
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5. Right-click and choose Hide (or click the Hideu at the bottom of the layers list) ,

to set the widget status to hidden.
3
[:] Note:
When a widget is hidden, a hide icon appears on the widget layer in gray.
5 | number-title-flo...

main-title_ wAJzF

main-title_mwFoE

main-title_Pdin5

main-img_XUTdw
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6. In the left-side Layers list, select a hidden widget, right-click and choose Show (or
click the u icon on the widget layer or at the bottom of the layers list to show this

widget).
Hide layer function

- When the map widget uses too many resources (CPU and memory), the applicatio
n slows down. You can hide a widget to reduce stress on computing resources and
deploy other widgets.

- You can hide widgets that have already been deployed to clear up the screen, make
operations run more smoothly, or greatly increase the efficiency of deployed

widgets.



5.7 Copy a widget

Procedure

1. Log on to the DataV console.

2. Select a widget on the canvas. If no widget is available, click Projects > Create
Project.

3. Select a template, and then click Create.

4. On the canvas or in the Layers list, move the pointer over the widget.

5. Right-click and select the Copy icon (outlined in red in the following figure).

1 Send to back

F Bring to front ]
L

2 Bring forward

F Send

= Group

5.8 Delete a widget

Procedure

1. Log on to the DataV console.
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Select a widget on the canvas. If no widget is available, click Projects > Create

Project.

. Select a template, and then click Create.

. On the canvas or in the Layers list, move the pointer over the widget.

Right-click the Delete icon (outlined in red in the following figure).

" 1 Send to back

F Bring to front ] I
% &

4 Bring forward
F Send

B Group

a Lock

& Hide

Copy

5.9 Manage child widgets of a map widget

Before you begin

1.
2.
3.
4.

Log on to the DataV console.
Choose Projects > Create Project.
Select the blank template, click Create, enter a project name, and then click Create.

In the top navigation pane, click the Maps icon, and then select a widget. In this
example, the 3D Globe (2018) is selected.
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5. Click the widget, and then select a child widget from the Child Management area.

For more information about child widgets, see Manage child widgets.

3D Globe (2018)

+ Child Management
O Earth Layer

O Ambient Light

Ambient Light Choropleth L... Atmosphere ...

ying Route Layer

Directional Li... InfoWindow L... Flying Route ...

Basic Attributes
Size

Earth Layer Heat Line Layer Scanner Layer

Paosition

BiE 0 AT Others

+ Add Child Widget

Rendering Normal Mode

Manage child widgets
Apply color tags to categorize child widgets

1. Click the square on the left of a child widget style, and then select a color from
the displayed box.

2. On the right of Child Management, click the target color tag to filter the child
widgets categorized by this tag.

3D Globe (2018)

+ Child Management

O Flying Route Layer

O Directional Light

O Sky Box Layer

Basic Attributes

Position

Others




- Add child widgets

1. On the left of Child Management, click + to view the thumbnail list of all the
child widgets included in the map widget.

2. Select one or multiple child widget thumbnails, and then click +Add Child
Widget.

3D Globe (2018)

ﬁhild Management

Basic Attributes

Rendering Normal Mode

Mode

» Background Settings

» Viewpoint Positioning

- Show or hide a child widget on the map

On the right of a child widget label in the list under Child Widget, click the Eye icon
to show or hide the child widget on the map.



Copy a child widget

On the right of a child widget label in the list under Child Widget, click the Copy
icon to copy the child widget.

3D Globe (2018)

+ Child Management
O Earth Layer
O Ambient Light
O Scatter Layer
O Flying Route Layer

irectional Light

Box Layer [ 3

Basic Attributes

Position

Others




- Rename a child widget

On the right of a child widget label in the list under Child Widget, click the Pencil

icon to rename the child widget.

+ Child Management
O Earth Layer
O Ambient Light
O Scatter Layer
O Flying Route Layer
O Directional Light

0 Sky Box Layer

0 Sky Box Layer

O Directional Light

Basic Attnbutes

Position

- Delete a child widget

il
|:| Note:



A deleted child widget cannot be restored.

On the right of a child widget label in the list under Child Widget, click the Trash
Can icon to delete the child widget.

3D Globe (2018)

+ Child Management
O Earth Layer
O Ambient Light
O Scatter Layer
O Flying Route Layer
onal Light

Layer

O Directional Light

Basic Attributes

Size

Position

Others

5.10 Configure widget data
Select a widget and click the Data tab. The data configuration menu of the widget

appears.



Data interface

Basic Line Chart

Basic Line Chart Interface = Completed

Field Mapping Status

= Matched
Successfully
s Matched

Successfully

= Optional

Data Source Type

Static Data

818/81/e1 60:8

L]

ele/el/e1 eo:9

The data interface of a selected widget is displayed in the following figure. The
data interface of a selected widget is displayed in the following figure. If a widget
is comprised of multiple data interfaces, you can click an interface title and

configure data one by one.



Interface data structure

Basic Line Chart

Basic Line Chart Interface = Completed

Field Mapping Status

= Matched
Successfully
s Matched

Successfully

= Optional

Data Source Type

Static Data

818/81/e1 60:8

3

ele/el/e1 eo:9

The following area outlined in red displays the data structure of the selected data

interface.

Click the drop-down menu (outlined in red) to see various data source types.



Data Source Type

Ctatic Data

CsV file
AP1
Database
TableStore

POP API

If you select Database from the Data Source Type drop-down list, select a database

for inquiry.
Data Source Type
Database
Select Data Source :

Select Data Source

il
|:_| Note:

You must use the corresponding syntax to query the database you selected. DataV

has no special handling for database syntax.



Data source type and parameter

Basic Line Chart

Basic Line Chart Interface = Completed

Field Mapping Status

= Matched
Successfully
s Matched

Successfully

= Optional

Data Source Type

Static Data

@/el/e1 ee:88:¢

818/81/01 68:0808:¢

Data source type and the corresponding input parameters are displayed in the area

outlined in red.



Data filters

Basic Line Chart

Basic Line Chart Interface = Completed

Field Mapping Status

= Matched
Successfully
s Matched

Successfully

= Optional

Data Source Type

Static Data

818/81/e1 60:8

L]
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Select Data filter to enable the data filter function. You can write programs to

implement data structure conversion, filtering, and simple calculations.



Data polling frequency

Basic Line Chart

Basic Line Chart Interface = Completed

Field Mapping Status

= Matched
Successfully
s Matched

Successfully

= Optional

Data Source Type

Static Data

818/81/e1 60:8

L]
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Select Auto Data Request. You can also manually enter the time frequency of

round-robin.

5.11 Configure widget interaction

Procedure

The following example uses a Ticker Board widget.



1. Select a Ticker Board widget, and then click the Interaction tab on the right side of
the page.

Ticker Board

w Interaction Events (@ Tutorial

Tiete Name
w Trigger Event when Number Chanc 1 Enable

.$ 2 3 2 '42 5 Dollar Field B:-r—:l-;:l to a Varizble Field Description

value Changed Value

2. In the upper-right corner of the Trigger Event when Number Changes menu, select
Enable.

3. Change the variable name listed under the Bind to a Variable column.

As shown in the following example, value ischangedto income .

Ticker Board

w Interaction Events (3 Tutorial

w Trnigger Event when Number Chang- | Enable

Bind to a Vanable

@)

Field

Field Description

value income Changed Value

Other widgets can use the variable named income to retrieve this parameter.

E] Note:

With this feature, you can configure different variable names for different widgets,

so as to differentiate used parameters.



4. Youcanuse : Variable name (such as, :income) in the data source, as shown

in the following example:

- SQL:
select : +dincome as value
select A from table where income = : income
- API:
http :// api . test ? dincome =: income & id =: myid
Note:

- If you select Static Data or CSV file from the Data Source Type drop-down list, a
callback ID is not supported.

- DataV supports callback parameter auto-complete. When configuring a
data source, if you type :, the editor prompts all variable names that were
configured in the current project. Use the up and down arrow buttons to
browse the variables and press Enter to select. The callback parameter auto-
complete feature helps you easily view any previously configured variables so

that you can better navigate your widgets and data.
Data Source Type

API
URL: -

Configure callback parameter to URL, for
instance: http://api.test?value=:value

http://api.test?income=:|
= income CallbackId
w1 myid




Advanced settings
- Set custom fields

1. Click the Data tab of the Ticker Board configuration pane.

2. Configure a id field , and the valueis 123 at the data source section.

Ticker Board

Ticker Board Mumber Interf

» Completed
ace

Field Mapping Status

name = Optional

» Matched

value ~
Successfully

prefix = Optional

suffix = Optional

Data Source Type

Ctatic Data

I
l m L1
name" :
“"value”:

3. Click the Interaction tab.
4. Click Create a New Field.
5. Enter an id in the Field column and enter a variable name under the Bind to

Variable column.



w Trnigger Event when Number Chang- i Enable

Bind to a Vanable

@

Field Field Description

value income Changed Value

id myid T

)
|:| Note:
Only when both the Field and the Bind to a Variable fields are filled out, can this

variable take effect..

- Set the default value for the callback ID

Set the default value of the callback ID by configuring the request parameters in

the URL, as shown in the following example:

http :// datav . aliyun . com / screen / 000000 ? myid = 123
**x Note :*xx " Q00000 " refers to the screen ID .

When accessing data through this URL, the value of the callback ID my+id is
already set to 123.

Use the ampersand mark (&) to join multiple callback IDs. The following example
sets default values for both callback IDs, myid and -{income .
http :// datav . aliyun . com / screen / 000000 ? myid = 123 &

income = 1000
*%* Note :xx " QOOOOO " refers to the screen ID .



6 Widget guide

6.1 Configure item description

Click a widget on the canvas. The configuration panel appears on the right-side of the

canvas. The panel includes three tabs:Style, Data, and Interaction.

Configuration items are collapsed and grouped based on different levels. The Style tab
displays Basic Attributes. Other content is collapsed to make the item structure more

clear and ease classification and searches.

The following example uses a line chart.

Basic Line Chart
Big Data DevOps Monitor Dashboard
( Basic Attributes
Total Task Volume Tasks Taking Long Response Time Tasks Taking Most Computing Pidscurees:

232 , 425 Year on Year Basis

23%

/

Position

» Global Options

» X Axis

» Y Axis

Total Data Sheet Volume Average Data Sheet Capacity

232,425 | 232,425

3%

Average Data Sheet Size

232,425

Basic Attributes

In the basic attributes bar, you can adjust the size, position, rotation angle, and

opacity of the widget.

Basic Atinbutes

Position




- Size

The border width and height are measured by the pixel distance between the left

and right sides and between the upper and lower sides respectively.

Click the plus (+) or minus (-) signs, or enter a number to adjust the Width and
Height.

- Position

The X-Y position of the widget. The Abscissa is the difference between the distance
of the chart's upper left corner to the page's left-side border. The Ordinate position

is the distance between the chart's and the page's upper border.

Click the plus (+) or minus (-) signs, or enter a number to adjust the Abscissa and
Ordinate.

- Others

- Rotation angle: Rotate around the center point of the widget. Click the plus (+)
or minus (-) signs, or enter a number to adjust the rotation angle.
- Click the plus (+) or minus (-) signs, or enter a number (0-1) to adjust the

opacity.
Color picker

You can use the color picker to configure attributes such as a widget's font color, axis
color, grid line color, and border color. This document will show you two ways to

change text color.



- Click the left-side commonly used color block icon to pick a color.

~ Text Style

Font Size

Font Color I &FFF

Beginners can quickly select from the built-in commonly used colors when using
the commonly used color block to easily and efficiently modify corresponding

widgets.



- Click the color wheel icon on the left-side to adjust the font color opacity, add or

remove global colors, or select recently used colors.

= Text Style

Font Size

Font Color I #rFF

= Global Colors

--

= Recently Used

- Adjust font color opacity



w Text Style

Font Size

Font Color #3682B6

100|

Global Colers

lE +

Recently Used

- Add or remove global colors



w Text Style

Font Size

Font Color

= Global Colors

il +

= Recently Used

Select recently used colors



w Text Style

Font Size

Font Color - RGBA(93 197 8209 &

= Global Colors

--,h

= Recently Used

Colors selected through the Global Colors bar are applied throughout the entire

project, and saved in the Recently Used bar.

6.2 Interaction

6.2.1 Full screen switch

The full screen switch widget allows you to view your project in full screen mode.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Enter Full Screen: To customize the full screen icon, delete the existing icon and

upload a local icon. To use an icon from the Internet, enter the URL of the icon.



- Exit Full Screen: To set the icon for exiting full screen, delete the existing icon and
upload a local icon. To use an icon from the Internet, enter the URL of the icon.

- Background Color: To change the background color of the icon, see Color picker.

- Border Radius: You can set the border radius of the widget as needed. By default, if
the value is set to 50%, the icon is displayed in a circle. If the value is 0, the icon is

displayed in a square.

Full Screen Switch

Basic Attnbutes

200
Position

Others

Enter Full & https-ifimg_alicdn.comftfs/TE

Exit Full Screen @ hitpsfimg_alicdn.comitfs/TE

Screen

Background Il RGBA(25

Color

Border Radius A0%




Note:

You can view the style on the preview or publish page, as shown in the following

figure.

Data

You do not need to configure data for this widget.

6.2.2 iframe

You can add one or more iframe widgets to a project to display pages corresponding
to different URLs.

Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- URL Link: You can enter or paste the URL of the page displayed on the widget.

-

Note:
We recommend that you specify the HTTP or HTTPS. An HTTPS cannot be used to
visit the iframe with an HTTP URL. Cross-domain must be supported for the URL.



- Close Button: If you select this option, a Close button is displayed in the right

corner of the preview or publish page. To close a web page, click Close.

Q Ycat Login

@

11.11 The Biggest Deals of the Year

4MFF on selected cloud servers with a free 100 GB data transfer!

Join Now

Data

Hrame Interface s Completed

Field Mapping Status

» Matched
url

Successfully

Data Source Type

Ctatic Data




url : URL of the page that is displayed on the widget. The URL set here corresponds

to the URL you set for URL Link. If you set a URL in both the configuration and data
panes, the URL set for URL takes priority.

Interaction

To enable the interaction function, select Enable. For more information about how to

configure the interaction, see Configure callback IDs for ticker boards.

6.2.3 Timeline

Style

You can add one or more timelines to a project for users to view data obtained during

different time periods.

Usage: You can use a timeline to display data in a loop by setting the loop parameter
to an interaction field in the interaction pane. To hide the timeline, move it outside

the canvas or set all colors to transparent.

- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

Font Family: To set the font of the displayed text, click the drop-down arrow and

select the target font. The default font is Microsoft YaHei.

- Loop: If you select this option, the event nodes are displayed in a looped
sequence. If you clear this option, the event nodes are displayed only once.

- Duration: You can set the time interval between the display of two event nodes.

- Stop Time: You can set the time for which a node is displayed.

- Padding: You can set the horizontal spacing between the event nodes and the

borders as needed. We recommend that you set the spacing smaller than half

the width of the outline.



- Node

- Category: To change the event node category, click the drop-down arrow and
select the target category. The category can be Numeric, Category, or Time. The
following two figures show the Numeric and Category event nodes.

~ Node

Category Numeric

Shape Diamond

Node Size

~ Node

Category

Shape Diamond

Node Size

- Data Format: This option is displayed only after you set Category to Numeric.
You need to set this option according to the data. For example, if the data is
1982-02-01 17:09, you need to set this option to %Y-%m-%d %H:%M.

« Mode

Category Time

Data Format %0 Y-%m-%d %H %M

Shape Diamond

- Shape: To change the node shape, click the drop-down arrow and select the
target shape.
- Node Size: To change the node size, enter a value, or click + -.

- Default Style: Default style of the nodes.
B Node Fill Color: To change the fill color of the nodes, see Color picker.

B Stroke Color: To change the color of the node outlines, see Color picker.

B Stroke Width: To change the width of the node outlines, enter a value, or click

+0r -.



w Default Style

#FF4D4F

Bl #AAD14

- Selected Style: Style of the displayed nodes.

B Node Fill Color: To change the fill color of the nodes, see Color picker.
W Stroke Color: To change the color of the node outlines, see Color picker.

B Stroke Width: To change the width of the node outlines, enter a value, or click
+or-.
ted Style
Node Fill #ODBAFF
Color
Stroke Color R#ODBAFF

Stroke Width

- Label Bottom

- Offset: You can adjust the margin between the bottom labels and the axis line as

needed.

w Label Bottom

Rotate

» Default Style

- Rotate: To change the rotation angle of the bottom labels, enter a value, or click
+or-.

- Default Style

B Font Size: To change the font size of the label text, enter a value, or click + or

B Color: To change the font color of the label text, see Color picker.
B Font Weight: To change the font weight of the label text, click the drop-down
arrow and select the target font weight.
- Selected Style: To set the style of the selected nodes, see the settings of the
default style.



- Label Top: To set the top labels, see Label Bottom.
- Background

- Width: You can set the width of the axis line as needed.
- Default Style: To change the default color of the axis line, see Color picker.

- Selected Style: To change the color of the displayed axis line, see Color picker.
+ Background

]

~ Default Style

Color Il #FFC53D

~ Selected Style

Color #FF4D4F

- Interaction: You can set the callback ID of the widget as needed.

@ Notice:

The interaction function has been migrated from the Configuration pane to the

Interaction pane. Please upgrade your widget as soon as possible.



Data

e
-

Timeline

Timeline Interface » Completed

Field Mapping Status

= Matched
name -
Successfully
text = Optional

» Matched

value ~
Successfully

width = Optional

height = Optional

Data Source Type

Ctatic Data

“name" :
"wvalue": B
"text": "E 1"

"name”: "1985",
"wvalue": B
"text": "Event2”

“name" :
"value®:
"text™:

name : bottom label text, that is, text under the axis line

text :top label text, that is, text above the axis line



value :value that corresponds to a node. If the value is a date, you need to set the

data format in the configuration pane.

[

“name” ;
"waluel :
"text"™:

“name" :
"walue":
"tE':{t " .

" n-E.ImE L .
“value”:

width :width of alabel. By default, this field does not need to be set.

height : height of a label. By default, this field does not need to be set.

Interaction

To enable the interaction function, select Enable. For more information, see Configure

callback IDs for ticker boards.

6.2.4 Tab

The tab widget allows you to customize the tabs in a project as needed. You can

connect the tabs to different events in the interaction pane.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font.

- Background Color: To set the background color of the displayed text, see Color
picker.

- Number of Rows: To change of the number of rows in the tab list, enter a value, or
click + or -.

- Number of Columns: To adjust of the number of columns in the tab list, enter a
value, or click + or —.

- Select Type: This option contains Single Select and Multiple Select. To set the
selection type, click the drop-down arrow and select the target type.

- Init Value: You can enter the ID of the tag to be initialized. The ID must match the
value of the id field in the data pane. If you set Select Type to Single Select, you can



enter one ID only. If you set Select Type to Multiple Select, you can enter two or

more IDs. However, you need to separate the IDs with commas (,).

?

N . S A e N N A |

Font Family Microsoft YaHei

Background Il RGBA(2

Color

MNumber of

Rows

Number of

Colums
Select Type

Init Value @

Font Family Microsoft YaHei

Background Il RGBA(255;:

Color

MNumber of

Rows

MNumber of

Multiple 5
All Buttons
Init All

Init Value &




Tab List Interface
Field Mapping
id

conten
t

Data Source Type

Ctatic Data

L m = m
id™:
“content™:

)
X

llidll: EJ
“content™:

X

"id": 3

=

“content™:

» Completed

Status

» Matched
Successtully
s Matched
Successfully




- All Buttons: This option is displayed only after you set Select Type to Multiple
Select. If you select this option, the All tab is displayed in the tab list.

Font Family @  Microsoft YaHei

Background Il RGBA(255,25

Color

Number of

Rows

Number of

Colums

Select Type Multiple
All Buttons

Init All

Init Value @

- Init All: This option is displayed only after you set Select Type to Multiple Select. If
you select this option, all tabs in the tab list are selected, and the Init Value option

is hidden.

Font Family @  Microsoft YaHei

Background Il RGBA(25

Color

Number of

Rows

Mumber of

Colums

Select Type Multiple

All Buttons

Init All



- Label Options

Font Size: To change the font size of the label text, enter a value or drag the

slider.

Font Color: To change the font color of the label text, see Color picker.

Font Weight: To set the font weight of the label text, click the drop-down arrow
and select the target font weight.

Background Color: To set the background color of the label text, see Color picker.
Border Radius: To change the border radius of each tab, enter a value or drag the
slider. The default value is 0.

Hover Color: To change the color of each tab when you rest your pointer on the
tab, see Color picker. The configured color can only be viewed on the preview or
publish page.

Selected Color: To change the font color of the text on the selected tab, see Color
picker.

Selected Background Color: To change the background color of the selected tab,

see Color picker.



Background Il RGBA(255,255,255,0

Color

Mumber of

Rows

Mumber of

Colums

Select Type Multiple Select
All Buttons

Init All

Init Value

« Label Options

Font Size

Font Color #3333313

Font Weight  normal

- —

Background Il RGBA(255 2552550 @

Color

Border Radius W

Howver Color RGBA(D, D, D, 0.7)
Selected Color [l #FFFFFF

Selected I #69BA6D

= T O Backgroundcolor

- Interaction: You can set the callback ID for the widget as needed.




Data

Tab List Interface s Completed

Field Mapping Status

. = Matched

id ) )
Successfully

conten = Matched

t Successfully
Data Source Type

Static Data

Ilidll : 1,
"content™:

id 2,
"content™:

"id": 3,
"content™:

T ———

{

id :tab ID, which corresponds to the value of the Init Value field in configuration
pane

content :tab name
Interaction

To enable the interaction function, select Enable. For more information, see Configure

callback IDs for ticker boards.



6.3 Column and bar charts

6.3.1 Table bar chart — 11.11 Global Shopping Festival

The widget of table bar chart — 11.11 Global Shopping Festival allows you to add one
or more table bar charts to a project to display data of different products during 11.11

Global Shopping Festival.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- General

Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Row Padding: To adjust the spacing between the bars, enter a value, or click + or

- Quantity: To change the number of displayed bars, enter a value, or click + or -.
- Height: To change the height of each bar, enter a value, or click + or -.

- Loop

B If you select this option, text in each bar is automatically displayed in
sequence.
B If you clear this option, text in each bar is not automatically displayed in

sequence.

Note:



The loop function will take effect a few seconds after you select this option.

Flip

B If you select this option, the flip transition effect is displayed.
B If you clear this option, the flip transition effect is not displayed, and only
data on the first page is displayed.
Flip Animation Duration: To change the duration of the flip transition, enter a
value, or click + or -. The unit is milliseconds.
Flip Animation Stop Time: To change the interval of the flip transition, enter a
value, or click + or -. The unit is milliseconds.
Next Frame: To change the interval of the flip transition between two bars, enter
avalue, or click + or -.
Playback Interval: To change the overlap duration between two frames, enter a
value, or click + or -.
S o
NG This is along string.  This is a long string. 7 [EESREEENS

= o _ Row Padding
pis @ long string. This is a long string

Quantity

1S a long string. . Height

Loop ®
Flip

Flip Animation 800

Playback

Interval




- Index Numbers - Text Style: To display the index numbers, click the Eye icon.

- Font Size: To change the font size of the index numbers, enter a value, or click +
or —.

- Font Color: To change the font color of the index numbers, see Color picker.

- Right Margin: To adjust the horizontal spacing between the index numbers and
the displayed text, enter a value, or click + or —.

- Width: You can customize the width of the index number blocks as needed. The
unit is pixels.

- Border Radius: You can customize the border radius of the index number blocks
as needed. The unit is pixels.

- Background Color: To change the background color of the index number blocks,
see Color picker.

- Number Format: To set the format of the index numbers, click the drop-down

arrow and select the target format. The format can be 1, No., 1, or (1).

w Index Numbers

IS iS a long string. This is a long string. This is  [IRGESE

. Font Size
88 @ long string. This is a long string. RCBAD.0000
3 RGBA(D,0,0,0.6) @

Right Margin 10

Background #O0BAFF

Color

4 Number

Format




- Content

- Text Style
B Font Size: To change the font size of the displayed text, enter a value, or click +
or —.
B Font Color: To change the font color of the displayed text, see Color picker.
- Marquee: To display the marquee effect, click the Eye icon.
B Animation Duration: To change the time for displaying the scrolling text (seen

when text exceeds the bar width), enter a value, or click + or -. The unit is

milliseconds.

~ Content

B
ng




- Bars: To display the chart style, click the Eye icon.

- Gradient Colors: To add or delete a color, click + or click the Trash icon. The

colors of a bar change from left to right.

B Position: To change the scale of a color in a bar, enter a value or drag the

slider.

B Color: To change a color in a bar, see Color picker.

- Border Radius: You can customize the border radius of a bar as needed. The unit

is pixels.

- Gradient Coverage: To adjust the gradient range, click the drop-down arrow and

select the target range.

H Bar only
B Full width

~ Bars

ing. This is a long string. This is a long string. This is a long strin | NGRS

] Color 2

wlg string. This is a long string. This is a long string.

Position |

long string. This is a long string.
is is a long string. -

Border Radius  2pX

- Light Sweep: To display the light sweep option, click the Eye icon.

Color 3

- Animation Duration: To change the light sweep duration, enter a value, or click +

or —. The unit is milliseconds.

- Light Sweep Pause Time: To change the light sweep interval, enter a value, or

click + or -.

- Background Color

- Color: To change the background color of each bar, see Color picker.

[% Note:



If the value in the data pane is smaller than the maximum value, the difference

between the two values is filled with this color.

- Border Radius: You can customize the border radius of a background bar as

needed. The unit is pixels.

w Background Color

This is a long L This is a long string. This is a long ¢

Color #AAACBA

1 Border Radius  2px

Data
value :width of a bar. The larger the weight, the greater the proportion of a bar.
content :text displayed in each bar.

Interaction

This widget is not connected to any events yet.

6.3.2 Arc bar chart

You can add one or more arc bar charts to a project to view differences between the

data more clearly.
Style
Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Chart

- Inner Radius: To change the distance between the center point and the inner

arc, enter a value or drag the slider. The value range is from 0 to 1.

- Outer Radius: To change the distance between the center point and the outer

arc, enter a value or drag the slider. The value range is from 0 to 1.

- Arc Number: To change the number of arcs in the chart, enter a value, or click +

or —.

E] Note:

If the number of arcs is greater than that of the data types, the excessive arc or
arcs will be displayed transparently.
- Radius Padding: To adjust the spacing between the arcs, enter a value, or click +
or —.
- Max Angle: To change the maximum length of the outer arc, enter a value or
drag the slider. If the value is 360, the outer arc becomes a circle.

- Text Padding: To adjust the horizontal spacing between the text and the starting

points of the arcs, enter a value, or click + or -.

w» Chart

Inner Radius

Outer Radius
Arc Number 5

Radius
Padding

EVEL

Text Padding




- Gradient Options

- Start Color: To change the start color of the arcs, see Color picker.

- End Color: To change the end color of the outer arc, see Color picker.

y Chart

= Gradient Options

Start Color #O0DBAFF

End Color #ET3DAD

» Text Style

¥ Animation

. - @

- Text Style

- Font Family: To change the font of the displayed text, click the drop-down arrow
and select the target font. The default font is Microsoft YaHei.

- Font Size: To change the font size of the displayed text, enter a value, or click + or

- Font Color: To change the font color of the displayed text, see Color picker.
- Font Weight: To change the font weight of the displayed text, click the drop-
down arrow and select the target font weight.

~ Text Style

Font Family & Microsoft YaHei
Font Size 11 T

Font Color - RGBA(

Font Weight normal

» Animation




Data

?

- Animation: To display the animation option, click the Eye icon.

Original Duration: To change the duration to which the widget renders

the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

Easing: To set animation easing, click the drop-down arrow and select the target
effect.

Animations of All Series in Sequence: If you select this option, the animations
of all arcs in the chart are displayed in sequence. If you clear this option, the
animations of all arcs in the chart are displayed at the same time.

Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

Update from Latest Status: If you select this option, the animation begins from
the arc where the data has changed. If you clear this option, the animation

begins from the starting point.

~ Animation

label 1
label 2
label 3
label 4
label 5

Original 1000

Duration
Easing cubicInOut

Animations
All Series In

Sequence

Duration for

Data Up date

Update from

Latest Status

B et it

text :text corresponding to an arc.



value :adecimal number that corresponds to a percentage value. The maximum

valueis 1.
Data Source T'."'F‘E
Static Data

L
"label 1",

"label_2",

"label 3",

: "label 4",

Interaction
This widget is not connected to any events yet.
6.3.3 Grouped column chart

You can add one or more grouped column charts to a project to view the data

differences more clearly.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Chart

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Bar Options

B Inner Padding: To adjust the horizontal spacing between the columns, enter a
value or drag the slider. The value range is from 0 to 1.
B Outer Padding: To adjust spacing 1 (spacing between the leftmost column

and the y-axis) and spacing 2 (spacing between the rightmost column and the



right border of the chart), enter a value or drag the slider. The value range is

from 0 to 1.
B Background Color: To change the background color of the columns, see Color
picker.
- Margin
B Top: To adjust the spacing between the columns and the top border of the
chart, enter a value, or click + or -.

B Bottom: To adjust the spacing between the columns and the bottom border of

the chart, enter a value, or click + or -.

B Left: To adjust the spacing between the leftmost column and the left border of

the chart, enter a value, or click + or -.

B Right: To adjust the spacing between the rightmost column and the right

border of the chart, enter a value, or click + or -.

~ Chart
Font Family @
« Bar Options

Inner Padding
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- Label: To display the labels, click the Eye icon.
B Text Style

B Font Size: To change the font size of the label text, enter a value, or click +
or —.

B Font Color: To change the color of the label text, see Color picker.



B Font Weight: To change the font weight of the label text, click the drop-

down arrow and select the target font weight.
B Vertical Offset: You can customize the vertical offset of the labels as needed.

B Horizontal Offset: You can customize the horizontal offset of the labels as

needed.
w Label
« Text Style

Font Size 12

Font Color ] RGBA(25

Font normal

Weight
Vertical Offset

Horizontal




- X Axis: To display the x-axis, click the Eye icon.
- Text Style

B Color: To change the font color of the text along the x-axis, see Color picker.

B Font Size: To change the font size of the text along the x-axis, enter a value or

drag the slider. The value range is from 10 to 100.
B Font Weight: To set the font weight of the text along the x-axis, click the drop-

down arrow and select the target font weight.

B Tick Size: To change the length of the ticks along the x-axis, enter a value or

drag the slider. The value range is from 0 to 40.

B Label Distance from X Axis: To adjust the spacing between the text along the
x-axis and the x-axis, enter a value or drag the slider. The value range is from
-40 to 40.

B Assist Line: If you select this option, the axis line and ticks are displayed.
« Text Style

Color

Font Size

Font Weight  nommal

Assist Line




- Y Axis: To display the y-axis, click the Eye icon.
- Text Style

H Color: To change the font color of the text along the y-axis, see Color picker.
Bl Font Size: To change the font size of the text along the y-axis, enter a value or
drag the slider. The value range is from 10 to 100.
B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.
- Unit: You can set the unit of the label text along the y-axis as needed.
- Min: To set the format of the minimum value along the y-axis, click the drop-

down arrow and select the target value.

B Minimum data value
B Automatic rounding
- Max: To set the format of the maximum value along the y-axis, click the drop-

down arrow and select the target format.

B Maximum data value
B Automatic rounding

- Tick Size: To change the length of the ticks along the y-axis, enter a value or drag
the slider. The value range is from 0 to 40.

- Label Distance from Y Axis: To adjust the spacing between the text along the y-
axis and the y-axis, enter a value or drag the slider. The value range is from -40

to 40.

- Assist Line: If you select this option, the axis line and ticks are displayed.
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- Series: To add or delete a series, click + or click the Trash icon.

- Color: To set the fill color type, click the drop-down arrow and select the target

type. To change the color of a series, see Color picker.

H Solid fill
B Gradient fill

B You can select two colors as the gradient colors.
B To change the gradient angle, enter a value or drag the slider. The value
range is from 0 to 360.

- Series to Type

B If you select this option, the column chart is displayed in type mode. If the
type mode is not displayed, check whether you have set the s field, which

defines the column type. A category corresponds to a specific type.
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B If you clear this option, the column chart is displayed in series mode. If the

series mode is not displayed, check whether you have set the s field, which



defines the column type. For example, if you set two series, two columns are

displayed for each category.
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Color Gradient Fill
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#000

Series to Type

- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the columns of different series are displayed in sequence. If you clear this



option, the animations of the columns of different series are displayed at the
same time. This option takes effect only when two or more series are set.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the column where the data has changed. If you clear this option, the animation

begins from the starting point.

~ Animation

Original

Duration

Easing cubicInOut

Sequence

Duration for

Data Update

Updat

Data

x : category text of each column

y :actual data value of each column

s : (optional) series data

Data Source Type
Static Data
[
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Interaction

This widget is not connected to any events yet.



6.3.4 Configure a capsule column chart
This topic describes how to configure a capsule column chart on a dashboard to

display differences of series of data.
Configure the configuration plane
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar

B Inner Padding: To adjust the spacing between the columns, enter a value or
drag the slider. The value range is from 0 to 1.

B Outer Padding: To adjust the left space (between the leftmost column and the
left border of the chart) and the right space (between the rightmost column



and the right border of the chart), enter a value or drag the slider. The value

range is from 0 to 1.

B Capsule Padding: To adjust the spacing between the columns and the capsule

borders, enter a value, or click + or -.

B Border Color: To change the color of the capsule borders, see Color picker.

B Border Size: To change the width of the capsule borders, enter a value, or
click + or -.

B Padding Color: To change the color of the column borders, see Color picker.

- Margin

B Top: To adjust the spacing between the columns and the top border of the
chart, enter a value, or click + or -.

B Bottom: To adjust the spacing between the columns and the bottom border of
the chart, enter a value, or click + or -.

B Left: To adjust the spacing between the leftmost column and the left border of
the chart, enter a value, or click + or -.

B Right: To adjust the spacing between the rightmost column and the right

border of the chart, enter a value, or click + or -.
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- Label: Click the Eye icon to display labels on columns.
- Text Style

Bl Font Size: Set the font size of the label text by entering a value or clicking + or

B Font Color: Set the color of the label text. For more information, see Configure
item description.
B Font Weight: Select a font weight for the label text from the drop-down list.

- Position: Select a position for the label from the drop-down list.

B Top
B Center
B Bottom
- Empty Data: Select this check box to display a label for a column without data.
If you do not select this check box, labels are not displayed for columns without

data.



- Maximum Data: Set the maximum data value that a label can display by entering a

value or clicking + or -.

Font Color #000

Font normal

Weight

Position Center

Empty Data

- X Axis: To display the x-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.

H Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Angle: To set the angle of the axis labels, click the drop-down arrow and select
the target angle.
B Horizontal
B Slant
B Vertical

B Quantity: To change the number of axis labels, enter a value, or click + or -.

@ Note:



If you set the Quantity field to 0, the axis labels are automatically displayed

according to the data and the number of the columns.

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

H Color: To change the color of the grid lines, see Color picker.
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- Y Axis: To display the y-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Max: To set the display format of the maximum value along the y-axis, click

the drop-down arrow and select the target format.
B Maximum data value
B Automatic rounding
B Quantity: To change the number of axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the y-axis as needed.

- Axis Line: To display the axis line, click the Eye icon.

H Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye icon.

- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.

- Layout
B Margin

B Horizontal Interval: To adjust the space between two legends, enter a value
or click + or —. This parameter is available only if the chart has multiple

series of data.

B Vertical Interval: To adjust spacing 1 (spacing between the legend items
and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center

B Bottom left

B Bottom right
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Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s is automatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For

more information, see Frequently asked questions (User self-check process).

Color: To set the fill color type, click the drop-down arrow and select the target

type. To change the color of a series, see Color picker.

H Solid fill
B Gradient fill

B You can select two colors as the gradient colors.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
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- Animation: Click the Eye icon to display animation parameters.

- Original Duration: Set the time length (in milliseconds) for rendering an
animation for the first time. To set this parameter, enter a value or click + or -.

- Easing: Select an animation style from the drop-down list.

- Animations of All Series In Sequence: Select this check box to set the animations
of all series of data to be played in sequence. If you do not select this check box,
the animations of all series of data are played at the same time.

- Duration for Data Update: Set the time length (in milliseconds) at which the
animation of the data is updated by entering a value or clicking + or -.

- Update from Latest Status: If you select this check box, data updates start from
the value of the original data. If you do not select this check box, data updates

start from 0.

w» Animation
+*

Original

Duration
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Duration for

Data Update

Configure the data plane

x : Set the category text of each column.
y : Set the actual data value of each column.

s : (Optional) Set series data.
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Configure the interaction plane

This widget is not connected to any events yet.

6.3.5 Basic column chart
You can add one or more basic column charts to a project to view differences between

the series more clearly.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar Options

B Inner Padding: To adjust the spacing between the columns, enter a value or
drag the slider. The value range is from 0 to 1.
B Outer Padding: To adjust spacing 1 (spacing between the leftmost column

and the y-axis) and spacing 2 (spacing between the rightmost column and the



right border of the chart), enter a value or drag the slider. The value range is

from 0 to 1.
H Color: To change the background color of the columns, see Color picker.
- Margin
B Top: To adjust the spacing between the chart and the top border, enter a
value, or click + or -.

B Bottom: To adjust the spacing between the chart and the bottom border, enter
avalue, or click + or -.

B Left: To adjust the spacing between chart and the left border, enter a value, or
click + or -.

B Right: To adjust the spacing between the chart and the right border, enter a
value, or click + or -.

- Label: To display the labels, click the Eye icon.
B Text Style

B Font Size: To change the font size of the label text, enter a value, or click +
or —.

H Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To set the font weight of the label text, click the drop-down
arrow and select the target font weight.

B Position: To change the position of the labels, click the drop-down arrow and

select the target position.

B Top
Bl Center
H Bottom

B Empty Data: If you select this option, the label text is not displayed.
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- X Axis

- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Angle: To set the angle of the axis labels, click the drop-down arrow and select
the target angle.
B Horizontal
H Slant
M Vertical

B Quantity: To change the number of axis labels, enter a value, or click + or -.

Note:



If you set this field to 0, the axis labels are automatically displayed according

to the data and the number of the columns.
- Axis Line: To display the axis line, click the Eye icon.
B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

H Color: To change the color of the grid lines, see Color picker.
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- Y Axis: To display the y-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Max: To set the display format of the maximum value along the y-axis, click

the drop-down arrow and select the target format.

Note:



The value auto indicates automatic rounding.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the y-axis as needed.
- Axis Line: To display the axis line, click the Eye icon.
B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.
B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the left border of the chart) and spacing 2 (spacing between the legend
items and the right border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right
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Series: To add or delete a data series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s is automatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For

more information, see Frequently asked questions (User self-check process).
- Color: To set the fill color type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a series, see Color picker.
B Gradient fill
B You can select two colors as the gradient colors. For more information, see
Color picker.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
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- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or -. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the columns of different series in the chart are displayed in sequence. If you



clear this option, the animations of the columns of different series in the chart

are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the column where the data has changed. If you clear this option, the animation

begins from the starting point.
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Interaction

This widget is not connected to any events yet.

6.3.6 Basic bar chart

You can add one or more basic bar charts to a project to view differences between the

series more clearly.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar

B Inner Padding: To adjust the spacing between the bars, enter a value or drag

the slider. The value range is from 0 to 1.

Note:
Each label corresponds to a group.

B Outer Padding: To adjust spacing 1 (spacing between the bottom bar and the
bottom border of the chart) and spacing 2 (spacing between the top bar and



the top border of the chart), enter a value or drag the slider. The value range

isfromOto 1.
B Color: To change the background color of the bars, see Color picker.
- Margin
B Top: To adjust the spacing between the bars and the top border of the chart,
enter a value, or click + or -.

B Bottom: To adjust the spacing between the bars and the bottom border of the

chart, enter a value, or click + or -.

B Left: To adjust the spacing between the bars and the left border of the chart,

enter a value, or click + or -.

B Right: To adjust the spacing between the bars and the right border of the

chart, enter a value, or click + or -.

- Label: To display the labels, click the Eye icon.
B Text Style

B Font Size: To change the font size of the label text, enter a value, or click +
or —.

H Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To set the font weight of the label text, click the drop-down
arrow and select the target font weight.

B Position: To set the position of the labels, click the drop-down arrow and

select the target position.
B Left

B Middle

M Right

B Right outside

Note:



The labels will be displayed outside the bar segments only when you select

Right Outside .

B Empty Data: If you select this option, 0 is displayed when the y-axis has no
data.
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- X Axis: To display the x-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.
B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-

down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Max: To set the display format of the maximum value along the x-axis, click

the drop-down arrow and select the target format.

Note:



The value auto indicates automatic rounding.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the x-axis as needed.
- Axis Line: To display the axis line, click the Eye icon.
B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.

- X Aas
~ Text Style

Font Size

Font Color

Font Weight normal
= Moas Label

Max @ Maximum Data Value

Quantity 6

Heilongliang

Display 11 (Integer)

Anhu
Format &

Fujian
Unit | -~ Unit
Unit
« Mas Line
Calor - RGBA(25

« Gnd Lines

Color




- Y Axis: To display the y-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the y-axis, enter a value, or
click + or -.
B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-

down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

Angle: To set the angle of the axis labels, click the drop-down arrow and select

the target angle.

B Horizontal
B Slant
B Vertical

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.

~ Text Style

Font Size 10

Heilongliang oo | Font Color Il RGBA(
:J.'ll"._Ji 1
Fujian - - Font Weight mormal

w Mouas Label

Angle Horizontal

~ Axis Line

Color

w Grid Lines

Color




- Legend: To display the legend items, click the Eye icon.

- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.

B Font Weight: To set the font weight of the legend text, click the drop-down

arrow and select the target font weight.

- Layout
B Margin

B Horizontal Interval: To adjust spacing 1 (spacing between the legend items

and the left border of the chart) and spacing 2 (spacing between the legend



items and the right border of the chart), enter a value, or click + or —. The

setting takes effect only when two or more series exist.

B Vertical Interval: To adjust spacing 1 (spacing between the legend items
and the top border of the chart) and spacing 2 (spacing between the legend
items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

W Top left

B Top right

B Bottom center
B Bottom left

B Bottom right
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- Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s is automatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For

more information, see Frequently asked questions (User self-check process).
- Color: To set the color fill type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a series, see Color picker.
B Gradient fill
B You can select two colors as the gradient colors. For more information, see
Color picker.

B To adjust the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
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- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the bars of different series in the chart are displayed in sequence. If you



clear this option, the animations of the bars of different series in the chart are
displayed at the same time.
- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the bar where the data has changed. If you clear this option, the animation

begins from the starting point.
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Interaction

This widget is not connected to any events yet.



6.3.7 Capsule bar chart

You can add one or more capsule bar charts to a project to view differences between

the series more clearly.
Style
- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar

B Inner Padding: To adjust the spacing between the bars, enter a value or drag
the slider. The value range is from 0 to 1.

B Outer Padding: To adjust spacing 1 (spacing between the top bar and the
top border) and spacing 2 (spacing between the bottom bar and the bottom

border), enter a value or drag the slider. The value range is from 0 to 1.

B Capsule Padding: To adjust the spacing between the bars and the capsule

borders, enter a value, or click + or -.

B Border Color: To change the color of the capsule borders, see Color picker.

B Border Size: To change the width of the capsule borders, enter a value, or
click + or -.

B Padding Color: To change the color of the bar borders, see Color picker.

- Margin

B Top: To adjust the spacing between the bars and the top border of the chart,
enter a value, or click + or -.

B Bottom: To adjust the spacing between the bars and the bottom border of the
chart, enter a value, or click + or -.

B Left: To adjust the spacing between the bars and the left border of the chart,
enter a value, or click + or -.

B Right: To adjust the spacing between the bars and the right border of the

chart, enter a value, or click + or -.
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- X Axis: To display the x-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.
B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-

down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Max: To set the display format of the maximum value along the x-axis, click

the drop-down arrow and select the target format.

Note:



The value auto indicates automatic rounding.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-
down arrow and select the target format.
B Angle: To set the angle of the axis labels, click the drop-down arrow and select

the target angle.

Bl Horizontal
B Slant
B Vertical

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the x-axis as needed.

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Y Axis: To display the y-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the y-axis, enter a value, or
click + or -.
B Font Color: To change the font color of the text along the y-axis, see Color

picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-

down arrow and select the target font weight.
- Axis Label: To display the axis labels, click the Eye icon.
- Axis Line: To display the axis line, click the Eye icon.
B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the left border of the chart) and spacing 2 (spacing between the legend
items and the right border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right
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Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s is automatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For

more information, see Frequently asked questions (User self-check process).
- Color: To set the fill color type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a series, see Color picker.
B Gradient fill
B You can select two colors as the gradient colors. For more information, see
Color picker .

B To adjust the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
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- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the bars of different series in the chart are displayed in sequence. If you



clear this option, the animations of the bars of different series in the chart are
displayed at the same time.
- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the bar where the data has changed. If you clear this option, the animation

begins from the starting point.
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Interaction

This widget is not connected to any events yet.

6.3.8 Grouped bar chart
You can add one or more grouped bar charts to a project to view data differences

between the groups more clearly.
Style
- Basic Attributes
- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.
- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Bar

B Inner Padding: To adjust the horizontal spacing between the bars, enter a

value or drag the slider. The value range is from 0 to 1.

[% Note:



Each label corresponds to a group.

B Outer Padding: To adjust spacing 1 (spacing between the bottom bar and
the bottom border) and spacing 2 (spacing between the top bar and the top
border), enter a value or drag the slider. The value range is from 0 to 1.

- Margin

B Top: To adjust the spacing between the bars and the top border of the chart,

enter a value, or click + or -.

B Bottom: To adjust the spacing between the bars and the bottom border of the

chart, enter a value, or click + or -.

B Left: To adjust the spacing between the bars and the left border of the chart,

enter a value, or click + or -.

B Right: To adjust the spacing between the bars and the right border of the

chart, enter a value, or click + or -.

- Label: To display the labels, click the Eye icon.
B Text Style

B Font Size: To change the font size of the label text, enter a value, or click +
or —.

B Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To change the font weight of the label text, click the drop-
down arrow and select the target font weight.

B Position: To set the position of the labels, click the drop-down arrow and

select the target position.

W Left
H Middle
H Right
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- X Axis: To display the x-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Min: To set the display format of the minimum value along the x-axis, click

the drop-down arrow and select the target format.
B Minimum data value

B Automatic rounding

B Max: To set the display format of the maximum value along the x-axis, click

the drop-down arrow and select the target format.

Note:

The value auto indicates automatic rounding.

B Maximum data value
B Automatic rounding

B Quantity: To change the number of axis labels, enter a value, or click + or -.

Note:



If you set this field to 0, the axis labels are automatically displayed according

to the data and the number of the bars.

Bl Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the x-axis as needed.
- Axis Line: To display the axis line, click the Eye icon.
B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.
B Color: To change the color of the grid lines, see Color picker.
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- Y Axis: To display the y-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the y-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color

picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-

down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.
B Angle

B Horizontal
B Slant
B Vertical

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Decoration

B Decoration Line: To change the color of the decoration lines, see Color picker.

B Decoration Shape Fill: To change the color of the decoration pentagons, see

Color picker.

B Decoration Shape Stroke: To change the color of the decoration pentagon

strokes, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the right border of the chart) and spacing 2 (spacing between the
legend items and the left border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right
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Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s is automatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For
more information, see Frequently asked questions (User self-check process).

- Color: To set the fill color type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a series, see Color picker.

B Gradient fill

B You can select two colors as the gradient colors. For more information, see

Color picker.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
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- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the bars of different series in the chart are displayed in sequence. If you



clear this option, the animations of the bars of different series in the chart are
displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the bar where the data has changed. If you clear this option, the animation

begins from the starting point.
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Data Source Type

Static Data
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"Zhejiang",

“Liaoning”,

Interaction

This widget is not connected to any events yet.

6.3.9 Trapezoid column chart
You can add one or more trapezoid column charts to a project to view data differences

between the groups more clearly.
Style
- Basic Attributes
- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.
- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar

B Inner Padding: To adjust the horizontal spacing between the columns, enter a

value or drag the slider. The value range is from 0 to 1.

[% Note:



Each label corresponds to a group.
B Outer Padding: To adjust spacing 1 (spacing between the leftmost column

and the y-axis) and spacing 2 (spacing between the rightmost column and the



right border of the chart), enter a value or drag the slider. The value range is

from 0 to 1.

B Group Padding: To adjust the spacing between the columns in a group, enter a

value or drag the slider. The value range is from 0 to 1.
Bl Slope: To change the angle of the slope at the bottom of each column, enter a
value, or click + or -.
- Margin
B Top: To adjust the spacing between the columns and the top border of the
chart, enter a value, or click + or -.

B Bottom: To adjust the spacing between the columns and the bottom border of

the chart, enter a value, or click + or -.

B Left: To adjust the spacing between the columns and the left border of the

chart, enter a value, or click + or -.

B Right: To adjust the spacing between the columns and the right border of the

chart, enter a value, or click + or -.

- Label: To display the labels, click the Eye icon.
B Text Style

B Font Size: To change the font size of the label text, enter a value, or click +
or —.

B Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To change the font weight of the label text, click the drop-
down arrow and select the target font weight.

B Position: To set the position of the labels, click the drop-down arrow and

select the target position.
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- X Axis: To display the x-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.
B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-

down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.
B Angle

B Horizontal
B Slant
B Vertical

B Quantity: To change the number of axis labels, enter a value, or click + or -.

Note:



If you set this field to 0, the axis labels are automatically displayed according

to the data and the number of the columns.

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.
- Grid Lines: To display the grid lines, click the Eye icon.

H Color: To change the color of the grid lines, see Color picker.
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- Y Axis: To display the y-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Min: To set the display format of the minimum value along the y-axis, click

the drop-down arrow and select the target format.

B Minimum data value
B Automatic rounding

B Max: To set the display format of the maximum value along the y-axis, click

the drop-down arrow and select the target format.

Note:



The value auto indicates automatic rounding.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the x-axis as needed.

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the right border of the chart) and spacing 2 (spacing between the
legend items and the left border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right
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Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s is automatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For

more information, see Frequently asked questions (User self-check process).
- Color: To set the fill color type, click the drop-down arrow and select the target
type. To change the color of a series, see Color picker.
B Solid fill: To change the color of a series, see Color picker.
B Gradient fill
B You can select two colors as the gradient colors. For more information, see
Color picker.

B To change the gradient angle, enter a value or drag the slider. The value
range is from 0 to 360.
Unit |+ Series
Series 2
Series Name This is Series 1

Color Solid Fill

’

fFODBAFF

This is Series 1 W This is Series 2

- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the columns of different series in the chart are displayed in sequence. If you



clear this option, the animations of the columns of different series in the chart

are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the column where the data has changed. If you clear this option, the animation

begins from the starting point.
~ Animation

Original 1000

Unit

Duration
Easing cubiclnOut

Animations of
All Series In

Sequence

Duration for

Data U P date

Update from

Latest Status

Data

x :category text of each column
y :actual data value of each column
s : (optional) series data
Data Source Type

Static Data

I a .
"Anhui™,

178",
.




Interaction
This widget is not connected to any events yet.
6.3.10 Line column chart

You can add one or more line column charts to a project to view differences between

the series more clearly.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Margin
B Top: To adjust the spacing between the column chart and the top border,
enter a value, or click + or -.
B Bottom: To adjust the spacing between the column chart and the bottom
border, enter a value, or click + or -.
B Left: To adjust the spacing between the column chart and the left border,
enter a value, or click + or -.
B Right: To adjust the spacing between the column chart and the right border,
enter a value, or click + or -.

- Bar

B Inner Padding: To adjust the horizontal spacing between the columns, enter a
value or drag the slider. The value range is from 0 to 1.

B Outer Padding: To adjust spacing 1 (spacing between the leftmost column and
the y-axis) and spacing 2 (spacing between the rightmost column and the z-
axis), enter a value or drag the slider. The value range is from 0 to 1.

B Color: To change the background color of the columns, see Color picker.



« Global Settings

Font Family Microsoft YaHei

) ~ Margin
Unit

Top
Bottom
Left
Right

~ Bar

Inner Padding

Outer Padding

- X Axis: To display the x-axis, click the Eye button.
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.

H Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To change the font weight of the text along the x-axis, click the
drop-down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye button.
B Angle

B Horizontal
B Slant
B Vertical

B Quantity: To change the number of axis labels, enter a value, or click + or -.

E] Note:



If you set this field to 0, the axis labels are automatically displayed according

to the data and the number of the columns.

- Axis Line: To display the axis line, click the Eye button.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye button.

H Color: To change the color of the grid lines, see Color picker.

« Text Style

Font Size
Font Color
Font Weight

= Axis Label
Angle
Quantity

= Axis Line
Color

w Gnd Lines

Color

normal




- Y Axis: To display the y-axis, click the Eye button.

- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye button.

B Min: To set the display format of the minimum value along the y-axis, click

the drop-down arrow and select the target format.

B Minimum data value
B Automatic rounding

B Max: To set the display format of the maximum value along the y-axis, click

the drop-down arrow and select the target format.

Note:



The value auto indicates automatic rounding.

B Maximum data value

B Automatic rounding

B Quantity: To change the number of axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

- Unit: To display the unit option, click the Eye button.

B Unit: You can set the unit of the label text along the y-axis as needed.

- Axis Line: To display the axis line, click the Eye button.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye button.

B Color: To change the color of the grid lines, see Color picker.

- ¥ Aois

~ Text Style
Font Size
Font Color
Font Weight

~ Axis Label
Min @
Max (&
Quantity

Display

Format (3
Unit

Unit

~ Axis Line
Color
Grid Lines

Color

Il RGBA

normal

Maximum Data Value

6

11 (Integer)

Il #FFA3oE




- 7 Axis: To display the z-axis, click the Eye button.
- Text Style

B Font Size: To change the font size of the text along the z-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the z-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the z-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye button.

B Min: To set the display format of the minimum value along the z-axis, click

the drop-down arrow and select the target format.

B Minimum data value
B Automatic rounding

B Max: To set the display format of the maximum value along the z-axis, click

the drop-down arrow and select the target format.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of axis labels, enter a value, or click + or -.
B Display Format: To set the display format of the axis labels, click the drop-
down arrow and select the target format.

- Unit: To display the unit option, click the Eye button.

B Unit: You can set the unit of the label text along the z-axis as needed.

- Axis Line: To display the axis line, click the Eye button.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye button.

B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye button.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the right border of the chart) and spacing 2 (spacing between the
legend items and the left border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right
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- Series: To add or delete a series, click +or click the Trash icon.

- Series: You can set a value for this series as needed. This value corresponds to

the s field in the Data pane.

- Bar

B Series Name: You can set a name for the series as needed. If the series does
not have a name, the value of s isautomatically displayed as the series

name.

W Color: To set the fill color type, click the drop-down arrow and select the
target type.

B Solid fill: To change the color of a series, see Color picker.

B Gradient fill

B You can select two colors as the gradient colors. For more information,

see Color picker.
B To change the gradient angle, enter a value or drag the slider. The value
range is from 0 to 360.

B Label

B Font Size: To change the font size of the column label text, enter a value, or
click + or -.

B Color: To change the font color of the column label text, see Color picker.

B Font Weight: To set the font weight of the column label text, click the drop-
down arrow and select the target font weight.

B Position: To set the position of the column label text, click the drop-down

arrow and select the target position.

B Top
Bl Middle
H Bottom



~ Series

Font

Color I #FFF

Font normal

Weight

Position

- Line

@ Notice:



The line is displayed only when the z field has a value.

B Series Name: You can set the series name of the line as needed. If the series

does not have a name, the value of s isautomatically displayed as the series
name.

B Color: To set the fill color type, click the drop-down arrow and select
the target type. You can change the color of the line as needed. For more

information, see Color picker.

M Solid fill
B Gradient fill

B Style: To change the line style, click the drop-down arrow and select the target
style.

B Solid line

B Dotted line
B Width: To change the line width, enter a value, or click + or -.
B Curve: If you select this option, the line is displayed as a curve.

Bl Point Style

B Radius: To change the radius of the points, enter a value, or click + or -.

H Label

B Font Size: To change the font size of the label text along the line, enter a

value, or click + or -.
H Color: To change the font color of the label text along the line, see Color
picker.

B Font Weight: To set the font weight of the label text along the line, click the

drop-down arrow and select the target font weight.



Line
Il #3DEVCY
Solid Line
Width
Curve
« Point Style
Radius
w Label

Font Size 0

Color - #FFF

Font normal

Weight

Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or -. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the columns of different series in the chart are displayed in sequence. If you



clear this option, the animations of the columns of different series in the chart
are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the column where the data has changed. If you clear this option, the animation

begins from the starting point.
= Animation

r
Unit Original
97 | Duration
Easing cubicInOut
Animations of
All Series In

Sequence

Duration for

Data Update

Update from

Data

x : category text of each column
y :actual data value of each column
z :actual data value along the line

s : (optional) series value



= Optional

Data Source Type

Static Data

1

Data filter:

Interaction

This widget is not connected to any events yet.

6.3.11 Dot column chart

You can add one or more dot column charts to a project to display the data differences

more clearly.
Style
- Basic Attributes
- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.
- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar

B Inner Padding: To adjust the horizontal spacing between the columns, enter a

value or drag the slider. The value range is from 0 to 1.

@ Note:



Each label corresponds to a group.
B Outer Padding: To adjust spacing 1 (spacing between the leftmost column
and the y-axis) and spacing 2 (spacing between the rightmost column and the

right border), enter a value or drag the slider. The value range is from 0 to 1.

B Stroke Width: To change the width of each stroke, enter a value, or click + or

B Line Padding: To adjust the spacing between the strokes, enter a value, or
click + or -.
- Margin
B Top: To adjust the spacing between the column chart and the top border,
enter a value, or click + or -.

B Bottom: To adjust the spacing between the column chart and the bottom

border, enter a value, or click + or -.

B Left: To adjust the spacing between the column chart and the left border,

enter a value, or click + or -.

B Right: To adjust the spacing between the column chart and the right border,

enter a value, or click + or -.

- Label: To display the labels, click the Eye icon.
B Text Style

B Font Size: To change the font size of the label text, enter a value, or click +
or —.

H Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To set the font weight of the label text, click the drop-down
arrow and select the target font weight.

B Empty Data: If you select this option, 0 is displayed when the y-axis has no
data.



~ Global Settings
Font Famil
Bar

Inner Padding —#
Unit 0

Outer Padding

Stroke Width

Line Padding

Bottom
Left

Right

I #FF

normal

Weight

Empty Data

B.




- X Axis

- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Angle: To set the angle of the axis labels along the x-axis, click the drop-down
arrow and select the target angle.
B Horizontal
H Slant
B Vertical

B Quantity: To change the number of axis labels along the x-axis, enter a value,

or click + or -.

Note:



If you set this field to 0, the axis labels are automatically displayed according

to the data and the number of the columns.

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

H Color: To change the color of the grid lines, see Color picker.

Font Size 10

Font Color Il RGB
Font Weight normal
Axas Label

Angle

Quantity

This is Series 1 Axis Line

Color

Grid Lines

Color




- Y Axis: To display the y-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Min: To set the display format of the minimum value along the y-axis, click

the drop-down arrow and select the target format.

B Minimum data value
B Automatic rounding

B Max: To set the display format of the maximum value along the y-axis, click

the drop-down arrow and select the target format.

Note:



The value auto indicates automatic rounding.

B Maximum data value
B Automatic rounding

B Quantity: To change the number of axis labels along the y-axis, enter a value,

or click + or -.

B Display Format: To set the display format of the axis labels along the y-axis,
click the drop-down arrow and select the target format.

- Unit: To display the unit option, click the Eye icon.

B Unit: You can set the unit of the label text along the y-axis as needed.

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.

B Font Weight: To set the font weight of the legend text, click the drop-down

arrow and select the target font weight.

- Layout
B Margin

B Horizontal Interval: To adjust spacing 1 (spacing between the legend items

and the right border of the chart) and spacing 2 (spacing between the



legend items and the left border of the chart), enter a value, or click + or -.

The setting takes effect only when two or more series are set.

B Vertical Interval: To adjust spacing 1 (spacing between the legend items
and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

W Top left

B Top right

B Bottom center

B Bottom left

B Bottom right

« Legend
= Text Style

Font Size 10

Font Color Il RGBA

Font Weight  nmormal

~ Layout

Interval

Vertical

Interval

Position Bottom Center

- Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of s isautomatically displayed as the series name. If



the series has a name, ensure that the data is displayed in the proper order. For

more information, see Frequently asked questions (User self-check process).
- Color: To set the fill color type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a series, see Color picker.
B Gradient fill
B You can select two colors as the gradient colors. For more information, see
Color picker.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.

« Series

Series Mame This is Series 1

Color #D0BAFF

- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations

of the columns of different series in the chart are displayed in sequence. If you



clear this option, the animations of the columns of different series in the chart
are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the column where the data has changed. If you clear this option, the animation

begins from the starting point.

~ Animation

.- g
Unit

Original

Duration

Easing cubicInOut

Sequence
Duration for
Data Update

This is Series 1 Update from

e mmmmm———————

Latest Status

Data

x :category text of each column
y :actual data value of each column

s : (optional) series value

Data Source Type

Static Data

: "Inner Mongolia™,

"Zhejiang"”,




Interaction

This widget is not connected to any events yet.

6.4 Line charts
6.4.1 Area chart

The area chart widget allows you to customize the chart style, the display of different

series data, and other options as ne eded.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Margin: Spacing between the chart and the chart borders. The unit is pixels.

- Empty Data: If you select this option, the line and the x-axis intersect at the point

where the value corresponding to the y-axis is 0. If you clear this option, the line



and the x-axis do not intersect at the point where the value corresponding to the

y-axis is 0.

w Global Settings

— e .

Main Titte  $233Dollars Font Family @ | Microsoft YaHei

~ Margin
Top
Bottom
Left
Right

Empty Data

1
|
?
.

inTi : itle Name Main Title
Main Title $ Dollars Title Mam ain Ti

« Text Style

Font ¢ 20

ol Font Color
01,0 021 02/ 0401 0500 D6,

-—

""""""""""""""" ————————————— ¢ Font Weight normial



- Title

- Title Name: You can set a name for the chart as needed.

- Text Style: You can set the text style of the title as needed.

B Font Size: To change the font size of the title text, enter a value, or click + or -.

B Font Color: To change the font color of the title text, see Color picker.

B Font Weight: To change the font weight of the title text, click the drop-down

arrow and select the target font weight.

Mail'l Tlﬂe $ DD”EII'S Title Mame Main Title

; Liniit

— « Text Style

Font Size

Font Color

Font Weight  normal



- Ticker Board

- Horizontal Alignment: To set the position of the ticker board, click the drop-
down arrow and select the target position.
H Align right
B Align left

B Center alignment

IR e L]

Main Title | $

Unit Honzontal Align Right

« Ticker Board

375 Alignment
225

150

75

w Prefic

ol =
Ol 0201 031 0401 0501 O6ML Content

T

- Prefix

B Content: You can customize the prefix as needed.

B Text Style

B Font Color: To change the font color of the prefix, see Color picker.

B Font Size: To change the font size of the prefix, enter a value or drag the

slider. The value range is from 0 to 100.

B Font Weight: To change the font weight of the prefix, click the drop-down

arrow and select the target font weight.
~ Prefix
Content

Main Title $233Dollars —
; Uit ~ Text Style

Font Color ] RGBA(255,255,255 0

Font Size —Bn

0

Font normal

Weight

- Numbers
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By default, the maximum data value is displayed.
B Text Style

B Font Color: To change the font color of the data value, see Color picker.
Bl Font Size: To change the font size of the data value, enter a value or drag
the slider. The value range is from 0 to 100.

B Font Weight: To change the font weight of the data value, click the drop-

down arrow and select the target font weight.

B Spacing of Numbers: To adjust the spacing between the numbers contained in

the data value, enter a value or drag the slider. The value range is from 0 to 1.

Font Color #O0BAFF

Dollars

Font Size —H
0

Font normal

1 0401 0501 0601 Weight

Spacing of [ |

MNumbers

B Background Color: To change the background color of the data value, see
Color picker.

B Default Digits: To change the number of digits, enter a value or drag the
slider. The value range is from 0 to 100.

B Rounding: If you select this option, the data value is automatically rounded. If

you clear this option, the data value is not rounded.

B Thousands Separator: If you select this option, a thousands separator is

inserted. If you clear this option, no thousands separator is inserted.

B Thousands Separator Symbol: You can customize the thousands separator

symbol as needed.

B Decimal Symbol: You can customize the decimal symbol as needed.
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Only one character is allowed. If more than one character is entered, the first

character will be used. Numbers cannot be used as separators.

~ Ticker Board

SPALINY W

Background [l RGBA(51,5151.0) @

Color

Default Digits

Rounding

0401 0501 06T T e

Separator

Thousands
Separator

Symbol @

Decimal

Symbol &

Suffix

H Content: You can customize the suffix as needed.

B Text Style

H Font Color: To change the font color of the suffix, see Color picker.
B Font Size: To change the font size of the suffix, enter a value or drag the
slider. The value range is from 0 to 100.

B Font Weight: To change the font weight of the suffix, click the drop-down

arrow and select the target font weight.



« Suffix

Content Dollars

= Text Style

Font Color [l RGBA(

0401 0501 051 Font Size —

I -

Font normal

Weight

- X Axis: To display the x-axis, click the Eye icon.
- Text Style
B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color

picker.

B Font Weight: To change the font weight of the text along the x-axis, click the

drop-down arrow and select the target font weight.

Main Title  $233Dollars

«|Text Style

Font Size

Font Color Il RGBA(255,

Font Weight normal

- Axis Label: To display the axis labels, click the Eye icon.

E] Note:



An error will be displayed if the data format differs from the data format set for
the x field in the data pane.

B Category Type: To set the type of data along the x-axis, click the drop-down
arrow and select the target type.

B Numeric
B Category
Bl Time

B Data Format: To set the original format of the data, click the drop-down arrow

and select the target format.

[% Note:

The following is an example: %Y/%m/%d%H:%M:%S.
B Display Format: To set the display format of the data, click the drop-down

arrow and select the target format.

[% Note:

Time format: %m/%d%Y%H:%M:%S; integer format: d; floating-point
number: .1f.

« Moas Label
Main Title $233Dollars

Unit Category Type Time
375
300
235

150

75

Data Format 2016,/01,/01 02:30:00

[ ! | AW kN % )
. e e e Display 01/01{Month/Day)

Format (3

B Margin: If you select this option, spacing 1 (spacing between the chart and the
y-axis) and spacing 2 (spacing between the chart and the right border of the



chart) are displayed. If you clear this option, spacing 1 and spacing 2 are not
displayed.
B Margin Size: To adjust spacing 1 and spacing 2, enter a value or drag the

slider. The value range is from 0 to 1.

Margin

0L/01 0201 03/00 0400 0501 0&0L . e
Margin Size —H

0

--------------------- e

B Min/Max: You can customize the minimum and maximum values along the x-

axis as needed.

B Offset: To adjust the spacing between the labels along the x-axis, enter a
value, or click + or -.

B Unit: You can customize the unit of the text along the x-axis as needed.

B Quantity: To change the number of labels along the x-axis, enter a value, or
click + or -.

B Angle: To set the angle of the labels along the x-axis, click the drop-down
arrow and select the target angle. The options include horizontal, slant, and

vertical.

T_ --------------------- -———————— ]
Main Title  $233Dollars

| Unit Offset

1 i

Unit

75 Quantity
i
0L/01 0201 03700 0401 0501 0601

| S b

Angle Select

. Honzontal
= Moas Line
Slant

Vertical

Color

B Axis Line: To display the axis line, click the Eye icon. To change the color of
the axis line, see Color picker.
= Auds Line

0L/l 02/01 03M0 0401 0501 0601

--------------------- B |

Color




B Grid Lines: To display the grid lines, click the Eye icon. To change the color of

the grid lines, see Color picker.

~ Gnd Lines

Color

- Y Axis

For more information about how to set the y-axis, see X Axis.

- Legend: To display the legend items, click the Eye icon.
- Text Style

Bl Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To change the font weight of the legend text, click the drop-
down arrow and select the target font weight.
- Layout

B Margin

B Horizontal Spacing: To adjust spacing 1 (spacing between the legend items

and the right border of the chart) and spacing 2 (spacing between the



legend items and the left border of the chart), enter a value, or click + or -.

The setting takes effect only when two or more legend items are available.

B Vertical Spacing: To adjust spacing 1 (spacing between the legend items
and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend item or legend items, click the drop-

down arrow and select the target position.

B Top center

W Top left

B Top right

B Bottom center
B Bottom left

B Bottom right

~ Legend

w Text Style

Font Size 10
Font Color I #FFF

Main Title $ Dollars Font Weight normal

= Layout

~ Margin

0L,/01 02/01 0300 047001 0501 0601
senes 1 Hornzontal

Spacing

Vertical

Spacing

Position Bottom Center



- Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed. If the series does not
have a name, the value of the s field is displayed as the series name. If the s field

does not exist, the value null is used.
- Line

B Color: To change the line color, see Color picker.

B Style: To set the line style, click the drop-down arrow and select the target
style.
M Solid line
B Dotted line

B Width: To change the line width, enter a value, or click + or -.

H Curve: If you select this option, the line is displayed as a curve. If you clear

this option, the line is displayed as a straight line.

~ Senes

Main Title $233Dollars

Unit Series Name Series 1

375

- Line
75

- i ; : : : Color #ODBAFF
01/01 0201 03/01 0401 0501 0601

Senes 1 Style Solid Line

Width

Curve



Main Title  $233Dollars

Series Mame Series 1
w« Line
Color #00BAFF

Style Solid Line

L

Width

Curve

- Point Style: To display the point style, click the Eye icon.

H Color: To change the point color of a line, see Color picker.

B Radius: To change the point radius, enter a value, enter a value, or click + or -.

= Point Style

Color #00BAFF

0L,/01 0201 031 0401 0501 0601
Senes 1

Radius

- Area: To display the area option, click the Eye icon.

Bl Color: To set the fill color type, click the drop-down arrow and select the
target type.

B Solid fill
B Gradient fill

B You can select two colors as the gradient colors.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.



Main Title  $233Dollars

i Jrk 375

Gradient Fill
2::J'3 #O0BAFF
%0

OL/01 G201 0301 0401 0501 0601 E—

Senes 1 0

- Label: To display the labels, click the Eye icon.

B Font Size: To change the font size of the label text, enter a value, or click + or

H Color: To change the point color of the label text, see Color picker.

B Font Weight: To change the font weight of the label text, click the drop-down

arrow and select the target font weight.

Main Title % Dollars ~ [abel
n'rt 375

Font Size

: i)
Color Il #FFF
0,/01 0201 031 04701 0501 0601

) Font Weight normal
Senes 1

- Data Options

- Incremental Data: If you select this option, the chart is displayed as a line chart
similar to the display of a cardiogram. You can customize the data volume and
data changes to be displayed as needed.

- Maximum Capacity: To change the maximum data volume, enter a value, or click

+or —.

. . : = Data Options
Main Title  $233Dollars
| Unit 375
c Incremental

Data

Maximum

Capacity




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the point where the data has changed. If you clear this option, the animation

begins from the starting point.

+ Animation

Main Title $ Dollars

Original 1000

Duration

Easing cubicinOut

Duration for 300
Data Update

01/01 02/01 03/0 04/01 05/01 i
Update from

Latest Status

Data

x :data along the x-axis. The value of this field must be in the same format as the
label text along the x-axis.

y :data along the y-axis



s : (optional) series value. If the Series Name field in Series does not have a

value, the value of the s field is displayed as the series name.

Field Mapping Status
= Matched
Successfully
» Matched

Successfully

» Optional

Data Source Type
Static Data

I
Main Title $233Dollars

Unit 375
375

- FE N S R

x™: "'-'E!l'la;"laj-fla'l 85:80:¢

: P . "2010/02/01 00:00:¢

BTl

01,/01 0201 0501 0400 0501 0601

Series 1 "x": "2010/03/01 00:00:¢

x": "2818/84/061 86:80:¢

Interaction
This widget is not connected to any events yet.
6.4.2 Area chart with ticker board

The widget of area chart with ticker board allows you to customize the ticker board

style, the display of different series of data, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Settings
- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Margin: Spacing between the chart and the chart borders. The unit is pixels.

« Global Settings

| $90Dollars $60Dollars Font Family ®  Microsoft YaHei
{ Uit
| sss
|

= Margin

. . Top

0201 0300 0401 05M1 Bottom

Right

- X Axis: To display the x-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.
H Font Color: To change the font color of the text along the x-axis, see Color

picker.

B Font Weight: To change the font weight of the text along the x-axis, click the

drop-down arrow and select the target font weight.

$90Dollars $60Dollars

| Unit = Text Style
| ss5

| ass

' Font Size

¢

- _ : Font Color

D2l ORI [0
. Series 1 M Series 2 Font Weight  nomal
L _________ e .

- Axis Label: To display the axis labels, click the Eye icon.

@ Note:



An error will be displayed if the data format differs from the data format set for

the x field in the data pane.

- Data Type: To set the type of data along the x-axis, click the drop-down arrow
and select the target type.

B Numeric
B Category
B Time
- Data Format: To set the format of the data, click the drop-down arrow and select

the target format.

Note:
The following is an example: %Y/%m/%d%H:%M:%S.

- Display Format: To set the display format of the data, click the drop-down arrow

and select the target format.

Note:



Time format: %m/%d%Y%H:%M:%S; integer format: d; floating-point

number: .1f.

= Axis Label

$90Dollars $60Dollars
, Unit Data Type Time

LG

Data Format  2016/01/01 02:30:00

Display 01/01(Month/Day)

Format (3

Margin: If you select this option, spacing 1 (spacing between the chart and the y-
axis) and spacing 2 (spacing between the chart and the right border of the chart)

are displayed. If you clear this option, spacing 1 and spacing 2 are not displayed.

Margin Size : To adjust spacing 1 and spacing 2, enter a value or drag the slider.

The value range is from 0 to 1.

Margin

Margin Size —H

0

Min/Max: You can set the minimum and maximum values along the x-axis as
needed.

Unit: You can customize the unit of the text along the x-axis as needed.

Quantity: To change the number of labels along the x-axis, enter a value, or click
+or-.

Angle: To set the angle of the labels along the x-axis, click the drop-down arrow

and select the target angle. The options include horizontal, slant, and vertical.



-— »———— .

| $90Dollars $60Dollars e auto
T
[ LG : : : ] Min auto

Unit

*

: d Quantity
D401  05/01

Angle
. Hornzontal
» HAoas Line
Slant

¥ Gnd Lines Vertical

- Axis Line: To display the axis line, click the Eye icon. To change the color of the

axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon. To change the color of

the grid lines, see Color picker.
= Axis Line

Color

*

w» Grid Lines
05,01

Il #FFDG66

- Y Axis

For more information about how to set the y-axis, see X Axis.



- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To change the font weight of the legend text, click the drop-
down arrow and select the target font weight.
- Layout
B Margin
B Horizontal Spacing: To adjust spacing 1 (spacing between the legend items
and the right border of the chart) and spacing 2 (spacing between the
legend items and the left border of the chart), enter a value, or click + or -.
B Vertical Spacing: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right



Font Size

| Uit Font Color Il RGB

2333

555 : : [ I
e k E Font Weight normal

‘_‘ ~ Layout

0101 02/01 03/01 0401 05,01

T
| $90Dollars $60Dollars
’

| Series 1 M Series 2 ~ Margin
"

Hornzontal

Spacing

Vertical

Spacing

Position Bottom Center

Series: To add or delete a series, click + or click the Trash icon.

E] Note:



A series is an array. You can set two or more series as needed, and the Editor
traverses and renders the data through the series settings. To set data in a specific

format, sort the data manually.

- Series Name: You can set a name for the series as needed. If the series does not
have a name, the value of the s field is displayed as the series name. If the s field

does not exist, the value null is used.

- Area

H Color: To set the fill color type, click the drop-down arrow and select the
target type.

M Solid fill
B Gradient fill

B You can select two colors as the gradient colors.
B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.

« Series

- Series Name
| $90Dollars $60Dollars

| Uit ~ Area

| sss

Color Gradient Fill

‘ E "' #ODBAFF

01,01 0201 0301 0401 05,01 - e
Il RGBA(D, 136

— |
0

- Line
B Color: To change the line color, see Color picker.
B Style: To change the line style, click the drop-down arrow and select the target

style.

B Solid line
B Dotted line



B Width: To change the line width, enter a value, or click + or -.
Bl Curve: If you select this option, the line is displayed as a curve. If you clear

this option, the line is displayed as a straight line.

| $90Dollars $60

| Uit

#OOBAFF

y Solid Line
*

01/01 0201 02,01 401 05,01

- Point Style: To display the point style, click the Eye icon.

H Color: To change the point color of the line, see Color picker.

B Radius: To change the point radius, enter a value, or click + or -.

~ Point Style
$90Dollars $60Dollars

| Unit Color #00BAFF
| 555

Radius

w» Label

- Label: To display the labels, click the Eye icon.

B Font Size: To change the font size of the label text, enter a value, or click + or

B Color: To change the font color of the label text, see Color picker.

B Font Weight: To change the font weight of the label text, click the drop-down

arrow and select the target font weight.

sy

Font Size

0L/01 0201 0301 0401 0501 Color I #FF

Series 1 M Series 2
""""""""""""" o Font Weight normal
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By default, the data displayed on the ticker board is the last data that corresponds

to the y-axis.

Font Color: To change the font color of the data displayed on the ticker board,

see Color picker.
Font Size: To change the font size of the data displayed on the ticker board, enter
a value or drag the slider. The value range is from 0 to 100.

Font Weight: To change the font weight of the data displayed on the ticker board,

click the drop-down arrow and select the target font weight.

Rounding: If you select this option, the data value is automatically rounded. If

you clear this option, the data value is not rounded.

Thousands Separator: If you select this option, a thousands separator is

inserted. If you clear this option, no thousands separator is inserted.

Prefix: You can customize the prefix as needed.

Font Color: To change the font color of the prefix, Color picker.

Font Size: To change the font size of the prefix, enter a value or drag the slider.
The value range is from 0 to 100.

Font Weight: To change the font weight of the prefix, click the drop-down arrow
and select the target font weight.

Suffix: For more information about how to set the suffix, see Prefix.



« Ticker Board

-
|
|
i
|
|
|
|

s
|
|
|
i
|
|
|
|
B

Font Color

$9 0 Dollars $60Dollars

Uit
LLS

Font Size

Font Weight normal

» Rounding

01,01 0201 030 T 05/01 Thousands

separator

L T

|
|
|
?
|
|
|
|
.

Prefix
Font Color

Font Size

Font Weight normal
Suffix Dollars

Font Color I RG




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the point where the data has changed. If you clear this option, the animation

begins from the starting point.
~ Animation

Original

Unit

Duration

444 L ' Easing cubicinOut

Duration for 300

® ® | Data Update

| Update from
02/01 / 04/01 05/01 |

Series 1 [l Series 2

Data

x : data along the x-axis. The value of this field must be in the same format as the
label text along the x-axis.

y :data along the y-axis



s : (optional) series value. If the Series Name field in Series does not have a

value, the value of the s field is displayed as the series name.

Area Chart with Ticker Board

Basic Area Graph Interface s Completed

Field Mapping Status

® Matched
Successfully
» Matched
Successfully

= Optional

Data Source Type

Static Data

$9 0 Dollars $60Dollars

. Unit
| 555

0L/ 0201 0301 0401 05/01

| senes 1 W5enes 2
-— e

L, e

Interaction

This widget is not connected to any events yet.



6.4.3 Basic line chart

The basic line chart widget allows you to customize the chart style, the display of

different series of data, and other options as needed.

Style

- Basic Attributes

Size: Set the size of the widget by adjusting its width and height.
Position: Set the position of the widget by adjusting its abscissa and ordinate.

Others: Set the rotation angle and opacity of the widget.

- Global Settings

Font Family: To set the font of the displayed text, select the target font from the
drop-down list. The default font is Microsoft YaHei.
Margin: Spacing between the chart and the chart borders. The unit is pixels.

Empty Data: If you select this check box, the line and the x-axis intersect at

the point where the value corresponding to the y-axis is 0. If you clear this



check box, the line and the x-axis do not intersect at the point where the value

corresponding to the y-axis is 0.

+ Global Settings

Font Family Microsoft YaHei
~ Margin

Top
Bottom
0201 0201 0401 0501
| Series 1 M Series 2
P e = |

Right
Empty Data
+ Global Settings
Font Family Microsoft YaHei
« Margin

Top

Bottom

!
'
.

Left
Right

Empty Data




- X Axis: To display the x-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, select the
target font weight from the drop-down list.

- Axis Label: To display the axis labels, click the Eye icon.

Note:
An error will be displayed if the data format differs from the data format set for

the x field in the data pane.

B Data Type: To set the data type along the x-axis, select the target type from the

drop-down list.

B Numeric
B Category
H Time

B Data Format: To set the format of the data, select the target format from the

drop-down list.

Note:
The following is an example: %Y/%m/%d%H:%M:%S.
B Display Format: To set the display format of the data, select the target format

from the drop-down list.

Note:



Time format: %m/%d%Y%H:%M:%S; integer format: d; floating-point

number: .1f.

~ Text Style

b
¢

Font Size
Font Color Il RoBe
Font Weight normal

= Auis Label

AT AT 2L UL U5 A0

Series 1 W Senes 2 i
- - Data Type Time

’
2

e e |

Data Format

Display

Format &

B Margin: If you select this check box, spacing 1 (spacing between the chart and
the y-axis) and spacing 2 (spacing between the chart and the right border of



the chart) are displayed. If you clear this check box, spacing 1 and spacing 2
are not displayed.
B Margin Size: To adjust spacing 1 and spacing 2, enter a value or drag the

slider. The value range is from 0 to 1.

Margin

0L 0201 0300 04/01

Margin Size —H

{ Series 1 WSenes 2
' T 4 0

B Min/Max: You can set the minimum and maximum values along the x-axis as

needed.

B Offset: To adjust the spacing between the labels along the x-axis, enter a

value, or click + or -.
B Unit: You can customize the unit of the text along the x-axis as needed.
B Quantity: To change the number of x-axis labels, enter a value, or click + or -.

B Angle: To set the angle of the x-axis labels, select the target angle from the
drop-down list. The options include horizontal, slant, and vertical.

Max

Min

Offset

|
|
i
|
|
|
i
+ Unit
|
|
|
|
i
|
|

Quantity

02/ 03/01 0401 05,/01

Angle Select

L

. Honzontal
¥ Aoas Line
T

Vertical

B Axis Line: To display the axis line, click the Eye icon. To change the color of
the axis line, see Color picker.
B Grid Lines: To display the grid lines, click the Eye icon. To change the color of

the grid lines, see Color picker.



« Moas Line

Color

« Gnd Lines

03,01

Color Il #FFD666

Senes 1 W5enes 2

- Y Axis

For more information about how to set the y-axis, see X Axis.

- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, select the target font
weight from the drop-down list.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items

and the right border of the chart) and spacing 2 (spacing between the



legend items and the left border of the chart), enter a value, or click + or -.

The setting takes effect only when two or more series are set.

B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

Bl Position: To set the position of the legend items, select the target position

from the drop-down list.

B Top center

W Top left

B Top right

B Bottom center
B Bottom left

B Bottom right

« Legend
« Text Style

Font Size
Font Color

Font Weight

i = Layout
03,01 0401 05,01 i

Senes 1 WSenes 2 .
= Margin

Honzontal

Interval

Vertical

Interval

Position

Il RGBA

normal

Bottom C

- Series: To add or delete a series, click + or click the Trash icon.

E] Note:



A series is an array. You can set two or more series as needed, and the Editor
traverses and renders the data through the series settings. To set data in a specific

format, sort the data manually.

- Series Name: You can set a name for the series as needed. If the series does not

have a name, the value of the s field is displayed as the series name. If the s

field does not exist, the value null is used.

« Series

-0 e
senes 2

Series Name Series 1
« Line

1

1

[ Color #ODBAFF
04/01 os/01 |

[ Style Solid Line

1

Width

Curve

- Line
B Color: To change the line color, see Color picker.
B Style: To set the line style, select the target style from the drop-down list.
B Solid line
B Dotted line

B Width: To change the line width, enter a value, or click + or -.

Bl Curve: If you select this check box, the line is displayed as a curve. If you clear

this check box, the line is displayed as a straight line.

#ODBAFF

Solid Line

0401 D501 |

—

- Point Style: To display the point style, click the Eye icon.



H Color: To change the point color of the line, see Color picker.
B Radius: To change the point radius, enter a value, or click + or -.

- Area: To set the fill color type, select the target type from the drop-down list.

H Solid fill
B Gradient fill

B You can select two colors as the gradient colors.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
« Point Style
Color #ODBAFF

Radius

+ - Area

; Color Gradient Fill

02m o3 04/01 05/01 | Il RGBA(

!
' Bl RGBA(255,255
— =
0

- Label: To display the labels, click the Eye icon.

B Font Size: To change the font size of the label text, enter a value, or click + or

B Color: To change the font color of the label text, see Color picker.

B Font Weight: To set the font weight of the label text, select the target font

weight from the drop-down list.



? w« Label

P Font Size
04/01 0s/01 |
Color - #FFF

Font Weight normal

- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, select the target effect from the drop-down list.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this check box, the animation begins
from the point where the data has changed. If you clear this check box, the

animation begins from the starting point.
« Animation
Original
Duration
Easing cubicinOut

Duration for 300

Data Update

Update from

04/01 05/01 |

Latest Status

Data

x :data along the x-axis. The value of this field must be in the same format as the
label text along the x-axis.

y :data along the y-axis



s : (optional) series value. If the Series Name field in Series does not have a

value, the value of the s field is displayed as the series name.

Basic Line Chart

Basic Line Chart Interface s Completed

Field Mapping Status

= Matched
Successfully
» Matched
Successfully

= Optional

Data Source Type

Ctatic Data

020 03,/01 0401 05/01

Senes 1 W5enes 2

Example: The following example describes how to configure the monthly

evaporation and rainfall data obtained from January to July:



1. In the Series area, click Series 1 and set Series Name to Evaporatio n .Click

Series 2 and set Series Name to Rainfall , as shown in the following figures.

Series 2

Series Name Evaporation

- Line

Color #O0BAFF

Style Solid Line

Width

Curve

~ Point Style

Color #00BAFF

Radius

- Area

Color Gradient Fill




Series Mame

« Line

Color

Style

Width

Curve

~ Point Style

Color

Radius

- Area

Color

Rainfall

I #3DE7CH

Sold Line

I #3DE7CH

4

Gradient Fill

-
-

Bl RGBA(50,126,200, @

I RGBA(46.45450. @

—
0




2. Set the type of data along the x-axis, as shown in the following figure.

» Text Style

~ Axis Label

Data Type Category

Offset

Inner Padding

Outer
Padding

Quantity

Angle Select




3. Set the display format of data along the y-axis, as shown in the following figure.

» Text Style
- Axis Label
Min &

Max @ Maximum Data Value

+

Quantity 6

Display 11.1 (Float)

Format @&

Offset

Angle Honzontal

4. In the data pane, set Data Source Type to Static Data and configure data as follows:

[ { n X ||: n January II’ n y ||: 2 . n S ||: l }, { n X ||: n January

n n y n S 2 . 6 ., n S n S 2 } 5 { n X n S n Feb r-uar-y n ’ n y n 9 4 .
5 n S n 9 l }, { n X n 9 n Feb ruary n 5 n y n 0 5 . 9 5 n S n 0 2
}, { n X ll: n March ll, n y II: 7 , n S II: .l }’ { n X II: n Mar-ch
n s n y n S 9 s n S n S 2 } 5 { n X n S n Apr—-l 'L n 5 n y n 0 23 . 2 5 n
S n 0 l } 5 { n X n 0 n Apr--i 'L n 5 n y n 9 26 . 4 ’ n S n 0 2 } s { n
X n 0 n May n . n y n 0 25 . 6 . n S n S l } 5 { n X n S n May n . n y
": 28 .7 ,"s " 2 }, {"x":"3June","y": 76.7,"s
n . l }’ { n X n . n June n ’ n y n . 70 . 7 ’ n S n J 2 } , { n X

)

9



II: n July II, n y ll: 135 . 6 . n S II: l }, { n X II: n Ju'Ly ll, n
": 175 . 6 , "s ": 2 1} ]

Basic Line Chart

Basic Line Chart Interface

Field  Mapping

Data Filter:

The data can be obtained from a CSV file, as shown in the following figure.

A B C

1 x y 5

2 |January 2 1
3 |January 2.6 2
4 |February 4.9 1
5 February 5.9 2
6 |March 7 1
7 |Mar[:h 9 2
& April 23.2 1
9 April 26.4 2
10 | May 25.6 1
11 |May 28.7 2
12 |June 76.7 1
13 |June 70.7 2
14 |July 135.6 1
15 (July 175.6 2

Inthe CSVfile, x , y ,and s in the first row are the fields, and values in the

second and subsequent rows are the field values. To download the CSV file, click

here.


http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/90155/jp_ja/1551061028524/data.csv
http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/90155/jp_ja/1551061028524/data.csv

Interaction

This widget is not connected to any events yet.

6.4.4 Dual axis chart

The dual axis chart widget allows you to customize the chart style, the display of

different series of data, and other options as needed.

Style

- Basic Attributes

Size: Set the size of the widget by adjusting its width and height.
Position: Set the position of the widget by adjusting its abscissa and ordinate.

Others: Set the rotation angle and opacity of the widget.

- Global Settings

Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
Margin: Spacing between the chart and the chart borders. The unit is pixels.

Empty Data: If you select this option, the line and the x-axis intersect at the point

where the value corresponding to the y-axis is 0. If you clear this option, the line



and the x-axis do not intersect at the point where the value corresponding to the

y-axis is 0.

» Global Settings

Font Fan‘uil_ Microsoft YaHei

B
|
|
|
|
|
L]
|
|
|
|
|
.

« Margin

&
J =
5

Top
‘ Bottom

010 021 0401 0501 Left

T

Series Y

- - Right

Empty Data
« Global Settings

Font Family Microsoft YaHei
= Margin

Top

‘ Bottom

0L 0201 A 04,01 05,01 Left

[ Series Y
. Right

Empty Data




- X Axis: To display the x-axis, click the Eye icon.
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

Note:
An error will be displayed if the data format differs from the data format set for

the x field in the data pane.

B Data Type: To set the data type along the x-axis, click the drop-down arrow
and select the target type.

B Numeric
B Category
H Time

B Data Format: To set the format of the data, click the drop-down arrow and

select the target format.

Note:
The following is an example: %Y/%m/%d%H:%M:%S.

B Display Format: To set the display format of the data, click the drop-down

arrow and select the target format.

Note:



Time format: %m/%d%Y%H:%M:%S; integer format: d; floating-point

number: .1f.

5

10 |
‘14
"]

01,01 0201 08/ 0401 05,01

Series Y WS

'
-

Font Weight

= MAas Label

Data Type

Data Format

Display

Format (3

normal

Time

2016/01/0

01/01(Month/Day)

B Margin: If you select this option, spacing 1 (spacing between the chart and the

y-axis) and spacing 2 (spacing between the chart and the right border of the



chart) are displayed. If you clear this option, spacing 1 and spacing 2 are not
displayed.
B Margin Size: To adjust spacing 1 and spacing 2, enter a value or drag the

slider. The value range is from 0 to 1.

Margin

001 OO /0L 04 Margin Size — N

Series ¥ ies 7 0

B Min/Max: You can set the minimum and maximum values along the x-axis as
needed.

B Offset: To adjust the spacing between the labels along the x-axis, enter a
value, or click + or -.

B Unit: You can customize the unit of the text along the x-axis as needed.

B Quantity: To change the number of labels along the x-axis, enter a value, or
click + or -.

B Angle: To set the angle of the labels along the x-axis, click the drop-down
arrow and select the target angle. The options include horizontal, slant, and
vertical.

B Axis Line: To display the axis line, click the Eye icon. To change the color of
the axis line, see Color picker.

B Grid Lines: To display the grid lines, click the Eye icon. To change the color of

the grid lines, see Color picker.



Y auto
Unit
100
0
&0
40
20

L\g
0L 02/01 03/01 D4/00 05/01

Min auto
Unit
Quantity

: _ Angle
Senes Y WSe

Aoas Line

Color

Grid Lines

Color Il #FFD666

Y Axis

The y-axis is on the left. For more information about how to set the y-axis, see X

AXxis.

7. Axis

The z-axis is on the right. For more information about how to set the z-axis, see X

AXxis.



- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the right border of the chart) and spacing 2 (spacing between the
legend items and the left border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right



Font Size

Font Color Il RGBA(2

Font Weight  normal

= Layout

~ Margin

Hornzontal

Interval

Vertical

Interval

Position Bottom C

Series Y/Series Z

E] Note:



By default, a dual axis chart has two series of data, which correspond to the data
along the y-axis and z-axis. You can customize the data style as needed, including

the name of each series of data, the line style, the point style, and the area.
- Series Name: You can set a name for the series as needed.
- Line
B Color: To change the line color, see Color picker.

B Style: To set the line style, click the drop-down arrow and select the target
style.

M Solid line
B Dotted line
B Width: To change the line width, enter a value, or click + or -.

H Curve: If you select this option, the line is displayed as a curve. If you clear

this option, the line is displayed as a straight line.

- Point Style: To display the point style, click the Eye icon.
B Color: To change the point color of the line, see Color picker.
B Radius: To change the point radius, enter a value, or click + or -.
~ Series Y
Series Name  Sefies Y
~ Line
Color #00BAFF
Style Solid Line
Width

Curve

11018 02,01 02/01

= Point Style
Color #ODBAFF

Radius

- Area: To set the fill color type, click the drop-down arrow and select the target
type.
W Solid fill
B Gradient fill



B You can select two colors as the gradient colors.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.

- Label: To display the labels, click the Eye icon.

B Font Size: To change the font size of the label text, enter a value, or click + or

B Color: To change the font color of the label text, see Color picker.

B Font Weight: To set the font weight of the label text, click the drop-down

arrow and select the target font weight.
= Area

Unit [ Color Gradient Fill
100 |
#ODBAFF
Il RGBA(D,1
— n
0

0401 0501 % | | = Label

Font Size 10
Color Il #FFFFFF

Font Weight  normal




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is

milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the point where the data has changed. If you clear this option, the animation

begins from the starting point.

+ Animation

Unit

Original
375

Duration
300

Easing cubicInOut

Duration for 300

Data Update

0 | 0 Update from
01/01 02/01 03/01 04/01 05/01

Latest Status

Series Y [l Series 7

Data

The data pane of a dual axis chart has three fields (x, y and z fields). The x and y fields

correspond to the points on the two lines.

x : data along the x-axis. The value of this field must be in the same format as the
label text along the x-axis.

y :data along the y-axis



z :data along the z-axis

Biaxal Line Chart Interface mpleted

Field Mapping Status
= Matched
Successfully
= Matched
Successfully

s Matched

Unit Unit Successfully
e 100
; ; : Data Source Type

Static Data

Series Y W Series Z

-

Interaction

This widget is not connected to any events yet.



6.4.5 FAQ

How do | configure multiple series?
In the data pane, if multiple s fields exist, values of the s fields indicate different
series (lines).

Data Source Type
Static Data
[ 1

/61/81 60:00:¢

16/61/61 00:00:¢

Data Filter:

Auto Data Request: Every

@ Note:

In the configuration pane, the style of the configuration items is rendered
according to the data sequence. That is, if the data of series 2 is displayed first in a

chart, all subsequent data of series 2 is rendered according to the configured style



of series 1. You can customize the rendering effect by sorting the data in advance

using a data filter.

- You can set the style of multiple series in the configuration pane.

Series 2

Series Name Series 1

~ Line

Color #ODBAFF
Style Solid Line
Width
Curve

« Point Style
Color #OOBAFF
Radius =

-] Lo

Color Gradient Fill =

Il RGBA(54,160,255,

-
Il RCBA(255.25525 @

~ Series

4 Seriesl

Series Name Series 2

« Line

Color Il #3DE7C3
Style Solid Line
Width
Curve

« Point Style
Color Il #3DE7CO
Radius 4 =

~ Area

Color Gradient Fill
I Bl RGBA(131,198,13:

I RGBA(46,45,450.:

—a
1]




If the number of the actual series is greater than that in the configuration pane,

the data in the configuration pane is rendered in a loop.

As shown in the following figure, the style of series 3 is the same as that of series
1.

Data Source Type
Static Data

[

a8/e1/01 60:00:¢

016/81/01 88:88:¢

@/81/61 68:80:¢

s

I

1
Data Filter:

Auto Data Request:

As shown in the following figure, data of series 2 is displayed first. Therefore,

the data is rendered using the style of series 1 in the configuration pane.

16e/81/61 60:00:¢
/01/e1 ee:ee:¢

16/01/61 60:00:¢

Data Filterz

Auto Data Request: Every




If the s field does not exist in the data pane, all the data belongs to the same series

by default. That is, only the style of one series needs to be configured. (If multiple

series are set, only the configuration of the first series takes effect.)

Data Source Type

Static Data
[ [

/e1/e1 eo:e0:¢

18/83/81 00:80:¢

/84/01 00:80:¢

Data Filter:

Auto Data Request: Every

» Legend

~ Series

L

Series Name

» Line

» Point S

» Area

» Animation

What is the relationship between the series name in the configuration pane and the s field in the

data pane?

The series option in the configuration pane determines the style of a series, while the
series name determines the displayed text of a legend. You can customize the series
name as needed. If the series name is empty, the system automatically searches for

the value of the corresponding s field in the data pane. If the s field exists, the value of

s is used as the series name. If this field does not exist, the series name is empty.



Series Name

Data Source Type

Static Data

X": "2010/01/01 909:00:¢

Series 1 [l Sernes /Z

6.5 Pie charts
6.5.1 Basic pie chart I

The basic pie chart IT widget allows you to customize the pie chart style, the

percentage of different categories, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Font Family: To change the font of the displayed text, click the drop-down arrow
and select the target font. The default font is Microsoft YaHei.

- Label

- Distance from Label to Center: To change the horizontal distance between the

labels and the center of the pie chart, enter a value or drag the slider. The value



range is from 0 to 1. If the value is too small, the labels will overlap in the center
of the pie chart.
Distance from Vertex to Center: To change the distance between the vertices and

the center of the pie chart, enter a value or drag the slider. The value range is



from 0 to 1. If the value is too small, the vertices will overlap in the center of the

pie chart.

Category: To display the categories, click the Eye icon.

B Font Size: To change the font size of the category text, enter a value, or click +
or —.

B Color: To change the font color of the category text, see Color picker.

Value

B Font Size: To change the font size of the percentage values, enter a value, or
click + or -.

B Color: To change the font color of the percentage values, see Color picker.

B Font Weight: To change the font weight of the percentage values, click the
drop-down arrow and select the target font weight.

B Number of Decimal Places: To change the number of digits to the right of the

decimal point, enter a value, or click + or -.



Font Family &  Microsoft YaHei

- Lﬂ]&l

Distance from
Label to

Center

Distance from
Vertex to

Center
Category

Font Size

|31.58%

patenals Color Il RGE
| Device W Building materials_llFood .
! r:‘g : Font Weight normal
Vatue

Font Size

Color - RGB

Font Weight normal

Mumber of
Decimal

Places

Real Value

B Real Value: If you select this option, the actual data values corresponding to

the percentage values are displayed.



Data Source Type

Static Data

"Building material:
12

| 1200 : "Food",
paten'als y": 12

Device M Building matenals Wl Food
. -

- Circles

- Outer Radius: To change the length of the outer radius, enter a value or drag the

slider. The value range is from 0 to 1.

- Inner Radius: To change the length of the inner radius, enter a value or drag the

slider. The value range is from 0 to 1.

- Concentric Lines: To display the concentric lines, click the Eye icon.

B Color: To change the color of the concentric lines, see Color picker.

w Circles

Outer Radius

Inner Radius

= Concentric Lines

Device M Building materials llFood
w»

Color Il RGBA(170,170,170,0 @&




- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout/Margin
B Horizontal Interval: To change the horizontal distance between the legend
items, enter a value, or click + or —.

B Vertical Interval: To change the vertical distance between the legend items

and the pie chart, enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

Font Size

Font Color Il RGBA(25

Font Weight normal
« Layout

= Margin

M Building materials

= Hornizontal

Interval

Vertical

Interval

Position Bottom Center




- Series: To add or delete a series, click + or click the Trash icon.

- Color: To set the fill color type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a segment, see Color picker.

B Gradient fill

B You can select two colors as the gradient colors. For more information, see

Color picker.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.
~ Series
Series 2 Sernies 3

Gradient Fill
- #FAAD14

I #69BA6D

2
natenals

| mDevice M Building materials M Food




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Reset All Sectors in Pie Chart: If you select this option, the animation of each
segment in the pie chart is displayed in sequence. If you clear this option, the
animation of each segment in the pie chart is displayed at the same time.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations of
all segments in the pie chart are displayed in sequence. If you clear this option,
the animations of all segments in the pie chart are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation

begins from the starting point.

~ Animation

Original

Duration

31.58%
Foo

. all
36.84% .
Device in Pie

Easing cubicinOut

Animations of

31.58% Duration for
Building materials Data Update
Device M Building materials llFood

P —————— Update from

Latest Status
Data

x :text of a category



y :actual data value of a series

Data Source Type

Static Data

w"': "Device”,
e 14

x": "Building material:
2

1200 ' "x": "Food",

E'latenals "yTi 12

é W Device M Building matenals HFood

Interaction
This widget is not connected to any events yet.
6.5.2 Carousel pie chart

The carousel pie chart widget allows you to customize the pie chart style, animation,

the percentage of displayed content, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Chart Properties

- Inner Radius: To change the length of the inner radius, enter a value or drag the

slider. The value range of the inner radius is from 0 to 1.

- Outer Radius: To change the length of the outer radius, enter a value or drag the

slider. The value range of the outer radius is from 0 to 1.

w Chart Properties

Inner Radius

Duter Radius

|
1
:
|
:
:
L]
:
|
:
:

Animation 2000

Duration (ms)

- Animation Duration: To change the time for which a segment moves outward,

enter a value, or click + or -.

- Carousel Interval: To change the interval of moving outward between two

segments, enter a value, or click + or -.

- Default Color: To change the default color of the pie chart, see Color picker.

Outer Radius

Animation 2000

Duration (ms)

Carousel 3000

Interval (ms)

Default Color #00BAFF
TYPE 1 MTYPE 2 MTYPE 3 MTYPE A MTYPE S




- Percentage Display Options
- Text Style

B Font Family: To set the font of the percentage value and the type description,
click the drop-down arrow and select the target font. The default font is
Microsoft YaHei.

B Font Color: To change the font color of the percentage value and the type
description, see Color picker.

B Font Weight: To set the font weight of the percentage value and the type
description, click the drop-down arrow and select the target font weight.

B Wrap Automatically: If you select this option, the percentage value and the
type description are wrapped automatically. If you do not select this option,

the percentage value and the type description are not wrapped automatically.

= Percentage Display Options

e - -

= Text Style

| / | Font Family @ Microsoft YaHei
' 28 % |

\d 3 ’

! L | Font Color [l #FFFFFF

Font Weight mormal

TYPE 1 MTYPE 2 MTYPE 3 MTYPE 4 MTYPES | Wrap

B True Value: If you select this option, the real data value is displayed. If you do

not select this option, the percentage value is displayed by default.

Font Weight normal

Wrap

Automatically

True Value &

TYPE_1 WTYPE 2 MTYPE3 MTYPE 4 MTYPES Numberof  H

B Percent Sign: You can set the percent sign that follows the numerical value
when the real data value is displayed as the percentage value.
B Percent Sign Font Size: To set the font size of the percent sign, enter a value,

or click + or —.



B Percent Position: To set the position of the percent sign, click the drop-down
arrow and select the target position.
B Front
B End

B Percent Offset: To adjust the spacing between the percent sign and the

numerical value, enter a value, or click + or -.

Note:



The settings of the preceding four options are valid only when True

Value is not selected.

Percent

Symbol

Percent

Position

|
!
|

TYPE 4 MTYPES | . a
- Percent Offset 5

B Number of Decimal Places: To change the number of digits to the right of the
decimal point, enter a value or drag the slider. This is applicable to both the

percentage value and the real data value. The value range is from 0 to 10.

Number of
Decimal

Places

Border Width

B Border Width: To change the border width, enter a value or drag the slider.
The value range is from 0 to 1. If the value is too small, the numerical value
and the percent sign will overlap or will be displayed in two rows.

B Vertical Alignment: To set the height of the displayed content and the
distance between the percentage value and the type description, enter a value

or drag the slider. The value range is from 0 to 1.

Border Width
21.811%

TYPE_S

Vertical

Alignment

TYPE 1 MTYPE 2 MTYPE 3 MTYPE 4 MTYPES ! MNumber Font



/ Border Width
29.246
%
TYPE 2

Vertical

Alignment

TYPE 1 MTYPE 2 MTYPE 3 MTYPE 4 MTYPE 5 | Number Font

/ Border Width
1%A493

PE_1

Vertical

Alignment

TYPE 1 MTYPE 2 MTYPE 3 MTYPE 4 MTYPE S Number Font
B Number Font Size: To set the font size of the numerical value, enter a value, or
click + or -.
B Description Font Size: To set the font size of the type description under the

percentage value, enter a value, or click + or -.

MNumber Font

?

Description

Font Size




- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To set the font size of the legend text, enter a value, or click + or -.

H Font Color: To change the color of the legend text, see Color picker.

B Font Weight: To set the font weight of the legend text, click the drop-down

arrow and select the target font weight.
+ Legend
= Text Style

Font Size 10

Font Color Bl RGBA(

Font Weight  nommal

TYPE 1 ETYPE 2 ETYPE 3 MTYPE 4 MTYPE 5
B Horizontal Interval: To set the horizontal distance between the legend items,
enter a value, or click + or -.

B Vertical Interval: To set the vertical distance between the legend items, enter

avalue, or click + or -.
B Position: To set the position of the legend items, click the drop-down arrow
and select the target position.
B Top center
B Top left
H Top right
B Bottom center
B Bottom left
B Bottom right



- S ? = Layout

~ Margin

Horizontal

Vertical

Interval
TYPE ICOMTYPE 2 MTYPES

| TYPE4 ETYPES
L e -

1
|
1
1
t Interval
1
1
|
1

Position Bottom Center

Series: To add or delete a series, click + or click the Trash icon.
Series

- Background Color: To set the color of a legend block, see Color picker.

« Series

Background #OOBAFF

Color

TYPE1 MTYPE2 MTYPE3 MTYPE4
M TYPE 5

. A

Data

type :type name, which corresponds to a legend item

value :type value, which corresponds to a real data value

Stype”: "TYPE 1",

=value™: 32

"type": "TYPE_2",

"value™:

m t ':.f F‘IE L1 :
"value™:

TvrEl MWTYPE2 METYPES MTYPEA4

"type": "TYPE 4",

"value™: 12




Interaction

This widget is not connected to any events yet.

6.5.3 Percentage pie chart
The percentage pie chart widget allows you to customize the pie chart style, the

percentage value, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Chart Options

- Inner Radius: To change the length of the inner radius, enter a value or drag the
slider. The value range of the inner radius is from 0 to 1.

- Outer Radius: To change the length of the outer radius, enter a value or drag the
slider. The value range of the outer radius is from 0 to 1.

- Pie Background Color: To change the background color of the pie chart, see Color

picker.

» Chart Options

Inner Radius

Outer Radius

B R ————

Background

T
;
L

-




- Gradient Options

- Start Color: To change the start color of the segment, see Color picker.

- End Color: To change the end color of the segment, see Color picker. The end color
determines the gradient effect.
- Animation Duration: To change the time for which a segment changes its color

from the start point to the end point, enter a value, or click + or -.

~ Gradient Options

Ctart Color #2B80CF

End Color Il #00FFCC

Animation 2000

Duration

- Percent Size
- Text Style

B Font Family: To set the font of the percentage value, click the drop-down

arrow and select the target font. The default font is Microsoft YaHei.
B Font Color: To change the font color of the percentage value, see Color picker.
B Font Weight: To set the font weight of the percentage value, click the drop-
down arrow and select the target font weight.

B Size Percent: To change the display of the percentage value, enter a value or

drag the slider. The value range is from 0 to 1. If the value is too small, the



numerical value and the percent sign will overlap or will be displayed in two

TrOwSs.

~ Text Style

Font Family @ Microsoft YaHei

Font Color I #rFF

Font Weight MNormal

Size Percent

B Number Font Size: To set the font size of the numerical value, enter a value, or
click + or -.

B Percent Sign: You can set the percent sign that follows the numerical value
when the real data value is displayed as the percentage value.

B Percent Sign Font Size: To set the font size of the percent sign, enter a value,
or click + or -.

Bl Percent Position: To set the position of the percent sign, click the drop-down

arrow and select the target position.
B Front
B End
B Percent Offset: To adjust the spacing between the percent sign and the

numerical value, enter a value, or click + or —.

Mumber Font

Size

Percent

Symbol

Percent Sign

Font Size

Percent

Position

Percent Offset




Data

value :adecimal number, which indicates the percentage value of a segment in the

pie chart. The value 1 indicates 100%.

Percentage Pie Chart

Percent Pie Chart Interface s Completed

Field Mapping Status

» Matched

value ~
Successfully

Data Source Type

Ctatic Data

"valuele-©.332

__

Interaction
This widget is not connected to any events yet.
6.5.4 Comparison pie chart |

The comparison pie chart I widget allows you to customize the pie chart style, the

comparison of multiple indicators, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Container

- Padding: To set the distance between the pie chart and the pie chart borders,
enter a value, or click + or -. If the value is too large, the pie chart will move

outside the border.
]

Female : 1000 Font Family @  Microsoft YaHei

« Container

33.3%

Padding

¢ Label

66.7%

¥ Chart

*

- Label

- Color: To change the color of the top and bottom label text, see Color picker.

- Font Size: To set the font size of the top and bottom label text, enter a value or
drag the slider. The value range is from 12 to 100.

- Font Weight: To set the font weight of the top and bottom label text, click the

drop-down arrow and select the target font weight.

Female : 1000 « Label

Color - #FFC53D

33.3%

Font Size A

66.7%

Font Weight  mormal

T

Male : 2000




- Chart

- Color: To change the font color of the percentage values, see Color picker.

- Decoration Color: To change the color of the circle border and center point, see
Color picker.

- Background Color: To change the background color of the pie chart, see Color
picker.

- Font Size: To change the font size of the percentage values, enter a value or drag
the slider. The value range is from 12 to 100.

- Font Weight: To set the font weight of the percentage values, click the drop-down

arrow and select the target font weight.

= Chart

1
t
.

Female : 1000 Color Bl #FFFFFF o

Decoration Il RGBA(255,2552550 @

Color

33.3%

L

66.7%

Background Il RGBA(1,1,1,0)

Color
Font Size

Male : 2000

B O T

¢
.

?
.

Font Weight  bolder

- Margin
- Top: To set the distance between the pie chart and the top label, enter a value, or
click + or -.

- Bottom: To set the distance between the pie chart and the bottom label, enter a

value, or click + or —.



- Angle Offset: To change the rotation angle of the content in the pie chart, enter a

value or drag the slider. The value range is from 0 to 360.

Female : 1000
= Margin

33.3%

Top
Bottom

66.7%

Angle Offset

?

Male : 2000

- Series
Series

- Color: To change the color of a segment, see Color picker.

Female : 1000

33.3%

66.7%

Color #ODBAFF

Male : 2000



- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

Female : 1000

w» Animation

Original 1000

Duration

Easing cubicnOut

Duration for 300

Data Update

Male : 2000

Data

x :name of a label

y :value of a label



Comparison Pie Chart I

Indicator Contrast Pie Chart .
» Completed

Interface

Field Mapping Status

= Matched
Successtully
® Matched

Successtully
Data Source Type
Ctatic Data

Female : 1000

33.3%

- 66.7%

Male : 2000

Interaction
This widget is not connected to any events yet.

6.5.5 Pie chart with indicator

The pie chart with indicator widget allows you to customize the pie chart style, the

goal fulfillment, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Text Area

- Font Family: To set the font of the top and bottom label text, click the drop-down

arrow and select the target font. The default font is Microsoft YaHei.

- Font Color: To change the font color of the top and bottom label text, see Color
picker.

- Goal Text: You can customize the text of the bottom label.

- Current Progress Text: You can customize the text of the top label.

- Font Size: To change the font size of the top and bottom label text, enter a value

or drag the slider. The value range is from 12 to 100.

- Font Weight: To set the font weight of the top and bottom label text, click the
drop-down arrow and select the target font weight.
w Text Area
Font Family & Microsoft YaHei
Font Color
Goal Text This month sales target

Curremt This month's total sales

Progress Text

Font Size

Font Weight  normal

- Chart
- Progress Color

B Solid fill

B Gradient fill: You can select two colors as the gradient colors. To change the
gradient angle, enter a value or drag the slider. The value range is from 0 to
360.

- Progress Background Color: To change the color of the target circle, see Color

picker.

E] Note:



The target circle is under the progress circle.

~ Chart

Progress Color Solid Fill

10.0% #O0BAFF

Progress - RGBA(1,1,1,0)
Background

Color

- Excess Color: To change the color of the cross-boundary circle, see Color picker.

@ Note:



A cross-boundary circle appears when the actual value exceeds the target value.

Excess Color Solid Fill

Data Source Type

Ctatic Data

Inner Color: To change the color of the inner circle, see Color picker.
Inner Line Color: To change the color of the inner line, see Color picker.

Inner Label Color: To change the color of the percentage value in the inner
circle, see Color picker.

Font Size: To change the font size of the percentage value in the inner circle,
enter a value or drag the slider. The value range is from 12 to 100.

Border Size: To set the weight of the inner and outer borders, enter a value, or

click + or -.



Inner Color Il RGBA(255,2552550 @

Inner Line Il RGBA(255.2552550 @

Color

Inner Label Il RGBA(2

Color

Font Size

Font Weight bolder

Border Siz

- Margin

B Top: To set the distance between the pie chart and the top label, enter a value,

or click + or -.

B Bottom: To set the distance between the pie chart and the bottom label, enter

avalue, or click + or -.
Font Weight bolder

Border Siz

111.1% # ~ Margin

Top

Bottom




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation
begins from the starting point.

- -

This month total sales : 1000

= Animation

Original 1000

Duration

Easing cubicInCut

10.0%

Duration for 300

Data Up date

Update from

: e atest Status
I'his month sales target : 10000 Latest Statu

Data

aims :target value

actual : progress value (actual data value)
Data Source Type

Ctatic Data




Interaction

This widget is not connected to any events yet.

6.5.6 Basic pie chart |
The basic pie chart I widget allows you to customize the pie chart style, the

percentage of different data, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Font Family: To change the font of the text in the pie chart, click the drop-down

arrow and select the target font. The default font is Microsoft YaHei.



- Chart Style
- Label

B Distance from Vertex to Center: To change the distance between the labels
and the center of the pie chart, enter a value or drag the slider. The value

range is from 0 to 1.

- Radius

B Inner Radius: To change the length of the inner radius, enter a value or drag

the slider. The value range of the inner radius is from 0 to 1.

B Outer Radius: To change the length of the outer radius, enter a value or drag

the slider. The value range of the outer radius is from 0 to 1.

B Segment Spacing: To adjust the spacing between the segments, enter a value,
or click + or -. The maximum value cannot be greater than 1.
Font Family &  Microsoft YaHei
w Chart Style
w Label

Distance from
Vertex to

Center

« Radius

Inner Radius

Outer Radius

Segment

Spacing

Default Color || #FFFFFF




- Colors: To add or delete a segment or segments of the same color, click + or click
the Trash icon.
- Color: To change the color of different segments, see Color picker.

- Font Color: To change the font color of the label names and percentage values,
see Color picker.

- Number of Decimal Places: To change the number of digits to the right of the
decimal point, enter a value or drag the slider. The value range is from 0 to 10.

- Font Size: To change the font size of the label names and percentage values,
enter a value or drag the slider. The value range is from 10 to 100.

- Font Weight: To change the font weight of the label names and percentage

values, click the drop-down arrow and select the target font weight.

Color 2 Color 3
Color 1 #00BAFF

Font Color

Number of |

Decimal Places 0

Font Size

Font Weight normal




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Reset All Sectors in Pie Chart: If you select this option, the animation of each
segment in the pie chart is displayed in sequence. If you clear this option, the
animation of each segment in the pie chart is displayed at the same time.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations of
all segments in the pie chart are displayed in sequence. If you clear this option,
the animations of all segments in the pie chart are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation

begins from the starting point.

~ Animation

Original 1000

Duration

Reset All
ors in Pie

Chart
Easing cubicInOut

Animations of
All Series In

Sequence

Duration for

Data Up date

Data

x :label name



y :label value, which corresponds to the percentage value of this label
Data Source Type
Static Data
[

"x": "General cargo”,

"x": "General cargo”,

"x": "Bubble goods",

"Device",
e 14

Interaction
This widget is not connected to any events yet.

6.5.7 Pie chart with goal

The pie chart with goal widget allows you to customize the pie chart style, the

percentage of an indicator, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.

- Font Family: To set the font of the label text, click the drop-down arrow and select

the target font. The default font is Microsoft YaHei.



- Value

- Font Size: To set the font size of the percentage value, enter a value, or click + or

- Color: To change the font color of the percentage value, see Color picker.

- Font Weight: To set the font weight of the percentage value, click the drop-down

arrow and select the target font weight.

- Number of Decimal Places: To change the number of digits to the right of the

decimal point, enter a value, or click + or -.

- Real Value: If you select this option, the actual data value is displayed. If you

clear this option, the percentage value is displayed.

- Value

Font Size 32

Color Il RGBA(2

20.0%

Font Weight  bolder

Mumber of
Decimal
Places

Actual Text
- Real Value




- Sector

- Title: You can add a title for the pie chart.

- Color

B Solid Fill
B Gradient Fill :You can select two colors as the gradient colors. To
change the gradient angle, enter a value or drag the slider. The value range is
from 0 to 360.
- Background Color: To change the background color of the circle not covered by
the indicator segment, see Color picker.

» Sector

Title Actual Text

Color Solid Fill

#O0OBAFF

Background Il RGBA(1,1,1,0)

Color

- Excess Color: To change the color of the cross-boundary circle, see Color picker.

E] Note:



A cross-boundary circle appears when the actual value exceeds the target value.

Excess Color Gradient Fill

Data Source Type

Ctatic Data

200.0%

Actual Text

- Inner Radius: To change the inner radius length (distance between the indicator
segment and the center of the pie chart), enter a value or drag the slider. The

value range is from 0 to 1. If the value is too small, the inner circle will be

covered.

20.0% Inner Radius




- Inner Circle

- Color: To change the line color of the inner circle, see Color picker.

- Inner Radius: To change the radius length of the inner circle, enter a value or
drag the slider. The value range is from 0 to 1.

- Outer Radius: To change the radius length of the outer circle, enter a value or

drag the slider. The value range is from 0 to 1.

= Inner Circle

O
?

Color
Outer Radius

20.0%

Inner Radius

Actual Text

-—

|
[
[
[
[
[
|
L ]
I
[
[
[
[
[
[

- Circles
- Concentric Lines: To display the concentric lines, click the Eye icon.
B Color: To change the color of the concentric lines, see Color picker.

~ Circles

« Concentric Lines

20.0%

Color Il RGBA(170,170,170,0 @

e e g e

- Angle Axis

- Angle Offset: You can customize the offset angle of the indicator segment as

needed.

w Angle Axis

Angle Offset 80




- Legend: To display the legend items, click the Eye icon.

- Text Style

B Font Size: To set the font size of the segment title, enter a value, or click + or -.

H Font Color: To change the font color of the segment title, see Color picker.

B Font Weight: To set the font weight of the segment title, click the drop-down
arrow and select the target font weight.

- Layout/Margin

B Horizontal Interval: To set the horizontal distance between the segment title

and the pie chart borders, enter a value, or click + or -.

B Vertical Interval: To set the vertical distance between the segment title and

the pie chart borders, enter a value, or click + or -.
B Position: To set the position of the segment title, click the drop-down arrow
and select the target position.
B Top center
B Top left
H Top right
B Bottom center
B Bottom left
B Bottom right



Font Size
Font Color Il RGBA(25

Font Weight  normal

20.0%

= Layout

« Margin
Actual Text
Hornzontal
Interval
Vertical

Interval

Position Bottomn Cente

H H]




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation

begins from the starting point.

~ Animation

Original 1000

Duration

20-0% = cubicinOut

Duration for 300

Data Update

Update from

Actual Text Latest Status

Data

aims :target value

actual : progress value (actual data value), which is displayed as the percentage
value of the segment

Data Source Type

Y . t Static Data

20.0% . ] :rl:::idl : lD;igH

Actual Text




Interaction

This widget is not connected to any events yet.

6.5.8 Doughnut chart

The doughnut chart widget allows you to customize the pie chart style, the display of
different data dimensions, the percentage of different categories, and other options as

needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Outer Border Color: To change the border color of the outer circle, see Color picker.

Font Family (& Microsoft YaHei

Outer Border Il RGBA(255,2552550 @

Color




- Label

- Distance from Label to Center: To change the horizontal distance between the
labels and the center of the chart, enter a value or drag the slider. The value

range is from 0 to 1.

- Distance from Vertex to Center: To change the distance between the vertices and
the center of the chart, enter a value or drag the slider. The value range is from 0

to 1. If the value is too small, the vertices will overlap in the center of the chart.

- Category: To display the categories, click the Eye icon.

B Font Size: To set the font size of the category text, enter a value, or click + or -.

B Color: To change the font color of the category text, see Color picker.

B Font Weight: To set the font weight of the category text, click the drop-down
arrow and select the target font weight.

- Value

B Font Size: To set the font size of the percentage values, enter a value, or click +
or —.

H Color: To change the font color of the percentage values, see Color picker.

B Number of Decimal Places: To set the number of digits to the right of the
decimal point, enter a value, or click + or -.

B Font Weight: To set the font weight of the percentage values, click the drop-

down arrow and select the target font.



« Label
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. Font Weight  normal
Value

Fon

Color Il RGE

Font Weight normal

MNumber of
Decimal

Places

Real Value

B Real Value: If you select this option, the actual data values are displayed. If

you clear this option, the percentage values are displayed.

1400

Goods1
"Goods1",
"ia"

"Goods2",

nyg"

=2 W Goods3 HC =4 W Goods5 EMGoodse




Circles

- Radius: To change the distance between the center of the chart and the outer

circle, enter a value or drag the slider. The value range is from 0 to 1.

- Concentric Lines: To display the concentric lines, click the Eye icon.

H Color: To change the color of the concentric lines, see Color picker.

10.00 | .
Goods7 sl [~ Circles

Radius

20,00
Goodsh

= Concentric Lines

Color Il RGBA(170,170,1700 @

» Legend




- Legend: To display the legend items, click the Eye icon.

- Text Style

B Font Size: To set the font size of the legend text, enter a value, or click + or -.

H Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout/Margin
B Horizontal Interval: To change the horizontal distance between the legend
items, enter a value, or click + or —.

Bl Vertical Interval: To change the vertical distance between the legend items,

enter a value, or click + or -.
B Position: To set the position of the legend items, click the drop-down arrow
and select the target position.
B Top center
B Top left
H Top right
B Bottom center
B Bottom left
B Bottom right

~ Legend
~ Text Style

Font Size

Font Color Il rcB

Font Weight  normal

~ Layout

« Margin

Herizontal

— Interval
Goods4

Vertical

Interval

Position Bottom Center



- Series: To add or delete a series, click + or click the Trash icon.

- Color: To set the color of a segment, which corresponds to a series, click the

drop-down arrow and select the target color.

B Solid fill
B Gradient fill: You can select two colors as the gradient colors.
B To change the gradient angle, enter a value or drag the slider. The value range
is from 0 to 360.
- Inner Radius: To change the inner radius length of a segment, enter a value or
drag the slider. The value range is from 0 to 1.
- Outer Radius: To change the outer radius length of a segment, enter a value or

drag the slider. The value range is from 0 to 1.
w Series
Series 2 Sernies 3
Color Gradient Fill
#40ASFF

#FFADAF

— |
0

M Goods2 B Goods3 ; Inner Radius

W Goodss W Goodss

Outer Radius




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Reset All Sectors in Pie Chart: If you select this option, the animation of each
segment in the pie chart is displayed in sequence. If you clear this option, the
animation of each segment in the pie chart is displayed at the same time.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations of
all segments in the pie chart are displayed in sequence. If you clear this option,
the animations of all segments in the pie chart are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation

begins from the starting point.
w Animation

' Original
10.75% | Duratio
Goods7 : uration

21.51%
Goods6
cubicinOut

10.75%
Goods5

9.68% 19.35%
Goods4 Goods3
| Duration for
Goodsl HMGoods?2 MGoods3 MGoods4 M Goods5 MGoodse | Data Update
Goods7 |

Update fro

Latest Status

Data

x :name of a series



y :actual data value of a series. The value of this field determines the percentage
value of a segment.
Data Source Type

Static Data

[

*Goods1™
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Goods5
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9.00 1300 12

Goods4 Goods3

"Goods3™
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Interaction

This widget is not connected to any events yet.

6.5.9 Pie chart with image
The pie chart with image widget allows you to customize the pie chart style, upload an
image to the center of the pie chart, and customize the percentage of displayed data

as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.



- Image: To change the image in the center of the pie chart, click the Trash icon to
delete the current image and upload a local one. To use an image stored on the

Internet, enter the URL of the image.

26.58%

Goods1 Font Family &  Microsoft YaHei

TS & hitps:/fgw.alicdn.comfps/TE

Goodsl JGoods2

- Label

- Distance from Label to Center: To change the distance between the labels and
the center of the pie chart, enter a value or drag the slider. The value range is
from 0 to 1.

- Distance from Vertex to Center: To change the distance between the vertices and

the center of the pie chart, enter a value or drag the slider. The value range is



from 0 to 1. If the value is too small, the vertices will overlap in the center of the

pie chart.

Category: To display the categories, click the Eye icon.

B Font Size: To change the font size of the category text, enter a value, or click +
or —.

B Color: To change the font color of the category text, see Color picker.

B Font Weight: To set the font weight of the category text, click the drop-down
arrow and select the target font weight.

Value

B Font Size: To change the font size of the percentage values, enter a value, or
click + or -.

B Color: To change the font color of the percentage values, see Color picker.

B Font Weight: To set the font weight of the percentage values, click the drop-
down arrow and select the target font weight.

B Number of Decimal Places: To change the number of digits to the right of the

decimal point, enter a value, or click + or -.



w Label

Distanc
Label to
Center

Distanc

Category

Font Size

Color I RG

Font Weight  normal

Goods1l WGoods2

- Value
Font Size
Color Il RGBA

Font Weight  normal

MNumber of
Decimal

Places

Real Value

B Real Value: If you select this option, the actual data values corresponding to

the percentage values are displayed.

Goodsl W Goods2?




- Circles

- Radius: To change the distance between the center of the pie chart and the outer

circle, enter a value or drag the slider. The value range is from 0 to 1.

- Concentric Lines: To display the concentric lines, click the Eye icon.

H Color: To change the color of the concentric lines, see Color picker.

2325.00 ,
Goods1 w Circles

Radius

* Concentric Lines

Color Il RGBA(170,170,1700 @

Goodsl WGoods?




- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Horizontal Interval: To change the horizontal distance between the legend
items, enter a value, or click + or —.

B Vertical Interval: To change the vertical distance between the legend items

and the pie chart, enter a value, or click + or -.

B Position: To change the position of the legend items, click the drop-down

arrow and select the target position.
« Legend

« Text Style

e — e — . Font Size 10

Font Color Il RGBA(2
Font Weight  nommal

= Layout
= Margin

Harizontal
Interval

Goods] |WGoods2?

Vertical

Interval

Position Bottom Center




- Series: To add or delete a series, click + or click the Trash icon.

- Color: To set the color fill type, click the drop-down arrow and select the target
type.
B Solid fill: To change the color of a segment, see Color picker.

B Gradient fill

B You can select two colors as the gradient colors. For more information, see
Color picker.

B To change the gradient angle, enter a value or drag the slider. The value
range is from 0 to 360.

- Inner Radius: To change the inner radius length of a segment, enter a value or

drag the slider. The value range is from 0 to 1.

- Outer Radius: To change the outer radius length of a segment, enter a value or

drag the slider. The value range is from 0 to 1.

Color Gradient Fill

I #40A9FF

Il #FFESSF

Inner Radius

Outer Radius




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Reset All Sectors in Pie Chart: If you select this option, the animation of each
segment in the pie chart is displayed in sequence. If you clear this option, the
animation of each segment in the pie chart is displayed at the same time.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations of
all segments in the pie chart are displayed in sequence. If you clear this option,
the animations of all segments in the pie chart are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation

begins from the starting point.
« Amimation

Onginal 1000
Duration

26.58% |
Goods1|

Reset All
Sectors in Pie

Chart

Easing cubicInOut

e )

Animations
7342% )
Goods?2

All Series In

Duration for
Data Update
Goodsl M Goods2

Update from

Latest Status

Data

x :text of a category
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Interaction

This widget is not connected to any events yet.

6.5.10 Comparison pie chart I
The comparison pie chart IT widget allows you to customize the pie chart style, the

percentage of different categories, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.



- Decoration Color: To change the color of the circle border and center point, see

Color picker.

2?% Font Family &  Microsoft YaHei

O Decoration 2GBA(255.240,2400 @

73% Color

y Value
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- Value

Font Size: To change the font size of the percentage values, enter a value, or click

+or -.

Color: To change the font color of the percentage values, see Color picker.

Font Weight: To change the font weight of the percentage values, click the drop-

down arrow and select the target font weight.

Number of Decimal Places: To change the number of digits to the right of the
decimal point, enter a value, or click + or -.

~ Value

Font Siz 24 --
27% nt Si i

o) Color Bl #FFFFFF

7 3% Font Weight normal

Mumber of
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Places

Real Value

- Real Value: If you select this option, the real data values corresponding to the

percentage values are displayed.
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- Circles

- Radius: To change the distance between the center point and the outer circle of

the pie chart, enter a value or drag the slider. The value range is from 0 to 1.

- Concentric Lines: To display the concentric lines, click the Eye icon.

H Color: To change the color of the concentric lines, see Color picker.

e ——

~ Circles

Radius

« Concentric Lines

e

Building materials  Food Color Il RGBA(170,170,170,0
- Angle Axis
- Angle Offset: You can customize the angle offset of a segment.

p Circles
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- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.

B Font Weight: To change the font weight of the legend text, click the drop-
down arrow and select the target font weight.

- Layout/Margin

B Horizontal Interval: To change the horizontal distance between the legend
items, enter a value, or click + or —.

B Vertical Interval: To change the vertical distance between the legend items
and the pie chart, enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.
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- Series: To add or delete a series, click + or click the Trash icon.

- Color: To set the color of a legend block, click the drop-down arrow and select
the target color.

B Solid fill: To change the color of a segment, see Color picker.
B Gradient fill
B You can select two colors as the gradient colors. For more information, see
Color picker.

B To change the gradient angle, enter a value or drag the slider. The value

range is from 0 to 360.

| = Series

Solid Fill
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- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Reset All Sectors in Pie Chart: If you select this option, the animation of each
segment in the pie chart is displayed in sequence. If you clear this option, the
animation of each segment in the pie chart is displayed at the same time.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations of
all segments in the pie chart are displayed in sequence. If you clear this option,
the animations of all segments in the pie chart are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,
enter a value, or click + or —. The unit is milliseconds.

- Update from Latest Status: If you select this option, the animation begins from
the segment where the data has changed. If you clear this option, the animation

begins from the starting point.
« Animation
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Interaction

This widget is not connected to any events yet.

6.5.11 Percentage pie chart — 11.11 Global Shopping Festival
The widget of percentage pie chart — 11.11 Global Shopping Festival allows you
to customize the pie chart style, the proportion of members, and other options as

needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Chart Options

- Outer Radius: To change the length of the outer radius, enter a value or drag the

slider. The value range is from 0 to 1.

- Inner Radius: To change the length of the inner radius, enter a value or drag the

slider. The value range is from 0 to 1.
- Circle Color: To change the color of the outer circle, see Color picker.

- Circle Thickness: To change the width of the outer circle, enter a value, or click +

or —.

» Chart Options
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- Gradient Options

- Animation Duration: To change the animation duration, enter a value, or click +

or —.

- Gradient Range: To change the gradient range, click the drop-down arrow and
select the target range.
B Full circle
B Arc

- Gradient Colors: To change one of the gradient colors, see Color picker.

= Gradient Options
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- Icon

- File: To change the icon image in the center of the pie chart, enter the URL of the
image.

- Width: To change the width of the icon image, enter a value, or click + or —.

- Height: To change the height of the icon image, enter a value, or click + or -.

- Top Offset: To change the distance between the icon image and the top border of

the pie chart, enter a value, or click + or —.

- Left Offset: To change the distance between the icon image and the left border of

the pie chart, enter a value, or click + or -.

£ [img_.alicdn.comffs/TB1iHS
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- Title

- Text: You can add a title for the pie chart.

- Text Style

B Font Family: To set the font of the title text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

B Font Size: To change the font size of the title text, enter a value, or click + or -.
H Color: To change the font color of the title text, see Color picker.

B Font Weight: To set the font weight of the title text, click the drop-down arrow
and select the target font weight.

B Top Offset: To change the distance between the title text and the top border of

the pie chart, enter a value, or click + or —.

B Left Offset: To change the distance between the title text and the left border of

the pie chart, enter a value, or click + or -.

Text Proportion of Super Members
- Text Style

@ Font Family &
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Font Size 20
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- Percentage Display

- Size: To change the plot of the icon image, the title text, and the percentage
value in the pie chart, enter a value or drag the slider. The value range is from 0
to 1.

- Number Font Size: To change the font size of the numerical value, enter a value,
or click + or -.

- Percent Sign Font Size: To change the font size of the percent sign, enter a value,
or click + or -.

- Top Offset: To change the distance between the percentage value and the top
border of the pie chart, enter a value, or click + or -.

- Decimal Places: To change the number of digits to the right of the decimal point,
enter a value or drag the slider. The value range is from 0 to 2.

- Text Style

B Font Family: To set the font of the percentage value, click the drop-down

arrow and select the target font. The default font is Microsoft YaHei.
B Font Color: To change the font color of the percentage value, see Color picker.

B Font Weight: To set the font weight of the percentage value, click the drop-

down arrow and select the target font weight.



« Percentage Display

Proportion of Sup...

Top Offset

Decimal

Places

« Text Style

Font Fami Microsoft YaHei

Font Color Il #rFF

Font Wei g hit normal

Data
value :actual data value that corresponds to the percentage value The value of
this field is in decimal form where 1 is equal to 100%.
Data Source Type
Static Data
“walue": @
Proportion of Sup...
80s
Interaction

This widget is not connected to any events yet.



6.6 Scatter charts
6.6.1 Scatter plot

You can add one or more scatter plots to a project to display the series in different

time periods.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Margin
B Top: To adjust the spacing between the scatter plot and the top border, enter a
value, or click + or —.

B Bottom: To adjust the spacing between the scatter plot and the bottom border,

enter a value, or click + or -.

B Left: To adjust the spacing between the scatter plot and the left border, enter

avalue, or click + or -.

B Right: To adjust the spacing between the scatter plot and the right border,

enter a value, or click + or -.
* « Global Settings
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- X Axis
- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or

click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Data Type: To set the data type of the axis labels, click the drop-down arrow
and select the target type.

Note:
The data type corresponds to the value of the x field in the data pane. If the
value is a date, set the data type to time. If the value is a category, set the data

type to category. If the value is a number, set the data type to numeric.

B Numeric
B Category
H Time

B Data Format: To set the data format, click the drop-down arrow and select the

target format.

Note:
This option is displayed only when Data Type is setto Time . The data
format must match the time format.
B Display Format: To set the display format of the data along the x-axis, click the
drop-down arrow and select the target format. The data can be displayed in

time or numeric format. If you select the time format, keep the decimal digits



as needed. If you select the numeric format, set the year, month, day, hour,
and second as needed.

B Max: You can customize the maximum time or number value to be displayed.
The maximum value can be displayed in time or numeric format.

B Min: You can customize the minimum time or number value to be displayed.

The minimum value can be displayed in time or numeric format.

Note:
The default minimum and maximum values of the axis labels indicate a time

range. The values in the time range correspond to the x field in the data



pane. If the data in the data pane is inconsistent with a value in the time
range, the value in the time range takes priority.
B Unit: You can customize the unit of data along the x-axis as needed. If the
spacing between the scatter plot and the right border is too small, the unit

will not be displayed. The unit can be in time or numeric format.
B Quantity: To change the number of x-axis labels, enter a value, or click + or -.
B Angle: To set the angle of the x-axis labels, click the drop-down arrow and
select the target angle.
B Horizontal
B Slant
B Vertical

- Axis Line: To display the axis line, click the Eye icon.

Bl Color: To change the color of the x-axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Y Axis

- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Min: To set the format of the minimum value along the y-axis, click the drop-

down arrow and select the target format.

B Minimum data value
B Automatic rounding

B Max: To set the format of the maximum value along the y-axis, click the drop-

down arrow and select the target format.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of y-axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

B Angle: To set the angle of the y-axis labels, click the drop-down arrow and

select the target angle.

B Horizontal
B Slant
B Vertical

- Axis Unit: To display the axis unit, click the Eye icon.

B Unit: You can customize the unit of data along the y-axis as needed.

- Axis Line: To display the axis line, click the Eye icon.

Bl Color: To change the color of the y-axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Legend
- Text Style
B Font Size: To change the font size of the legend items, enter a value, or click +
or —.
H Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout

B Margin

B Horizontal Interval: To adjust spacing 1 (spacing between the legend items

and the right border of the scatter plot) and spacing 2 (spacing between the



legend items and the left border of the scatter plot), enter a value, or click +
or -.

B Vertical Interval: To adjust spacing 1 (spacing between the legend items
and the top border of the scatter plot) and spacing 2 (spacing between the
legend items and the bottom border of the scatter plot), enter a value, or
click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.
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- Series: To add or delete a series, click + or click the Trash icon. The series value

corresponds to the value of the s field in the data pane.

- Series: You can set a name for the series as needed.

- Color: To set the fill color type, click the drop-down arrow and select the target

type. To change the fill color, see Color picker.

B Solid fill

B Gradient fill: You can select two colors as the gradient colors.

B To change the gradient angle, enter a value or drag the slider. The value range
is from 0 to 360.

- Outline Color: To change the outline color of the plots, see Color picker.

Series 2 Series 3

Series Name Series 1
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. : : ' : Il RcBA(92
01 Month 04 Month 07 Month 10 Month |

S S 7 S 3 Frame Color #ODBAFF




Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

« Animation

Original 000

Duration
Easing cubiclnOut

Duration for 300

- ——mmmmmmm - -

Data Update

o
%

L

0
01 Month 04 Month 07 Month 10 Month

Data

x :category data along the x-axis
y :data along the y-axis

s : (optional) series, which indicates the data category

Data Source Type

Static Data

Unit :_—20818/92/81 00:00:¢
o _ =7 "175",
o ' H CJ H . nj-u

312 |

oo
O N,

0 : H H P p—
01 Month 04 Month 07 Month 10 Month L=

=y




Interaction

This widget is not connected to any events yet.

6.6.2 Bubble chart

You can add one or more bubble charts to a project to display data in different time

periods.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and

select the target font. The default font is Microsoft YaHei.

- Margin

B Top: To adjust the spacing between the chart and the top border, enter a

value, or click + or —.

B Bottom: To adjust the spacing between the chart and the bottom border, enter

avalue, or click + or -.

B Left: To adjust the spacing between the chart and the left border, enter a

value, or click + or —.

B Right: To adjust the spacing between the chart and the right border, enter a

value, or click + or -.
« Global Settings
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- X Axis

- Text Style

B Font Size: To change the font size of the text along the x-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the x-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the x-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Data Type: To set the data type of the axis labels, click the drop-down arrow
and select the target type.

B Numeric
B Category
Bl Time

B Data Format: To set the data format, click the drop-down arrow and select the

target format.

Note:
This option is displayed only when Data Type is setto Time .The data
format must match the time format.

B Display Format: To set the display format of the data, click the drop-down

arrow and select the target format.

Note:
The data along the x-axis can be displayed in time or numeric format. If you
select the time format, keep the decimal digits as needed. If you select the
numeric format, set the year, month, day, hour, and second as needed.
B Max: You can customize the maximum time or number value to be displayed.
The maximum value can be displayed in time or numeric format.

B Min: You can customize the minimum time or number value to be displayed.

The minimum value can be displayed in time or numeric format.

Note:



The default minimum and maximum values are auto . If auto is displayed,

the minimum and maximum values of the axis labels are automatically

calculated and displayed.

B Unit: You can customize the unit of data along the x-axis as needed. If the
spacing between the chart and the right border is too small, the unit will not

be displayed. The unit can be in time or numeric format.
B Quantity: To change the number of x-axis labels, enter a value, or click + or -.
B Angle: To set the angle of the x-axis labels, click the drop-down arrow and
select the target angle.
B Horizontal
B Slant
B Vertical

- Axis Line: To display the axis line, click the Eye icon.

B Color: To change the color of the x-axis line, see Color picker.

- Grid Lines: To display the grid lines, click the Eye icon.

B Color: To change the color of the grid lines, see Color picker.
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- Y Axis

- Text Style

B Font Size: To change the font size of the text along the y-axis, enter a value, or
click + or -.

B Font Color: To change the font color of the text along the y-axis, see Color
picker.

B Font Weight: To set the font weight of the text along the y-axis, click the drop-
down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Min: To set the format of the minimum value along the y-axis, click the drop-

down arrow and select the target format.

B Minimum data value
B Automatic rounding

B Max: To set the format of the maximum value along the y-axis, click the drop-

down arrow and select the target format.

B Maximum data value
B Automatic rounding
B Quantity: To change the number of y-axis labels, enter a value, or click + or -.

B Display Format: To set the display format of the axis labels, click the drop-

down arrow and select the target format.

B Angle: To set the angle of the y-axis labels, click the drop-down arrow and

select the target angle.

B Horizontal
B Slant
B Vertical

- Axis Unit: To display the axis unit, click the Eye icon.

B Unit: You can customize the unit of data along the y-axis as needed.

- Axis Line: To display the axis line, click the Eye icon.

Bl Color: To change the color of the y-axis line, see Color picker.

- Grid Lines

B Color: To change the color of the grid lines, see Color picker.
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Bubbles
- Map by Y-Axis
B If you select this option, the minimum and maximum radii of the bubbles are
mapped according the minimum and maximum values along the y-axis.

B If you clear this option, you need to customize the value range of the bubbles

to control the bubble radii

B Min: You can set the minimum value for a bubble, and the system will
compare the value you set with the r value in the data pane. If the r

value is smaller than the set value, the bubble is not displayed. If the r



value is greater than the set value, the bubble is displayed. The radius of
the bubble = (r value - the minimum value)/the maximum value X r value.
B Max: You can set the maximum value for a bubble, and the system will
compare the value you set with the r value in the data pane. If the r
value is smaller than the set value, the bubble is not displayed. If the r

value is greater than the set value, the bubble is displayed. The radius of

the bubble = (r value - the minimum value)/the maximum value X r value.

Unit

¥ Y Asas
~ R Axis

Map by ¥-Axis

» Legend

» Series
- Legend
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

H Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.

- Layout
B Margin

B Horizontal Interval: To adjust spacing 1 (spacing between the legend item
or legend items and the right border of the chart) and spacing 2 (spacing
between the legend item or legend items and the left border of the chart),
enter a value, or click + or -. The setting takes effect only when two or more
series are set.

B Vertical Interval: To adjust spacing 1 (spacing between the legend item

or legend items and the top border of the chart) and spacing 2 (spacing



between the legend item or legend items and the bottom border of the

chart), enter a value, or click + or -.

B Position: To set the position of one or more legend items, click the drop-down

arrow and select the target position.
B Top center

B Top left

B Top right

B Bottom center

B Bottom left

B Bottom right
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- Series: To add or delete a series, click + or click the Trash icon.

- Series Name: You can set a name for the series as needed.

- Color: To set the fill color type of the center point of the bubbles, click the drop-

down arrow and select the target type. To change the fill color, see Color picker.

W Solid fill

B Gradient fill: You can select two colors as the gradient colors.

B To change the gradient angle, enter a value or drag the slider. The value range
is from 0 to 360.

- Outline Color: To change the outline color of the bubbles, see Color picker.
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Il RGBA(S0, 191, 200,( @

Frame Color #ODBAFF [




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

~ Animation

Original

Duration

Easing cubicInOut

Duration for 300

Data Update
0
01/01 02/01 03/01 04/01 05/01

*
!
|
.
!
:
L ]

Data

x :label along the x-axis

y :data along the y-axis

r :radius of the bubbles in the bubble chart (This field takes effect when the data
is not mapped by the y-axis.)

s : (optional) series, which indicates the data category



Data Source Type

Static Data

[

I
L

“2818/83/81 60:88:¢
125",
"ce

Interaction

This widget is not connected to any events yet.

6.7 Other charts
6.7.1 Liquid chart

You can add one or more liquid charts to a project to display a percentage value of

data in different styles.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



+ Qutline Line

Shape: To set the shape of the outline line, click the drop-down arrow and select

the target shape.

M Circle
B Square
B Rounded square

Radius: To change the default radius of the liquid chart, enter a value or drag the

slider. The value range is from 0 to 1.
Border Color: To change the border color of the liquid chart, see Color picker.
Border Width: To change the border width, enter a value, or click + or -.

Border Distance: To change the border distance, enter a value, or click + or —.

- Text Style

Text

B Color: To change the text color when the text is not covered by the liquid, see

Color picker.

Bl Inside Color: To change the text color when the text is covered by the liquid,
see Color picker.

B Font Size: To change the font size of the text, enter a value or drag the slider.
The value range is from 10 to 100.

B Width: To set the font weight of the text, click the drop-down arrow and select
the target font weight.

B Height location: Manually enter a numeric value or drag the slider to change

the height of the text, the range of valuesis 0 to 1.
B Percentage display: Click the drop-down arrow to select the text percentage
display style.
B Integer
B A decimal number

B Two decimal places.



- wave

Number of peaks: Manually enter a numeric value or drag the slider to change

the number of peaks in a range of 1 to 10.

- Amplitude: Manually enter a numeric value or drag the slider to change the

wave amplitude, from 0 to 1.

- Phase: Manually enter a numeric value or drag the slider to change the wave

phase, with a range of 0 to 360.

- Cycle: Manually enter a numeric value or drag the slider to change the wave

period, covering a range of 0.5 to 60, units are seconds.

- Transparency: Manually enter a numeric value or drag the slider to change the

transparency of the wave, from 0 to 1.

- Animation: ClickEye buttonDisplays animation features.
B Direction: Click the drop-down arrow to select a style for the direction.

B Left to right.
H Right to left.
B Change Effect: Click the drop-down arrow to select a change effect style.

B constant speed
B Acceleration
B slow down

- Scatter Type: Click the plus (+) sign or the trash can icon to add or delete a type.

- Color: To change the text color when the text is not covered by the liquid, see

Color picker.

Data
Value : Corresponds to the data content of the percentage icon in the basic water
level diagram.
Interaction

This widget is not connected to any events yet.



6.7.2 Icon chart — 11.11 Global Shopping Festival

You can add one or more icon charts (11.11 Global Shopping Festival) to display the

data percentages clearly.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Icon

- Male Icon: To change the male icon, paste the target icon URL or upload an icon
from your local server.

- Female Icon: To change the female icon, paste the target icon URL or upload an
icon from your local server.

- Male Label: You can customize the label text of the male icon as needed.

- Female Label: You can customize the label text of the female icon as needed.

- Layout: To set the layout of the male and female labels, click the drop-down

arrow and select the target layout.

B Vertical: If you select this option, the male and female labels are hidden.

B Horizontal: If you select this option, the label text is displayed horizontally.

Male Icon & Ifimg_alicdn_comfps/TB1UT

Female Icon ¢ Ifimg alicdn com/tps/TB1Ao

Layout




- Style

- Icon Width: To change the width of the male and female icons, enter a value or
drag the slider. The value range is from 0 to 1000.

- Icon Height: To change the height of the male and female icons, enter a value or
drag the slider. The value range is from 0 to 1000.

- Font Size: To change the font size of the icon text, enter a value or drag the slider.

The value range is from 0 to 100.

- Font Family: To set the font of the icon text, click the drop-down arrow and

select the target font. The default font is Microsoft YaHei.
- Color: To change the font color of the icon text, see Color picker.
- Icon Offset: To adjust the spacing between the icons, enter a value or drag the
slider. The value range is from 0 to 1000.
- Space Between Icon and Text: To adjust the spacing between the icons and the icon
text, enter a value or drag the slider. The value range is from 0 to 1000.
- Text Spacing: To adjust the spacing between the icon text, enter a value or drag the

slider. The value range is from 0 to 1000.



- Decimal Places: To change the number of digits to the right of the decimal point,

enter a value, or click + or -.

- Style

Icon Width =

Icon Height —H

55.00% 45.00%

| SN ——

Font Size

Font Family (& Microsoft YaHei

Color I #rFF

Icon Offset -

Space Between Ml

Icon and Text

Text Spacing

Data

name :label text of an icon

value :decimal number, which corresponds to a percentage value in the chart



Data Source Type

Static Data

: "men”,
. @.cc

2™ "women™,

Interaction
This widget is not connected to any events yet.

6.7.3 Radar chart

You can add one or more radar charts to a project to display the data of different

categories and series.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Margin
B Top: To adjust the spacing between the chart and the top border, enter a
value, or click + or —.

B Bottom: To adjust the spacing between the chart and the bottom border, enter

avalue, or click + or -.

B Left: To adjust the spacing between the chart and the left border, enter a

value, or click + or -.

B Right: To adjust the spacing between the chart and the right border, enter a

value, or click + or —.

- Label: To display the labels, click the Eye icon.
H Text Style
B Font Size: To change the font size of the label text, enter a value, or click +
or —.
B Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To set the font weight of the label text, click the drop-down

arrow and select the target font weight.



+ Global Settings

Font Family

~ Margin
Top
Bottom
Left

Right

Font Color [l #FFF

Font mormial

Weight




Angle Axis
- Text Style

B Font Size: To change the font size of the text along the angle axis, enter a
value, or click + or -.

B Font Color: To change the font color of the text along the angle axis, see Color
picker.

B Font Weight: To set the font weight of the text along the angle axis, click the
drop-down arrow and select the target font weight.

B Rotate Angle: To change the rotation angle of the angle axis, enter a value or

drag the slider. The value range is from 0 to 360.

Ambwii

« Angle Aas
Heilongliang

= Text Sty

Font Size

-

Font Color Il RGBA(2

FomtWeight  nommal

Lizoning

w Angle Aoas

Zhejiang

w Text Style

mner Mongolia

Heilongliang Font Color Il RGBA
Font Weight  normal

Rotate Afigle

360




- Circles
- Text Style
B Font Size: To change the font size of the text along the circles, enter a value, or
click + or -.
H Font Color: To change the font color of the text along the circles, see Color
picker.

B Font Weight: To set the font weight of the text along the circles, click the drop-

down arrow and select the target font weight.

- Axis Label: To display the axis labels, click the Eye icon.

B Min: You can customize the minimum value of an axis label as needed.

Bl Max: You can customize the maximum value of an axis label as needed.

Note:



By default, the minimum value of an axis label is 0, and the maximum value of
an axis label is auto . If auto is displayed, the maximum and minimum values
in the data pane are automatically calculated and displayed in the radar chart.

- Axis Line: To display the axis lines, click the Eye icon.

B Color: To change the color of the axis lines, see Color picker.

- Concentric Lines: To display the concentric lines, click the Eye icon.

B Color: To change the color of the concentric lines, see Color picker.

= Circles
------------------------------ B Y

Anhwui

Fujian

Font Size
Heilongliang

Font Color Il RGBA(

w Aods Label
Min

Max

Lizoning
This 1s Senes 1 W This
______________________________ S

|
|
|
1
|
|
|
|
|
|
!
50 Inner Monga 'l Font Weight normal
!
|
|
1
|
|
|
1
|
|
|
|

« Moas Line
Color - RGBA(
Concentric Lines

Color - RGBA(




- Legend: To display the legend items, click the Eye icon.
- Text Style

B Font Size: To change the font size of the legend text, enter a value, or click + or

B Font Color: To change the font color of the legend text, see Color picker.
B Font Weight: To set the font weight of the legend text, click the drop-down
arrow and select the target font weight.
- Layout
B Margin
B Horizontal Interval: To adjust spacing 1 (spacing between the legend items
and the right border of the chart) and spacing 2 (spacing between the
legend items and the left border of the chart), enter a value, or click + or -.
B Vertical Interval: To adjust spacing 1 (spacing between the legend items

and the top border of the chart) and spacing 2 (spacing between the legend

items and the bottom border of the chart), enter a value, or click + or -.

B Position: To set the position of the legend items, click the drop-down arrow

and select the target position.

B Top center

B Top left

B Top right

B Bottom center
B Bottom left

B Bottom right



R

Anhai

Font Size
Heilongliang

Font Color | I

Font Weight  nommal
= Layout

w Margin

Honzontal

Interval

1
|
?

)

Vertical

Interval

Position Bottom Center

Series: To add or delete a series, click + or click the Trash icon.

- Series Value: You can customize the value of a series as needed. The series value
is the same as the value of the s field in the data pane.

- Series Name: You can set a name for the series as needed.

- Stroke Color: To change the stroke color, see Color picker.

- Stroke Width: To change the stroke width, enter a value or drag the slider. The

value range is from 0 to 10.

- Fill: To change the color of a series, see Color picker.

Heilongliang

Stroke Color

Stroke Width




- Animation: To display the animation option, click the Eye icon.

- Original Duration: To change the duration to which the widget renders
the animation for the first time, enter a value, or click + or —. The unit is
milliseconds.

- Easing: To set animation easing, click the drop-down arrow and select the target
effect.

- Animations of All Series in Sequence: If you select this option, the animations of
all segments in the chart are displayed in sequence. If you clear this option, the
animations of all segments in the chart are displayed at the same time.

- Duration for Data Update: To change the animation duration when data changes,

enter a value, or click + or —. The unit is milliseconds.

~ Animation
Anhui

uiia S
Fujian Original

Duration

*
|
|
|
]
I - +
| [
! -
]
!
|
a |
: ! .
N Easing cubicInOut
—1 Inner Mongolia |
. . .
| Animations of
]
!
|
|
|
|
|
|
|
!
!
]
]
]
]

Jili All Seri
Jilin All Series In

Sequence
Zhejiang

Liaoning Duration for

This is Series 1 W This is Series 2 Data Update

Data

x :category text in the chart
y :actual value corresponding to a category in the chart

s :series value in the chart



Data Source Type

Static Data

[

I
L

"Inner Mongolia™,
375"

1

"Inner Mongolia™,
180",
Hlin nou

Interaction
This widget is not connected to any events yet.

6.7.4 Radar chart — 11.11 Global Shopping Festival

You can add one or more radar charts (11.11 Global Shopping Festival) to display the

data percentages clearly.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- General

- Top Offset: To adjust the spacing between the chart and the top border, enter a

value, or click + or -.

« General

Top Offset

» Circle Style

¥ Area and Gradient

- Circle Style

- Color: To change the color of the outer circle, see Color picker.

- Thickness: To change the weight of the outer circle, enter a value, or click + or -.

y General
« Cirde Style

Color #ODBAFF

Thickness

- Area and Gradient

- Radial Axis Scale: To change the radial axis scale, enter a value, or click + or -.

- Gradient Colors: To change the colors of different areas, see Color picker.

E] Note:



To add or delete a color, click + or click the Trash icon.
- Stroke Width: To change the stroke width of the radar areas, enter a value, or
click + or -.
- Stroke Type: To change the stroke type of the radar areas, click the drop-down

arrow and select the target type.

B Smooth
B Linear
- Curve Arc: To change the arc of the radar area stroke, enter a value or drag the

slider. The value range is from 0 to 1.

= Area and Gradient

T}" pE']_ Radial Asas
Scale

TypeZ' w Gradient Colors

Color 2 Color 3

Type3

Position [ |

Color #O0BAFF

Stroke Width O

Stroke Type Smooth

Curve Arc




- Text and Lines

- Space Between Text and Lines: To adjust the spacing between the displayed text
and the lines, enter a value or drag the slider.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Font Family: To change the font color of the displayed text, see Color picker.

- Font Size: To change the font size of the displayed text, enter a value or drag the
slider.

- Font Weight: To set the font weight of the displayed text, click the drop-down
arrow and select the target font weight.

- Line Color: To change the color of the lines, see Color picker.

- Line Width: To change the width of the lines, enter a value or drag the slider.

~ Text and Lines

Space
between Text

and Lines

Font Family & Microsoft YaHei

Font Color Il RGBA(255,255,255 0

Font Size 20
Font Weight normal
LineColor [l RGBA(255,255 2550

Line Width




- Spinning Overlay

- Image: To add an image, enter or paste the image URL.
- Animation Duration: To change the animation duration, enter a value, or click +

or —.

« Spinning Overlay

Image hitps:/idatav. oss-cn-hangzhouw

Amimation

Duration (s)

Data

type :icon text

value :type value. A greater value indicates a larger radial area within the chart.

Data Source Type

Ctatic Data

[
I
D AR 1}
Cype
"valug" - 28

“t}f pE Ll : "
"value":

“t}pr Ll :

"value":
5 ]

“t}pr Ll :

"value":

J

Interaction

This widget is not connected to any events yet.



6.7.5 Single bubble chart — 11.11 Global Shopping Festival

You can add one or more single bubble charts (11.11 Global Shopping Festival) to a
project to display data using the bubbles of different types and sizes.

Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- General

- Animation Duration: To set the animation duration, enter a value, or click + or -.

- Animation Type: To set the animation type, click the drop-down arrow and

select the target type.

- Padding: To adjust the spacing between the bubbles, enter a value, or click + or

- Scale: To change the proportion of the bubbles in the chart, enter a value, or

click + or -.
- Horizontal Offset: You can adjust the horizontal spacing between the bubbles as

needed. The unit is pixels.

- Vertical Offset: You can adjust the vertical spacing between the bubbles as

needed. The unit is pixels.
~ General

Animation

Duration (s)

Animation easeBackOut

s 1_"_-,-"' e

Paddin g

Scale

Hornzontal

Offset

Vertical Offset




- Text Style

- Font Color: To change the font color of the displayed text, see Color picker.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Font Weight: To set the font weight of the displayed text, click the drop-down
arrow and select the target font weight.

- Max Font Size: To change the maximum font size of the displayed text, enter a

value, or click + or —.

- Min Font Size: To change the minimum font size of the displayed text, enter a

value, or click + or -.

~ Text Style

Font Color - #FFFFFF

Font Family @ Microsoft YaHei

Font Weight  bolder

Max Font Size 20

Min Font Size 10

¥ Mode Style

- Node Style

- Color: To change the color of the bubbles, see Color picker.

« Node Style

Color #00BAFF

Data

value :data value that corresponds to a bubble



content :text of a bubble label

Data Source Type

Static Data

"wvalue”:
rcontontt-

"value™: 6432
“content .

“"wvalue™: 3452
Lwcontent™: “"Ha

"walue":
“"content™:
1

Interaction

This widget is not connected to any events yet.

6.8 Flat maps with 3D effects

6.8.1 Map container
Flat Map with 3D Effects is a container that holds a flat map with 3D effects. You can

add layers such as scatter layers, flying routes layers, and columns layers to this



container, which enables you to show real-time data across the globe from multiple

perspectives and in diverse forms.
Style
- Child Management

- Add a Child Widget: Click the + button next to Child Management, select a child
widget, and then click Add a Child Widget. The added child widget is displayed

in Child Management.
{7/}

Flat Map with 3D Effects

Child Management

Scatter Lay  Flying Routes Layer@0.2.3

Flying Rout  Columns Layer@0.2.1

- Scatter Layer@0.2.2
Columns L:

Basic Attrib Add a Child Widget

- Copy, edit, or delete a child widget: Move the mouse over the added child widget
and click next to the child widget name to copy the child widget. Click E

to edit the name of the child widget. Click u to delete the child widget.

- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Options
- Camera Rotation

B Horizontal: Drag the slider or enter a value to rotate the camera horizontally.
The range of the value is -180 to 180.

B Vertical: Drag the slider or enter a value to rotate the camera vertically. The
range of the value is -90 to 90.

- Camera Center

B Latitude: Drag the slider or enter a value to set the latitude of the camera. The
range of the value is -90 t090.
B Longitude: Drag the slider or enter a value to set the longitude of the camera.
The range of the value is -180 to 180.
- Camera Distance: Drag the slider or enter a value to set the focal length of the
camera. The range of the value is 18-420.
- Map Interaction: Select the check box to enable the map interaction feature.

With this feature, you can create interaction events in the preview page or



the published page. For example, you can create an event that is triggered by

clicking. Clear the check box to disable the map interaction feature.

= Global Options

« Camera Rotation

Horizontal — Bn

Vertical

= Camera Center

Latitude

Longtitude

Camera

Distance

Map

Interaction

- Fill Options
- Fill Color

B MinValue Color: You can modify the minimum value for the color. For more

information, see Color Picker.

B MaxValue Color: You can modify the maximum value for the color. For more

information, see Color Picker.

)
|:| Note:



Different countries/regions are rendered with different colors based on the
value field in the data tab.

B NoData Color: You can modify the color of the countries/regions whose
value fields are not specified in the data tab. For more information, see
Color Picker.
B Back Side: You can modify the color of the back of the map. For more
information, see Color Picker. You can view the back of the map by rotating the

camera. For example, see the second figure that follows.

Flat Map with 3D Effects

» Global Options

~ Fill Options

Flat Map with 3D Effects

Basic Attributes

» Global Options

~ Fill Options

#FFADAF




- Outline Options
H Outline Color: You can modify the color of the outlines on the map. For more
information, see Color Picker.

B Outline Width: Click + or - or enter a value to modify the width of the outlines

on the map.
B Opacity: Drag the slider or enter a value to set the opacity of the outlines on

the map. The range of the value is 0-1.

Data
Two fields can be configured by default in the data tab of the map container.

id : The abbreviation of the country/region on the map.
to : The value of the country/region. The color of a country/region is determined
by both the value field and the configurations in the style tab.

name (optional): The full name of the country/region.



Flat Map with 3D Effects

Child Management
Scatter Layer
Flying Routes Layer
Columns Layer
Region Data s Completed

Field Mapping Status

s Matched
Successfully
» Matched
Successtully

id
value

Data Source Type

Ctatic Data

llidll: II.&FE"-‘
“"value™: 15,
“name”: "Afghanistan”

llidll: “.EIJE'D"-‘
“valua™: 13,
“name”: "Angola”

llidll: II.&LBII-‘
"value™: 14,
“name™: "Albania”™

Interaction

This widget is not bound to any events.



6.8.2 Flying Routes Layer
You can set flying routes on the map using the flying routes layer. A flying route

indicates the transition animation from one location to another.
Style

- Height: Drag the slider or enter a value to modify the maximum height of the flying
routes. The range of the value is 0-3.

- Fly Speed: Drag the slider or enter a value to modify the animation speed of the
flying route. The range of the value is 0.1-25.

- Hue: Drag the slider or enter a value to modify the hue value of the flying route

line. The range of the value is 0-1.

@ Note:

This value equals to the general hue value divided by 360. A generally hue value is
represented by an angular position around a neutral point on a color wheel, which

ranges from 0 to 360.
- Width: Click + or - or enter a value to modify the width of the flying routes.
- Density: Click + or - or enter a value to modify the number of flying particles on a

single route at each occurrence.

vy

< Flying Routes Layer

Height

Data

from : The longitude and latitude of the origin on a flight route, which are

separated by a comma (,).



to :The longitude and latitude of the destination on a flight route, which are

separated by a comma (,).

¢ Flying Routes Layer

Flying Routes Data » Matching
Field Mapping Status
from » Matching

to » Matching

Data Source Type

Ctatic Data

L
“from":
“to": "118.
. ]
“from":
lltDll:
. ]

“from":
"to": "117.

5

“from":
lltDll :

b ]

Data filter:

Interaction

This widget is not bound to any events.



6.8.3 Scatter Layer

You can set points on the map using the scatter layer. A point indicates the

information of the specified geographic coordinates.
Style

- Scale: Drag the slider or enter a value to set the distance from the scatter layer to
the flat map. The range of the value is 0-20.

- Animation Range: Drag the slider or enter a value to set the animation range of the
points. The animation range is affected by the radius of the point. The range of the
value is 0-3.

- Animation Speed: Drag the slider or enter a value to set the animation speed. The
range of the value is 0-0.2.

- MaxValue Radius: Drag the slider or enter a value to set the maximum radius of the
points. The radius of a point is determined by both the value field in the data tab
and the configurations in the style tab. The range of the value is 1-100.

- MinValue Radius: Drag the slider or enter a value to set the minimum radius of the
points. The radius of a point is determined by both the value field in the data tab

and the configurations in the style tab. The range of the value is 1-50.

, Scatter Layer
<




- Scatter Style

- Inner Color: You can modify the inner color of the points. For more information,

see Color Picker.

- Outer Color: You can modify the outer color of the points. For more information,

see Color Picker.

- Gradient Level Count: Drag the slider or enter a value to set the number of levels
in the gradient. The animation becomes smoother if you increase the number of

levels. The range of the value is 1-40.

- Gradient Type: Select a gradient type from the drop-down list.

B Linear None
B Quartic InOut
B Quartic Out
B Quartic In

Il #FFFCO0

Il #B1B41F

Data

lng : The longitude of the point.
lat :The latitude of the point.

value :The value of the point. The size of a point is determined by both the value

field and the configurations in the style tab.



< Scatter Layer

Scatter Data

Interaction

This widget is not bound to any events.

6.8.4 Columns Layer
You can set 3D columns on a map using the columns layer. A 3D column indicates the

value and other information of the specified geographic coordinates.
Style

- Maximum Height: Drag the slider or enter a value to set the maximum height of the

columns. The range of the value is 0-65536.

@ Note:

The height of a column is affected by the value field in the Data tab.

- Cell Size: Drag the slider or enter a value to set the width of the columns. The range
of the value is 30-6000.

- Color: You can modify the color of the columns. For more information, see Color
Picker.

- Opacity: Drag the slider or enter a value to set the opacity of the columns. The

range of the value is 0-1.



, Columns Layer
<

Maximum

Height

Data

1ng : The longitude of the column.
lat : The latitude of the column.

value :The value of the column. The height of a column is determined by both

the value field and the Maximum Height in the style tab.



—
—-—

Columns Layer

<

Columns Data s Completed

Field Mapping Status

s Matched

Successfully
| s Matched
n
< Successtully
» Matched
value -
Successtully

Data Source Type

Ctatic Data

“lat":
"Ing™:
“value”:

“lat":
"Ing™:
“value”:

“lat":
"Ing™: 114
“value”:

Interaction

This widget is not bound to any events.



6.9 Basic flat map widgets
6.9.1 Map Data format

Gcj-02 Coordinate System

G(CJ-02 is a coordinate system developed by the National Bureau of Mapping and
Geoinformation (People’ s Republic of China) for geographical information systems
(GISs). GCJ-02 is an encryption algorithm for latitude and longitude that inserts
random offsets. Map systems released in China (including those in electronic form

) must implement initial encryption on geographical locations using at least GCJ-02-

level of encryption.

- JJavascript version: Coordinate System Conversion Tool.

- JavaScript version: coordinate system conversion tool for whole GeoJSON conversion.
GeoJSON format

- GeoJSON is a GIS data exchange format based on the JavaScript object expression

method.

- To edit GeoJSON files online, see geojson.io.
Coordinator picker—google map

The coordinator picker converts between detailed addresses and precision
coordinates. For example, as shown in the following figure, if you enter Hangzhou
, Zhejiang and click West Lake, the corresponding coordination information is

displayed.


https://github.com/wandergis/coordtransform-cli?spm=a2c4g.11186623.2.5.whUmyN
https://github.com/wandergis/coordtransform-cli?spm=a2c4e.11153940.blogcont554167.11.5aae1ab0TbZ6Z9
http://geojson.io/?spm=a2c4g.11186623.2.7.whUmyN
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6.9.2 Configure a basic flat map
This topic describes how to configure the style, data, and interaction of a basic flat

map.

Configure the configuration plane

Basic Atinbutes

Position

Others

= Global Options

Ba cl-::gr:::und - RGBA(D,D,0,0)

Zoom Level |

2

Map Center

Longitude
-180  106.5306

Latitude — |
385714 80

Draggable
Zoomable

Interactive




- Component Management
- To add a widget, follow these steps:

1. In the DataV console, click the basic flat map, and click the Configuration tab.

2. Click + on the left of Component Management.

3. Select one or more widgets and click Add Child Widget. The names of the
added widgets are displayed in the Component Management area.

4. Click a widget and configure the widget parameters, as shown in the

following figure.

¢ Basemap Layer

Mask Color Il RGBA(D,0,0,0)

Opacity

TileUrd @&
Auto Refresh &
Use Filter

y Filter

5. Go back to the configuration plane of the basic flat map to configure other
widgets.

- In the Component Management area, you can click . to copy a widget, click

. to rename a widget, or click . to delete a widget.

il
[:] Note:

For more information about how to manage widgets, see Manage child widgets of a

map widget.



- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Options: Set the map parameters, including the background color, zoom

level, longitude and latitude of the map center, and scale ruler.

- Background: Set the background color of the map. For more information, see

Color picker.

- Zoom level: Adjust the zoom level by dragging the slider or entering a zoom

value.

Note:
The value of the zoom level can be a whole or decimal value.

- Map Center: Adjust the longitude and latitude of the map center by dragging the
slider or entering a value.

- Scale Ruler: Click the Eye icon to enable or disable the Scale Ruler function. If
this function is enabled, you can adjust the font color and line color of the scale
ruler.

- Draggable: Select this check box to allow the map to be dragged by clicking it.
This setting takes effect only when you preview the map or after you publish the
map.

- Zoomable: Select this check box to allow the map to be zoomed in or zoomed
out by scrolling up or scrolling down. This setting takes effect only when you
preview the map or after you publish the map.

- Interactive: Select this check box to enable the interaction function. When you
preview a widget or after you release a widget, you can click an area to view the

data of this area.

Note:
You can also adjust the map center point and zoom level by configuring the data

source.



Basic Flat Map

Child Management
Basemap Layer
B

Points Heatmap Layer

Map Status = Completed

Field Mapping

Ing = Optional
lat = Optional

Data Source Type

The following is an example of data in the data source:

" zoom ": 4
n 'Lng n
n 'Lat n



Configure the data plane

Child Management

Basemap L Choropleth Layer@0.2.6

[:thrrq::pletl- Animation Bubbles LEI}FE-I’@].....

Points Heat Flying Routes Layer@0.2.0

Grid Heatmap Layer@1.1.0
Map Status
Points Heatmap Layer@0.2.0

Field Maj  fsosurface Layer@0.2.0
z00m Line Layer@0.2.0

Scatter Layer@0.2.0

Basemap Layer@0.2.2

Data Source ype

zoom : Optional. Set the zoom level of the map. The zoom field corresponds to
the Zoom Level field on the Configuration tab. If you set the zoom level for both

zoom and Zoom Level, the value of zoom is used.

lng : Optional. Set the longitude of the map center. The 1ng field corresponds
to the Longitude field on the Configuration tab. If you set the longitude for both

1ng and Longitude, the value of 1ng is used.

lat :Optional. Set the latitude of the map center. The 1lat field corresponds to
the Latitude field on the Configuration tab. If you set the latitude for both 1at

and Latitude, the value of 1lat isused.
Configure the interaction plane
The basic flat map does not support the configuration of callback IDs.

However, some child widgets, such as the choropleth layer, region drill-down heat
layer, line layer, and scatter layer, support callback IDs. The configuration of callback
IDs allows you to implement map interactions. For more information, see Configure

widget interaction and Configure callback IDs for ticker boards.



6.9.3 Configure a basemap layer
This topic describes how to configure a basemap layer (also called a tile layer) that

functions as a basic flat map background.
Prerequisites

The basemap layer child widget is added to the basic flat map, and the widget

parameters are set. For more information, see Configure a basic flat map.

Configure the configuration plane

< Basemap Layer

Mask Color Il RGBAID,D,0,0)

Opacity

TileUd & s} tile openstreetmap_orgl

Auto Refresh

Use Filter

- Mask Color: Set the mask color of the basemap layer. For more information, see
Configure item description.
- Opacity: Set the opacity of the basemap layer by dragging the slider or entering a

value. The value range of this parameter is 0 to 1.



- TileUrl: Enter a tile URL in the box. DataV supports the following map tile service
URLs:

- GeoQ map
B GeoQ misty gray. Its URL is /map.geoq.cn/ArcGIS/rest/services/ChinaOnlin

eStreetGray/MapServer/tile/{z}/{y}/{x}

B GeoQ midnight blue. Its URL is /map.geoq.cn/ArcGIS/rest/services/
ChinaOnlineStreetPurplishBlue/MapServer/tile/{z}/{y}/{x}

B GeoQ color. Its URL is //map.geoq.cn/ArcGIS/rest/services/ChinaOnlin
eCommunity/MapServer/tile/{z}/{y}/{x}

B GeoQ edge. Its URL is //thematic.geoq.cn/arcgis/rest/services/ThematicMaps/
administrative_division_boundaryandlabel/MapServer/tile/{z}/{y}/{x}
- Amap

B Electronic map of amap.com. Its URL is http://webst02.is.autonavi.com/
appmaptile?style=7&x={x}&y={y}&z={z}

B Satellite map of amap.com. Its URL is http://webst02.is.autonavi.com/
appmaptile?style=6&x={x}&y={y}&z={z}

W Satellite map (road networks and annotations) of amap.com. Its URL is http://
webst02.is.autonavi.com/appmaptile?style=8&x={x}&y={y}&z={z}

- Google MapS

B Google electronic map. Its URLis http :// www . google . cn / maps /
vt ? lyrs = m@ 189 & gl = cn & x ={ x }& vy ={ vy }& z ={ z }.

B Google satellite map. Its URLis http :// mt3 . google . cn / vt / lyrs
=s &hl=zh-CN&gl=cn &x={x3}&y={yl}z={2z73

- Auto Refresh: Select this check box to enable the auto refresh function.

Note:
You must enable this function to obtain the latest map tile service data if you use

the tile URL of the Amap heat service or the Amap real-time traffic status service.

Refresh Interval: Set the interval (in minutes) at which the tile service is

automatically refreshed.
- Use Filter: Select this check box to add a filter effect to the basemap layer.

- Filter: Set the filter parameters, including Brightness, Contrast, Grayscale,

HueRotate, Invert, Saturate, and Sepia.



Configure the data plane
No settings are required.
Configure the interaction plane

No settings are required.

6.9.4 Configure a scatter layer
This topic describes how to configure a scatter layer (a type of data point layer) on a

map to display data across geographical locations by using scatter plot points.
Prerequisites

The scatter layer child widget is added to the basic flat map and the widget

parameters are set. For more information, see Map container.
Configure the configuration plane
- Set the Default Options.

- Callback ID: Set the field for associating data between widgets. This field
must belong to the data of this widget, and you can only set one field for this

parameter.

Note:
This function is also added to the Interaction plane where you can set multiple
fields. Additionally, this function will be removed from the Configuration plane.
Therefore, we recommend that you upgrade the widget to the latest version.
- Label: Click the Eye icon on the right to show or hide labels for scatter plot

points.

B Label Field: Set the field to label each scatter plot point. This parameter

setting must match a field of the data in the data plane. For example, if you set



this parameter to name, each scatter plot point will be labeled by the value of

the name field that has the same ID.

¢ Scatter Layer

w Default Options

Callback ID

ﬁ-ﬁ)i"t 10 int w Label
‘ L

PDI& 27 Label Field @& name
Label Color [l #FFF

Shadow Color

Font Family Microsoft Yahei

Font Size 12

Label Position Center

Data Source Type
Static Data

"value™: 19,
"info": "Description ind
"type”: "error”,

"name”: "Point 9"

“dotid”:
"lat™: 4

"Ing":

"value™: 9,

"info": "Description ind
“type”- ok,

"name”: “"Point 18"

"dotid" :
i = e

H Label Color: Set the label color. For more information, see Configure item
description.

B Shadow Color: Set the shadow color of the label. For more information, see
Configure item description.

B Font Family: Select a font family for the label from the drop-down list.

B Font Size: Click + or -, or enter a font size value to set the font size for the

label.



B Label Position: Select a value from the drop-down list to set the position of
each label relative to its corresponding scatter plot point. Available values are
Center, Top Center, Bottom Center, Left, and Right.

- Scatter Options

B Data Mapping: Select this check box to associate the color and the size of each

scatter plot point with its value field in the data source.

M Fill Color: Set the values for MinValue Color, MaxValue Color, and NoData

Color. These three parameters take effect only if you select the Data Mapping
check box.

B MinValue Color indicates the color of the scatter plot point that has the

minimum value in the value field in the data source.

B MaxValue Color indicates the color of the scatter plot point that has the
maximum value in the value field in the data source.
B NoData Color indicates the color of the scatter plot point that has no value

inthe value field in the data source.

Ifthe value field of a scatter plot point is between the maximum value and
the minimum value, the system displays the scatter plot point as a gradient
color according to its proportional value.

B Scatter Size: Set the values for MinValue Size, MaxValue Size, and NoData Size.
These three parameters take effect only if you select the Data Mapping check

box.

B MinValue Size indicates the size of the scatter plot point that has the

minimum value in the value field in the data source.

B MaxValue Size indicates the size of the scatter plot point that has the

maximum value in the value field in the data source.

B NoData Size indicates the size of the scatter plot point that has no value in

the value field in the data source.

Ifthe value field of a scatter plot point is between the maximum value
and the minimum value, the system displays the scatter plot point in a size
according to its proportional value.

H Outline Options: Set the color and width of the outline of the scatter plot

points.



- Popup Options
H Font Color: Set the color of the text in the popup box. For more information,
see Configure item description.

B Font Size: Set the size of the text in the popup box. For more information, see

Configure item description.



- Set the Series Options.

Click the + or Trash Can icon to add or remove a scatter type.

- Filter Value: Enter a type value (specified in the data plane) to filter a specific

type of scatter plot points. Then, you can set the icon style of the scatter plot

points of this type.

BuwKex
@

Keliprel3cTau

Jaipur  Lucknow

ATLFTH
medabad N 1

« Series Options

L Scatter Type2

Filter Value

Icon Options

w Icon

Icon Size

Icon Urd & [fimg.alicdn.comftps/TB 1xK

e Center

Position

Label Offset

Label Offset




Data Source Type

Ctatic Data

o -
"value™: 19,
"info": "Description ini
"type”: "error”,
"name”: "Point 9"

“dotid":
“lat":
"Ing":
"value
"“info"™ -

Description ind
..t'ﬁpr L1 : "Dk..,
“name”: "Point 18"

“dotid":
“lat":

- Icon Options: Select this check box to use icons to display scatter plot points of
a custom style. You can set the following Icon parameters: the icon image, the
icon size, the icon position, and the label offset relative to the icon. If you do not
select this check box, scatter plot points are displayed as dots. Then you can set

the color, size, and outlines of scatter plot points. For more information, see Set

the default options.



Configure the data plane

¢ Scatter Layer

Scatter Data » Completed
Field Mapping Status

= Matched
Ing m Matched
type m Optional

info m Optional

- .
::l:: nlJ m Optional

value m Optional

Data Source Type

Ctatic Data

"dotid"”:

"lat":

"Ing":

"value"

"info"™:

“t:r'pE" .

"name": " 3
"rotationfngle™: 45

"dotid"”:
"lat":
"Ing":
"value"
"info"™:

Data Rlter: | AddF

lat : Set the latitude of the scatter plot point.

lng : Set the longitude of the scatter plot point.



type : Set the scatter plot point type. Then you can set the icon style of the

custom type of scatter plot points.

Note:
If no type is set for a scatter plot point or its type is not included in the types that
you have set, the system renders the scatter plot point according to the settings of
Default Options in the Configuration plane.
info :Set the message of the popup box displayed when the scatter plot point is
clicked.
iconURL : Set the URL of the custom scatter plot point icon.
value : Set the value of the scatter plot point. This field setting is related to the
MinValue Color, MaxValue Color, and NoData Color settings of Scatter Options in
the Configuration plane.
name :Set a name for the scatter plot point. This field is used when you set Label
Field in the Configuration plane to label the scatter plot point.
rotationAn gle :(Optional.) Set the rotation angle of the scatter plot point
icon. This field takes effects only if you select the Icon Options check box of Series
Options in the Configuration plane, and configure the icon settings (for example,

you can upload a custom icon image or set iconUrl in the data plane).

Configure the interaction plane

Select the Enable check box to enable the widget interaction function. With this
feature enabled, the system displays the callback value when you click a scatter plot

point. By default, the 1ng and 1lat fields are displayed. For more information, see

Configure callback IDs for ticker boards.
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Scatter Layer

<

= Interaction Events (#) Tutorial

~ Trigger Event When Point

I= Clicked Enable

Bind to Varable

@

Field Field Description

Longtitude
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6.9.5 Configure an animation bubbles layer
This topic describes how to configure an animated bubbles layer (a type of data point

layer) to display data across geographical locations on a map.
Prerequisites

The animation bubbles layer widget is added to the basic flat map and the widget

parameters are set. For more information, see Map container.



Configure the configuration plane

1/}

¢ Animation Bubbles Layer

Animation Type Breath
Animation

Range

Animation

Speed

Color Gradient

Range

Max Bubble

-
e

Min Bubble
Lze
w Bubble Type
Bubble Type2
St}’IE E:t:."f‘ 5

Type Filter

Value

Color Il #rBF320

- Animation Type: Set the type of animation for the bubbles. Available types are
Breath and Fading.



- Animation Range: Drag the slider or enter a value to set the size range of the
bubbles. This parameter setting takes effect only if you set Animation Type to
Breath.

- Animation Speed: Drag the slider or enter a value to set the animation speed of the
bubbles.

- Color Gradient Range: Drag the slider or enter a value to set the maximum color
depth of the bubbles. If you set the fading Animation Type, the bubble color fades
from the set color depth to transparency.

- Max Bubble Size: Drag the slider or enter a value to set the maximum bubble size
that indicates the maximum value specified by the value field in the data plane.
- Min Bubble Size: Drag the slider or enter a value to set the minimum bubble size
that indicates the minimum value specified by the value field in the data plane.
- Bubble Type: Click + or the Trash Can icon to add or remove a bubble type. Bubbles

of one type share the same bubble style and color.

- Style: Select a bubble style from the drop-down list. Seven bubble styles are

available.

- Type Filter Value: Set the bubble type value to filter bubbles. Then, you can set
the same Style and Color for the filtered type of bubbles.

Note:



The type of each bubble is specified by the type field of this bubble in the

data plane.

Animation Bubbles Layer

<

Animation Type Breath

«~ Bubble Type
¢ Bubble Typel
Mumbsi  yderabad

Il #00FFAS

Data Source Type

Ctatic Data

"Ing™: 114.3
"value™: 1
I!t':'pr Ll :

"lat”

Color: Set the color of the filtered type of bubbles. For more information, see

Configure item description.



Configure the data plane

—
=
—

< Animation Bubbles Layer

Bubble Data » Completed
Field Mapping Status

= Matched

= Matched
value = Matched
type = Matched

Data Source Type

Ctatic Data

"Ing": 114.38@ 3
"value": 1,
“type": 1

"lat™: 34
"lng": 11
"value":

“tFpE“: 2

"lat™: 23.9
"Ing": 11
"value":
“type": 1

Data Filter: | Add Filter

Auto Data Request: Every

ng : Set the longitude of the animated bubbles.

lat : Set the latitude of the animated bubbles.



value : Set the bubble value. The bubble size is determined by this parameter

setting, and the Max Bubble Size and Min Bubble Size settings in the configuration

plane.
type : Set the bubble type. This parameter setting is associated with the Type

Filter Value setting in the configuration plane.
Configure the interaction plane
No settings are required.
6.9.6 Configure a points heatmap layer

This topic describes how to configure a points heatmap layer (a type of data point

layer) to display data across geographical locations.
Prerequisites

The points heatmap layer child widget is added to the basic flat map and the widget

parameters are set. For more information, see Map container.
Configure the configuration plane

i/}

¢ Points Heatmap Layer

Layer Opacity

Min Opacity

~ Color Plate

Color 1

Color 2

- Layer Opacity: Set the overall layer opacity by dragging the slider or entering a
value.
- Min Opacity: Set the opacity of the center of each heat circle by dragging the slider

or entering a value.



- Radius: Set the radius value of the layer by dragging the slider or entering a value.
- Blur: Set the blur value of the layer by dragging the slider or entering a value.

- Color Plate: Set the colors that indicate the degrees of heat circle rings displayed.
Color 1 indicates the color of the outer ring. Color 5 indicates the color of the inner

ring. For more information, see Configure item description.
Configure the data plane

lat : Set the latitude of the layer.
lng : Set the longitude of the layer.
value : (Optional) Set the weight of the layer.

Configure the interaction plane

No settings are required.

6.9.7 Configure a line layer
This topic describes how to configure a line layer to indicates data points (for

example, railways) by using lines.
Prerequisites

The line layer child widget is added to the basic flat map and the widget parameters

are set. For more information, see Map container.

Configure the configuration plane

< Line Layer

~ Stroke Options

» Color

LineWidth

Dotted Line

» Interactive Options




Stroke Options
- Color: Set the values for MinValue Color, MaxValue Color, and NoData Color.

Bl MinValue Color indicates the color of the line that has the minimum value in

the value field.

B MaxValue Color indicates the color of the line that has the maximum value in

the value field.

Bl NoData Color indicates the color of the line that has no value in the value

field.

If the value indicated by a line is between the maximum value and the minimum
value, the color of the line is a gradient color calculated based on the value. For

more information, see Configure item description.

< Line Layer

~ Stroke Options

~ Color

MinValue RGBA(5, 96, 125,0 @

Color

MaxValue [l RGBA(D, 255, 240, @

Color

NoData Il RGBA(TT, 77,77,0 @

Color

LineWidth

Dotted Line

» Interactive Options

Data Source Type

Ctatic Data

L
"link id": 1,
walue": 1,
Tcolor™: “#ED3229"

[

"link id": 2,

"wvalue™: 1,

"color™: "#36B354"
I

"link id™: 3,

"walue™: 1,

"color™: "#FFD323"

'l




Note:
If the Color values in both the Configuration plane and the color field in the
Data plane are set, the Data plane value takes effect.
LineWidth: Set the line width by dragging the slider or entering a value.
Dotted Line: Select a line type from the drop-down list.

- Interactive Options

Hover: Enable or disable the hover function by clicking the Eye icon. You can
set the color and width of the line displayed for the hover effect. This effect is
displayed only when you preview the layer or after you release the layer.

Click FitBounds: Select this check box to enable the focus effect for the line.
After you enable this effect, the system automatically focuses the line that you
have clicked. The line focus effect is displayed only when you preview the layer
or after you release the layer.

FitBounds Padding: Set the fitbounds padding of lines by dragging the slider.
You must select the Click FitBounds check box before setting this parameter.
The padding setting is displayed only when you preview the layer or after you
release the layer.

Callback ID: Set the field for associating data between widgets. This filed must
be associated with the data of this widget, and you can only set one field for this

parameter.

Note:
This function is also added to the Interaction plane where you can set multiple
fields. Additionally, this function will be removed from the Configuration plane.

Therefore, we recommend that you upgrade the widget to the latest version.

Configure the data plane

The following two data sources are required: GeoJSON LineString data and Mapping

data.



e
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¢ Line Layer

« GeolS0ON LineStnng dat
=0 e » Completed

a

Field Mapping Status

s Configuration
Random S I
completed

Data Source Type

Ctatic Data

"type”: "Feature”,

"geometry”: {
"type™: "LineString
"coordinates™: [

Data Filter:

Auto Data Request: Every

» Mapping data » Completed

- GeoJSON LineString data: Set the GeoJSON LineString data. If you want to associate
this type of data with the mapping data, you must ensure that this type of data
has aunique 1link_id or id field. For more information, see http://geojson.org/

geojson-spec.html.

{


http://geojson.org/geojson-spec.html
http://geojson.org/geojson-spec.html

" type ": " FeatureCol lection ",

" features ": [

" type ": " Feature ",

" properties ": {
" link_id ": 1 ,
" name ": " test "

s

" geometry ": {
" type ": " LineString ",
" coordinate s ": [

L
109 . 4677734375 ,

41 . 4097758320 09565

1,
[
117 . 4658203124 9999 ,
36 . 3151251474 8051
1,
[
118 . 828125 ,
32 . 0639555946 604
1,
[
114 . 9169921875 ,
27 . 5667214304 09707
]
]
}
}
]
}
Note:

You can use the properties field to set messages in a pop-up box.



- Mapping data

Line Layer

<

¥ GeolSON LineString d

ata » Completed

«= Mapping data » Completed
Field Mapping Status
link_id = Matched

value = Matched

info = Optional

Data Source Type
Static Data
[
1
"link_id™: 1,

“value™: 1,
"color"™: "#ED322G"

"link_id™: 3,
“value™: 1,
"color”: "#FFD823"

Auto Data Request: Every

Second

- link_id :Set the ID by which to associate the mapping data with the GeoJSON
data.
- value : Set the line weight. Based on this field, the settings of MinValue Color,

MaxValue Color, and NoData Color in the Configuration plane take effect.



- info :Set the message for the pop-up box. If you do not set this field, the
message displayed in the pop-up box message is the content of the properties
field specified in the GeoJSON data.
- color :Set the fields that can be used to render the lines, such as color |,

weight ,and dashArray .

Data Source Type

Ctatic Data

[

1
"link id™: 1,

"walue™: 1,
) “color™: "#ED3229"
_I'J

"link id™: 2,

"walue™: 1,
"color™: "#36B354"

L
Ir
I,
L

Configure the interaction plane

Select the Enable check box to enable the interaction function. For more information,

see Configure callback IDs for ticker boards.

¢ Line Layer

w Interaction Events (@) Tutorial

rigger Event When Line .
Corked Enable

.
Is

Bind to Vanable

@

Field Field Description

link_id link_id Line Link Id




6.9.8 Configure a choropleth layer

This topic describes how to configure a choropleth layer on a map.

Prerequisites

The choropleth layer child widget is added to a map and the corresponding widget

parameters are set. For more information, see Map container.

Configure the configuration plane

i/}

< Choropleth Layer

~ Label

W #FFF

RGBA(D, 0, D, 0.85)

- Labels

Label Field: Set this field to the name of an area.

Color: Set the label color. For more information, see Color picker.

Shadow Color: Set the shadow color of the label. For more information, see Color
picker.

Font Family: Select a font for the label from the drop-down list.

[% Note:

Only a font that is installed in your system can be displayed accurately. If the
selected font is not installed in your system, the default font is displayed.

Font Size: Click + or -, or enter a font size value to set the font size for the label.

- Fill Color: Set the values for MinValue Color, MaxValue Color, and NoData Color.

For more information, see Color picker.

- Outline Options: Set the color and width of the outline of the choropleth layer.



- Interactive Options

Hover: Hide or show the hover effect by clicking the Eye icon.

Hover Color: Set the color that is displayed when the pointer is positioned
above a target area. For more information, see Color picker. Note that this effect is
displayed only when you preview the layer or after you release the layer.

Click FitBounds: Select this check box to enable the focus effect for the area.
After you enable this effect, the system automatically focuses on the area that
you have clicked. The line focus effect is displayed only when you preview the
layer or after you release the layer.

FitBounds Padding: Drag the slider or enter a value to adjust the displayed area
when you click an area. Set the fitbounds padding of areas by dragging the slider
or entering a value. The padding setting is displayed only when you preview the
layer or after you release the layer.

Callback ID: Set the field for associating data between widgets.

Note:
The callback ID function is also added to the Interaction plane where you
can set multiple fields. Additionally, this function will be removed from the
Configuration plane. Therefore, we recommend that you upgrade the widget to

the latest version.



Configure the data plane

- Geographical Boundaries: To use the GeoJSON-based boundary data in DataV,

follow these steps:

1. Click Choropleth Layer.

2. On the Data tab, click Geographical Boundaries.

3. Select API from the Data Source Type drop-down list.

4. Paste the GeoJSON API to the URL area, as shown in the following figure.

—
-

¢ Choropleth Layer

« Geographical Boundarie « Completed
s

Field Mapping Status

» Configuration
Random 9
completed

Data Source Type

APT

URL :

Configure callback parameter to URL, for
instance: http://apitest?value=:value

https://geo.datav.aliyun.
com/areas/bound/238180 full.

json

5. Publish the project to view the effect.



If you encounter label text offset during the configuration, you can:

- Check whether you are using the choropleth layer V0.2.4 or a later version. If

you are using an earlier version, delete this layer, and then add a new one.

- Check whether the data you obtained has been updated. If yes, use the latest
data.

- Modify the parameters:

1. Use geojson.io to add the customLabe 1Position parameter to the

GeoJSON API.

Add the customLabe 1Position attribute,suchas" customLabe
lPosition ": [ 112 . 500801 , 22 . 927694 ],tothe properties

parameter in the area where label text offset occurs.

1
“type”: "Feature”,
‘rroperties s |
Tadeode” 441204,
“rame”: "GYCL,
“center”: [
112, 460345,
23 027894
1,
“custemLabelPosition”: [
112, 500301,
22, B2TRO9d
1,
“childrenfium”: 0,
"lewel”: “district”,
“subFeatureIndex” : 4
“acroutes”: [
100000,
440001,
dd41 200
1,
“parent”: |
“adcode”: 441200



http://geojson.io/

2. Save the modified API to your server.

3. Click Choropleth Layer.

4. On the Data tab, click Geographical Boundaries.

5. Select API from the Data Source Type drop-down list.
6. Paste the JSON API to the URL area.



- Mapping Data: Customize the choropleth layer style by configuring the mapping

data. Data in the choropleth layer can be rendered first.

1. Click Choropleth Layer.
2. On the Data tab, click Mapping Data.
3. Select Static Data from the Data Source Type drop-down list, as shown in the

following figure.

+ Mapping Data s Completed

Field Mapping Status

» Matched
Successtully
s Matched
Successfully

area_id

value

info = Optional

Data Source Type

Ctatic Data

“area_id": "71eee8",
“"value™: 64

"area_id"
“valua":

“"area_id": "150000
"value™: 23

"area_id":
“valua":

Data filter:

Auto Data Request: Every

- area_id :The postal code of an area.



- value :The value of an area. The color of an area is determined by the

MinValue Color and MaxValue Color fields on the Configuration tab.

Note:
The color gradient can be calculated according to the value field on the
Data tab.
- dnfo :Optional. The information in the pop-up window.
4. Set the values for the color (line color), weight (line weight), dashArray

(dotted line), and fillColor (fill color) fields.

The corresponding areas on the map are rendered according to the values of

these fields. The value of the fillColor fieldcanbein red ,# fffooo ,and

rgba ( @, 256 , 0 , 0 . 5 ) format.
Configure the interaction plane

Trigger Event When Area Is Clicked: Select Enable to trigger an event when an area is
clicked. Specifically, when the target area is clicked, a request is triggered and data of

different areas is loaded.

When you click an area, the value of area_id is displayed automatically. For more

information, see Configure callback IDs for ticker boards.

6.9.9 Configure an isosurface layer
This topic describes how to configure an isosurface layer to convert vector point data
to a raster map. For example, you can display a national air quality map by using an

isosurface layer.
Prerequisites

The isosurface layer child widget is added to the basic flat map and the widget

parameters are set. For more information, see Map container.



Configure the configuration plane

< Isosurface Layer

Opacity

Render Type Linear
From Color Il #58F613
Middle Color #FF4300

End Color #FFDO00

Delhi

Jaipur  Lucknow
T anmedabad b S
Kolhata- " h
\ egfypbecd ) .
v il Classify Col
Count

« I nania
NFDINWURIAS r
L}

Opacity: Set the overall layer opacity by dragging the slider or entering a value.
Pixel Size: Set the pixel size of each square of the raster graphic by clicking + or -,
or entering a value. The value range of this parameter is 1 to 10. A smaller pixel
size indicates a clearer isosurface layer, but takes longer to render compared with a
greater a greater pixel.

Weight: Set the weight of the interpolation point by which it affects its surrounding
points by dragging the slider or entering a value. The value range of this parameter
is 0.5 to 3. A greater weight value indicates that the interpolation point significantly
affects its surrounding points and achieves a better layering effect, but takes a

longer time to render compared with a lower weight value.



- Render Type: Select a layer render type from the drop-down list. Available types

are Linear and Piecewise.
- Linear

B From Color: Set the color of the interpolation point that indicates the
minimum value in the data source. For more information, see Configure item
description.

B Middle Color: Set the color of the interpolation point that indicates the
median value in the data source. For more information, see Configure item
description.

B End Color: Set the color of the interpolation point that indicates the
maximum value in the data source. For more information, see Configure item
description.

B Break Value: Set the break value for linear rendering by dragging the slider
or entering a value. Based on the specified break value and the value range
in the data source, DataV obtains the interpolation point of the middle value.

The color of this interpolation point is the Middle Color that you set.

Note:
This parameter setting takes effect only if you set Render Type to Linear.

B Classify Color Count: Set the number of classification of interpolation point
by dragging the slider or entering a value. Based on the Classify Color Count
value that you set and the value range in the data source, DataV uses
different colors to classify interpolation points. A greater Classify Color Count
value indicates a better interpolation effect, but takes a longer time to render
compared with a lower Classify Color Count value.

- Piecewise

B Default Color: Set the default color of interpolation points. If the value

indicated by an interpolation point is not included in the Break Value that



you set, this parameter takes effect. For more information, see Configure item

description.

B Piecewise: Add or remove a break by clicking + or the Trash Can icon on the

right.

B Break Value: Set a break by dragging the slider or entering a value. You
can set this parameter according to the value range that is indicated by all
interpolation points.

B Break Color: Set the color of the interpolation points that indicate values

included in a Break. For more information, see Configure item description.
Configure the data plane

Clip GeoJSON data

¢ Isosurface Layer

« Clip GeoJSON data = Completed

Field Mapping Status

figuration
Random <
ompleted

Data Source Type

Static Data

": "Feature”,
I
L

"MultiPolygon”,
Data Filter:

Auto Data Request: Every Second

" ) Interpolation Points Dat
= N
a

= El

The Clip GeoJSON data settings specify the area of interpolation points that need to
be rendered. For example, in the preceding figure, the Clip GeoJSON data settings
specify the China map displayed in colors.



- Interpolation Points Data

= Interpolation Points D
ata

» Completed

Field Mapping Status
= Matched
= Matched
value = Matched

Data Source Type

Ctatic Data

Auto Data Request: Every

Second

- 1lng :Set the longitude of the interpolation points.

- lat :Set the latitude of the interpolation points.

- value :Setthe interpolation point value. Based on the value and the
rendering settings in the Configuration plane, DataV adjusts the layer rendering

effect.
Configure the interaction plane

No settings are required.



6.9.10 Configure a grid heatmap layer
This topic describes how to configure a grid heat map layer to display the density of

points scattered on a map.
Prerequisites

The grid heatmap layer child widget is added to the basic flat map and the widget

parameters are set. For more information, see Map container.
Configure the configuration plane

]

¢ Grid Heatmap Layer

Cell Size
Classify Colo
Count

From Colo =
End Color BLUE

Border Width —8&

Border Color

Ahmedabad

Mumba  Hyderabad

- Cell Size: Set the icon size by dragging the slider or entering a value. Based on the
grid size that you set and the value range of the data, DataV calculates the number
and location of all icons.

- Classify Color Count: Set the number of color gradient levels (levels between From
Color and End Color) by dragging the slider or entering a value. The color of each
icon is displayed according to the point distribution.

- From Color: Set the color of the icon where the color distribution of the points
starts. For more information, see Configure item description. Based on the latitude and
longitude of the points, DataV calculates the icon where the points are located. The
icon that has the greatest number of points is the start icon.

- End Color: Set the color of the icon where the color distribution of the points

ends. For more information, see Configure item description. Based on the latitude and



longitude of the points, DataV calculates the icon where the points are located. The

icon that has the least number of points is the end icon.

Note:
The color of the icons between the start icon and the end icon is determined by

the Classify Color Count, From Color, and End Color that you set.
- Border Width: Set the icon border width by dragging the slider or entering a value.
- Border Color: Set the icon border color. For more information, see Configure item

description.



Configure the data plane

—
=
_—

< Grid Heatmap Layer

Points Data = Completed

Field Mapping Status
= Matched

= Matched

Data Source Type

Ctatic Data

Data Filter:

Auto Data Request: Every

- Ing: Set the longitude of the points.
- lat: Set the latitude of the points.

Configure the interaction plane

No settings are required.



6.9.11 Configure a flying routes layer
This topic describes how to configure a flying routes on a map to display the Origin-
Destination (OD) data by using dynamic lines. Typically, a line in a flying routes layer

indicates the association between two places, such as logistics and transactions.
Prerequisites

The flying routes layer child widget is added to the basic flat map and the widget

parameters are set. For more information, see Map container.

Configure the configuration plane

- Fly Frequency: Click + or -, or enter a value to set the frequency at which flying
routes fly out.

- Fly Speed: Drag the slider or enter a value to set the flight speed of flying routes.
The value range of this parameter is 1 to 10.

- Path Points: Drag the slider or enter a value to set the number of path points for
flying routes. The value range of this parameter is 100 to 4000.

- Step: Drag the slider or enter a value to set the length of flying routes. The value
range of this parameter is 10 to 120.

- Height Ratio: Drag the slider or enter a value to set the height ratio of flying routes.

The value range of this parameter is 0.5 to 5.

1

< Flying Routes Layer




- Flying Style Options

- From Color: Set the color of the starting points for flying routes. For more
information, see Configure item description.

- End Color: Set the color of the destinations for flying routes. For more
information, see Configure item description.

- Flare Color: Set the flare color of flying routes. For more information, see
Configure item description.

- Line Width: Drag the slider or enter a value to set the width of flying routes. The
value range of this parameter is 0.01 to 10.

- Flare Width: Drag the slider or enter a value to set the flare width of flying

routes. The value range of this parameter is 0.01 to 20.

- Gradient Ratio: Drag the slider or enter a value to set the gradient ratio of flying
routes. The value range of this parameter is 0.01 to 10.

- Bubble Color: Set the bubble color of flying routes. For more information, see
Configure item description.

- Bubble Radius: Drag the slider or enter a value to set the bubble radius of flying
routes. The value range of this parameter is 0 to 30.

- Bubble Speed: Drag the slider or enter a value to set the bubble speed of flying

routes. The value range of this parameter is 0.1 to 1.
Configure the data plane

from : Set the latitude and longitude for the starting point the flying route, and
use a comma (,) to separate the latitude and longitude.
to :Set the latitude and longitude for the destination of the flying route, and use a

comma (,) to separate the latitude and longitude.
Configure the interaction plane

No settings are required.



6.10 3D Globe (2018)
6.10.1 Earth container

3D Globe (2018) is a container that holds a 3D earth model. You can add layers such as
an earth layer, an atmosphere layer, and flying routes layers to this container. You can

show real-time data across the world from multiple perspectives and in diverse forms.
Style
- Child Management

- Add a Child Widget: Click the + icon next to Child Management, select a child
widget, and then click Add a Child Widget. The added child widget is displayed

in Child Management.



3D Globe (2018)

Child Management

Earth Layer  ambient Light@0.0.5

Ambient Li
Basic Attrib Atmosphere Layer@0.0.5
Directional Light@0.0.5
InfoWindow Layer@0.0.7
Flying Route Layer@0.0.11
Position

Earth Layer@0.0.7

Heat Line Layer@0.0.6

Scanner Layer@0.0.5
Scatter Layer@0.0.14
Rendering
Mode
¢ Background Settings

» Viewpoint Positioning

Rotation Speed D

Map Interaction

- Copy, edit, or delete a child widget: Move the mouse over the added child widget
and click next to the child widget name to copy the child widget. Click H

to edit the name of the child widget. Click u to delete the child widget.

- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Rendering Mode: You can select Advanced mode to configure advanced graphic

effects.

Basic Atinbutes

Position

Others

Rendering Advanced Mode

Nli]d e

» Advanced Rendering Mode

Antialiasing None

Bloom

Threshold

Bloom Radius

Blcom

Intensity

¢ Background Settings

» Viewpoint Positioning
Rotation Speed 0

Map Interaction

Advanced Rendering Mode:



- Antialiasing: Select SMAA Antialiasing, FXAA Antialiasing, or None in the drop-
down list. The default value is None.

- Bloom Threshold: Drag the slider or enter a value to modify the threshold of the
bloom. The range of the value is 0-1.

- Bloom Radius: Drag the slider or enter a value to modify the radius of the bloom.
The range of the value is 0-1.

- Bloom Intensity: Drag the slider or enter a value to modify the intensity of the
bloom. The range of the value is 0-1.

- Background Settings: Modify the background color of the 3D earth. For more

information, see Color Picker.

- Viewpoint Positioning: Drag the sliders or enter values to modify your viewpoint.

The viewpoint contains four parameters: Field of View, Latitude, Longitude, and



Distance. Configure these parameters based on the principles of the camera to

adjust the view of the earth.

- Field of View: The visual angle of the camera. The earth becomes smaller if you

increase the visual angle.

VR = J—.

Camera position

perspective

A

height

e RIS 1o L

¥

far

K

Top view

- Latitude and Longitude: The latitude and the longitude of the viewpoint of the
camera on the earth.

- Distance: The distance between the camera and the earth. The earth becomes
smaller if you increase the value.

- Rotation Speed: Enter a value or click + or - to modify the rotation speed of the

earth. The range of the value is 0-10. The earth stops rotation if the value is set to 0.



- Map Interaction: Select the check box to enable the map interaction feature. With
this feature, you can create interaction events in the preview page or the published
page. For example, you can create an event that is triggered by clicking. Clear the

check box to disable the map interaction feature.
Data
No data configuration is required for this widget.
Interaction
This widget is not bound to any events.

6.10.2 Ambient Light

You can simulate the ambient light around the earth by using the ambient light layer.

This layer shows the colors and other effects of the ambient light.
Style

- Ambient Light Intensity: Drag the slider or enter a value to modify the intensity of

the ambient light.



- Color: Modify the color of the ambient light. For more information, see Color Picker.

¢ Ambient Light

Ambient Light —#
Intensity 0

Color Wl #FFFFFF

Ambient Light

<

Ambient Light —
Intensity 0

Color

Data
No data configuration is required for this widget.
Interaction

This widget is not bound to any events.



6.10.3 Choropleth Layer

Style

You can present area boundaries and render area styles based on data in the GeoJSON

format by using the choropleth layer.

- Display: Select to display the choropleth layer. Clear the check box to hide the
choropleth layer.

- Height: Drag the slider or enter a value to modify the distance between the
choropleth layer and the earth layer.

- Outline Only: Select the check box to display only the outlines. Clear the check box

to highlight the areas. You can configure the styles of the areas and the outlines.

< Choropleth Layer

sx

Height

Qutline Only
Minimum
Maximum
None

Fill Opacity

Outline Color [l #ETEESS

Outline Opacity

Outline

Thickness

- Minimum: Modify the color of the area whose value field in the data tab is set
to the minimum value. For more information, see Color Picker.

- Maximum: Modify the color of the area whose value field in the data tab is set
to the maximum value. For more information, see Color Picker.

- None: Modify the color of the area whose value field in the data tab is not
specified. For more information, see Color Picker.

- Fill Opacity: Drag the slider or enter a value to modify the opacity of the
highlighted areas.



Data

- Outline Color: Modify the color of the outlines. For more information, see Color

Picker.

- Outline Opacity: Drag the slider or enter a value to modify the opacity of the

outlines.

- Outline Thickness: Drag the slider or enter a value to modify the width of the

outlines.

- Geographical Data : Customize the geographical data to define an area at the

choropleth layer. The format of the data is GeoJSON. For more information about

the format and how to obtain data, see Map Data format.



- Choropleth Layer :

—
_—

¢ Choropleth Layer

» Geographical Data » Completed
« Choropleth Layer » Completed

Field Mapping Status
adcod » Matched
Successfully

» Matched

value ~
Successfully

Data Source Type

Ctatic Data

"adcode™:
"wvalue®™: @.

"adcode™:
"wvalue®™: @.

"adcode™:
"value™: 8

"adcode™:
"wvalue®™: @.

JLJ
r

Data filter:

Auto Data Request: Every Second

- adcode :The address code (adcode) of the area.



- value :The value of the area. The color of an area is determined by the

Maximum and Minimum fields in the style tab and the value field in the data tab.

@ Note:

The value field of an area determines where the color of the area is located in

the color gradient.
Interaction
This widget is not bound to any events.
6.10.4 Atmosphere Layer

You can simulate the atmosphere that surrounds the earth by using the atmosphere

layer. This layer shows the color and other effects of the atmosphere.

Style

< Atmosphere Layer

Atmosphere

- Display: Select to display the atmosphere that surrounds the earth. Clear the check
box to hide the atmosphere.

- Atmosphere Color: Modify the color of the atmosphere. For more information, see
Color Picker.

- Atmosphere Opacity: Drag the slider or enter a value to modify the opacity of the
atmosphere.

- Atmosphere Intensity: Drag the slider or enter a value to modify the blurring of the

atmosphere. The atmosphere becomes blurred if you increase the value.



- Atmosphere Scale: Drag the slider or enter a value to modify the size of the color

ring that represents the atmosphere.

Data

No data configuration is required for this widget.
Interaction

This widget is not bound to any events.
6.10.5 Directional Light

Directional Light simulates a light that emits parallel rays to the globe.
Style

i

¢ Directional Light

Light Intensity u
1] 1.07

Color Il #FFFFFF
X Position u

-2000 61446

¥ Position

Z Position

- Light Intensity: Drag the slider or enter a number manually to set the light
intensity of the directional light layer.
- Color: For more information about how to adjust the light color of the directional

light layer, see Color selector.

- X Position/Y Position/Z Position: The coordinate formed by the values of these
three properties determines where the light is directed. Drag the sliders or enter

numbers manually to adjust the direction of the light.
Data

Data configuration is not required for the component.



Interaction
The component does not have any interaction events.

6.10.6 InfowWindow Layer

InfoWindow Layer shows detailed information based on geographic locations in the

form of floating windows on the page of a project.
Style

{7}

< InfoWindow Layer

B=

Height

Opacity

- Show: Select the Show check box to show the info window layer. Clear the check
box to hide the info window layer.

- Height: Drag the slider or enter a number manually to adjust the height of the info
window layer from the surface of the globe.

- Scale: Drag the slider or enter a number manually to adjust the size of the info
windows.

- Opacity: Drag the slider or enter a number manually to adjust the opacity of the

info windows.



¢ InfoWindow Layer

Info Window s Completed

Field Mapping Status

= Matched
Successfully

= Matched
Successtully

lat

Ing

conten

; = Optional

Data Source Type

Ctatic Data

"lng": 135,

"lat™: 34,

"content":
"width":
"height": 35E
"title": "frE@1”,
"titleFontSize"™: 45,
"titleColor™: "#fbf324
"content”: "Content",
"contentColor™: "#288"
"contentFontsize™: 48
"paddingleft™:
"paddingRight™:
"paddingTop”: 118,
"fontFamily": "Micr‘o5r|[

T =x T EE (1]

Data filker:

Auto Data Request: Every

lat :The latitude of the location at which an info window is located.

lng : The longitude of the location at which an info window is located.




content :The text shown in an info window. The content property contains the

following properties.

width : The width of an info window.

height : The height of an info window.

- title :Thetitle of an info window.

- titleFontS 1ze :The font size of the title.

- titleColor :The color of the title.

- content : The body content of an info window.

- contentCol or :The color of the body content.

- contentFon tSize :The font size of the body content.

- paddingLef t :The space between the body content and the left border of an
info window.

- paddingRig ht :The space between the body content and the right border of
an info window.

- paddingTop : The space between the body content and the top border of an
info window.

- fontFamily : The font of the title and body content. Specify a font that has

been installed on your operating system. If the specified font is not on your

system, the default font is selected.

bgImgUrl : The background image of an info window.
Interaction

The component does not have any interaction events.



6.10.7 Flying Route Layer
Flying Route Layer uses lines to visualize origin-destination (OD) data, representing

the connection between two locations such as logistics and trades.
Style

i1

< Flying Route Layer

show
Flying Route

Radius

Flying Route
Length

Flying Route
Speed 0.0001

Flying Route
Height

Flying Route
Arc

Flying Route
Opacity 0

Default Color [l #E7EES8

~ Flying Route Type

< Flying Route Tyg »

type2

Il #E7EESE

- Show: Select the Show check box to show the flying route layer. Clear the check box
to hide the flying route layer.

- Flying Route Radius: Drag the slider or enter a number manually to adjust the
radius of the scanner layer.

- Flying Route Length: Drag the slider or enter a number manually to adjust the
length of the flying lines.

- Flying Route Speed: Drag the slider or enter a number manually to adjust the
moving speed of the flying lines.

- Flying Route Height: Drag the slider or enter a number manually to adjust the
height of the flying route layer from the surface of the globe.

- Flying Route Arc: Drag the slider or enter a number manually to adjust the

curvature of the flying lines.



- Flying Route Opacity: Drag the slider or enter a number manually to adjust the
opacity of the flying lines.

- Default Color: If the type of a flying line in the data source is not contained in the
Flying Route Type property, then the default color is rendered for the flying line.
For more information about how to modify the default color, see Color selector.

- Flying Route Type: The property contains the Type property and the Color
property. The values of these two properties can be considered as the elements of
two arrays. The values of the type properties for each flying route type are a subset
of the values of the type properties that are specified for each flying line in the

data source. If the type ofaflyingline in the data source is not included in the



values of the type properties contained in the Flying Route Type property, then the

default color is rendered for the flying line.

« Flying Route Type + &

Flying Route Typ ¥

type type2

Color Il #c7EE9s




—
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¢ Flying Route Layer

Flying Route s Completed

Field Mapping Status

» Matched
Successfully
» Matched
Successfully
» Matched
Successfully

from
to
type

Data Source Type

Ctatic Data

“"to": "113.911722,38.74¢
!lt}ﬂpE" : 'It}fpezl'

“from":
!ltDll:
“"type”: "typel

"from": "117.428724,41.:
“"to": "117.427149,26.42¢
!lt}ﬂpE" : 'It}fpezl'

[0 Manr anec—anes - F

Data filter:

Auto Data Request: Every

Data

from : The start point of a flying line specified by the longitude and the latitude,

which are separated by an English comma.



to : The end point of a flying line specified by the longitude and the latitude,
which are separated by an English comma.
type :The alias of the color of a flying line. It is used in combination with the
Flying Route Type property in the Style pane.
Interaction

The component does not have any interaction events.

6.10.8 Heat Line Layer

Scanner Layer is used to draw line elements on the positions of the globe, which are

corresponding to geographic locations.
Style

171

< Heat Line Layer

Display
Dotted Line
Height —a

0

Maximum —a

Width 01

Gradient Speed u
0 0.0049 0.01

Color for Il #FFD666
Minimum

Color for

Maximum

Maximum |

Transparency ~ 0.001 06479 1

- Show: Select the Show check box to show the heat line layer. Clear the check box to
hide the heat line layer.

- Dotted Line: Select the Dotted Line check box to show the heat lines in the form of
dotted lines.

- Height: Drag the slider or enter a number manually to adjust the height of the heat

line layer from the globe.



Data

- Maximum Width: Drag the slider or enter a number manually to adjust the

maximum width of the heat lines. Specify the width of the heat line through setting

the value of the value property in the data source.

- Gradient Speed: Drag the slider or enter a number manually to set the flickering

speed of the heat lines. The greater the value, the higher the speed.

- Color for Maximum: For more information about how to adjust the color of the

heat line that is corresponding to the value property that has the greatest value,

see Color selector.

- Color for Minimum: For more information about how to adjust the color of the heat

line that is corresponding to the value property that has the smallest value, see

Color selector.

- Maximum Transparency: Drag the slider or enter a number manually to adjust the

maximum transparency of the heat lines. The transparency of each heat line is

based on the corresponding value of the value property in the data source.

The component data is in GeoJSON format. For more information about data formats
and data acquisition, see Map Data format. Values of the value properties for each

line can be configured in the properties properties.



—
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¢ Heat Line Layer

Heat Line Layer » Completed

Field Mapping Status

= Configuration
Random
completed

Data Source Type

Static Data

"type": "FeatureCollection’
"features™: [
;
{
"type": "Feature”,
"geometry”: {
.
)
"properties”:
"value™: 1
“name”: "Chilna->Thai
"id": 1

=

=

[ o

-

Data filter:

Auto Data Request: Every Second

il
|:| Note:
The range of the hexadecimal color values is calculated based on the range of values

of the value propertiesin the data source.
Interaction

The component does not have any interaction events.



6.10.9 Scanner Layer
Scanner Layer simulates the dynamic effects of scanning lines by looping through

texture animation.

Style

¢ Scanner Layer

Show
Loop
Color
Texture Url

Opacity

X-Axis Rotation

Y-Axis Rotation

Z-Axis Rotation

31415 04014 31415

- Show: Select the Show check box to show the scanner layer. Clear the check box to
hide the scanner layer.

- Loop: Select the Loop check box to loop through the scanning animation.

- Color: For more information about how to modify the color of the scanner layer,
see Color selector.

- Texture Url: Set the texture style of the scanner layer by entering the URL of the
texture image.

- Opacity: Drag the slider or enter a number manually to adjust the opacity of the
scanner layer.

- Speed: Drag the slider or enter a number manually to adjust the speed of the
animation for the scanner layer.

- Radius: Drag the slider or enter a number manually to adjust the radius of the

scanner layer.



Data

- X-Axis Rotation/Y-Axis Rotation/Z-Axis Rotation: Drag the sliders or enter numbers

manually to adjust the three-dimensional coordinate, which represents the center

of the scanner layer.

Data configuration is not required for the component.

Interaction

The component does not have any interaction events.

6.10.10 Scatter Layer

Style

Scatter Layer shows the data information corresponding to the geographic location in

the form of dots.

- Show: Select the Show check box to show the scatter layer. Clear the check box to

hide the scatter layer.

- Height: Drag the slider or enter a number manually to set the height of the scatter

layer from the surface of the globe.

- Pulse Speed: Drag the slider or enter a number manually to set the flickering speed

of the dots in the scatter layer.

- Opacity: Drag the slider or enter a number manually to set the opacity of the

scatter layer. The value is from 0 to 1.

- Data Classification: You can use the property to classify data into multiple grades

based on the values of the value propertiesin the data source. The value is from
2 to 7 (integer). Drag the slider or enter a number manually to specify the number
of data grades to classify. The property helps you avoid the issue of rendering that
is caused by the large difference between the minimum and the maximum values

of the value properties.

- Dot Size (Small To Large): Click the plus (+) sign or the trash can icon to add or

delete a type.

- Value: Enter a number manually or click the plus (+) /minus (-) sign to specify

the size of the dot corresponding to the type.

Notice:



The values of the property can be considered as elements of an array. Used in
combination with Data Classification, the values increase with the ordinals of
types. For example, if the value of Type 1 is set to 10, then the size of a dot with
a value of0to 10 in the data source is shown as the size a dot with a value of
10. If the value of Type 2 is set to 20, then the size of a dot witha value of11

to 20 is shown as the size of a dot with a value of 20. Assuming that the value of

Data Classification is set to 3, the size of a dot with a value greater than 20 is
shown as the size of a dot with the value of Type 3.

- Default Color: For more information about how to modify the default color, see

Color selector.

)
|:| Note:
If the type property of a dotin the data source is not contained in the Scatter

Type pane, then the default color is used for rendering the dot.

¢ Scatter Layer

-

Pulse Speed —a
0

Data

Classification 2

« Scatter Size(Small To Large)
4{pel Type 2 Type 3
Value 2

22 +

Default Color [l #FFCCCT

» Scatter Type




- Scatter Type: Click the plus (+) sign or the trash can icon to add or delete a type.

- type: The values of the type properties for each scatter type are a subset of the

values of the type properties that are specified for each dot in the data source.

- Color: For more information about how to modify the color for a scatter type,

see Color selector.

-

Note:
The values of the property can be considered as elements of an array. You can
configure colors for scatter types. A color is rendered for a dot based on its
type property specified in the data source. If the type property of a dot in the

data source is not contained in the Scatter Type pane, then the default color is

used for rendering the dot.

Scatter Type 2

type

Color Bl #1904A7

Data

Ing : The longitude of a dot.

lat : The latitude of a dot.

type :The type of a dot. It specifies the color of the dot corresponding to the
scatter type property in the Style pane.

value :The value of a dot. It determines the size of a dot in combination with the

Dot Size property in the Style pane.



—
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Scatter Layer

<

Scatter Layer s Completed
Field Mapping Status
= Optional

= Optional

» Matched
Successfully
» Matched
Successfully

type

value

Data Source Type

Ctatic Data

Data filter:

Auto Data Request: Every

Interaction

The component does not have any interaction events.



6.10.11 Scene Manager

Style

Scene Manager enables you to view the different parts of a globe by rotating and

zooming the camera.

- Enable: Select the Enable check box to enable the scene manager. Clear the check

box to disable the scene manager.

- Carousel Mode: Click the drop-down list and select the carousel mode as needed.

- Play once.

- Loop.

- Duration: Drag the slider or enter a number manually to adjust the duration of the

animation for each scene. The value is from 0 to 30000. The unit is in milliseconds.

If the values of the duration properties in the data source are specified, then the

value of the Duration property in the Style pane is not applicable.

- Delay: Drag the slider or enter a number manually to adjust the interval between

the animations for scenes. The value is from 0 to 30000. The unit is in milliseconds.

If the values of the delay properties in the data source are specified, then the

value of the Delay property in the Style pane is not applicable.

- Callback ID: Sets the callback ID of the component. The value of a callback

ID (similar to a parameter variable) is passed to other components when the
animation for a scene ends. A callback ID specifies the field that is used to
implement filter interactions among components. The field must be contained in

the data source.



i/}

< Scene Manager

Enable
Carousel Mode  Loop

Duration

Callback ID

Data

name : Specifies the name of the scene.

position :Specifies the coordinate of the scene, the field of view of the camera,
and the distance to the camera. The position property includes four properties:

fov (camera field of view), lat (latitude), 1ng (longitude), and distance
(camera distance).

duration : Specifies the duration of the animation for the scene.

delay :Specifies the time interval between animations for the scenes.



—
-

¢ Scene Manager

Scenario Manager s Completed

Field Mapping Status

= Matched
name
Successfully
positio s Matched

n Successfully

durati S
= Optional
on

delay = Optional

Data Source Type

Ctatic Data

"id": "1",

"name”: "beijing”,

"position™: {
"fov":

LN

I
"duration™:
"delay”:

"id": "2",
"name”: "shanghai”,
"position™: {

"o -

Data filter:

Auto Data Request: Every Second




Interaction

Enable: Select the Enable check box to enable interactions among the components.
You can configure interactions in Scene Manager to pass the value of a callback ID

when a scene ends. The default callback ID is the id property in the data source.

For more information, see Configurations for component callback IDs.

Scene Manager

{

~ Bound Event () Tutorial

~ Fired When Carousel Is

Completed Enable

Field Bound Varable (Z)Field Description

Area Link ID




6.10.12 Sky Box Layer
Sky Box Layer provides users with an immersive experience by creating three-

dimensional box models with texture applied on each surface.

Style

Sky Box Layer

<

Duplicate
Image Count

on § Axis
Duplicate

Image Count

on T Axis

Size |}

10000 10000

50000



- px/nx/py/ny/pz/nz: These six properties specify the texture for each surface of

the box model by the URLs as shown in the following figure. Enter the URLSs of the

texture images manually to set the style of the box model.

- Duplicate Image Count on S Axis : Drag the slider or enter a number manually to

adjust the number of duplicate texture images along the horizontal axes.

- Duplicate Image Count on T Axis : Drag the slider or enter a number manually to

adjust the number of duplicate texture images along the vertical axis.

- Size: Drag the slider or enter a number manually to adjust the size of the texture

images.
Data
Data configuration is not required for the component.
Interaction

The component does not have any interaction events.



6.10.13 Trajectory Layer

Style

Trajectory Layer simulates the effect of a trajectory by showing the process of

rendering the line that connects dots.

- Show: Select the Show check box to show the trajectory layer. Clear the check box

to hide the trajectory layer.

- Height: Drag the slider or enter a number manually to adjust the height of the

trajectory layer from the surface of the globe. The value is from 0.1 to 10.

- Length: Drag the slider or enter a number manually to adjust the lengths of the

trajectories. The value is from 0 to 1.

- Trajectory Frequency: Drag the slider or enter a number manually to adjust the

time interval of repeated movements for a trajectory. The value is from 0 to 1.

- Speed: Drag the slider or enter a number manually to adjust the speed of the

movement for a trajectory. The value is from 0 to 0.05.

- Color: For more information about how to adjust the color of trajectories, see Color

selector.

- Opacity: Drag the slider or enter a number manually to adjust the opacity of the

trajectories. The value is from 0 to 1.

- Data Classification: Drag the slider or enter a number manually to specify the

number of data grades to classify. The property helps you to avoid the issue

of rendering that is caused by the large difference between the maximum and
minimum value of the value properties. You can use the property to classify
data into multiple grades based on the values of the value properties under the

properties properties in the data source. The value is from 2 to 7 (integer).



< Trajectory Layer

Display

Height

Trajectory

Frequency

Speed

Il #FFFD49

—
0 0.2

Data —a

Classification

» Trajectory Size(Small To Large))

- Trajectory Size (Small To Large): Click the plus (+ ) sign or the trash can icon to

add or delete a type.

- Trajectory Width: Enter a number manually or click the plus (+) /minus ( -)

sign to specify the width of the trajectories corresponding to the type.

@ Notice:

The values of the properties can be considered as the elements of an array. Used
in combination with Data Classification, the values increase with the ordinals
of the types. For example, if the value of Type 1 is set to 10, then the size of a
dotwitha value of0to 10 in the data source is shown as the size a dot with a
value of 10. If the value of Type 2 is set to 20, then the size of a dot witha value

of 11 to 20 is shown as the size of a dot with a value of 20. Assuming that the



value of Data Classification is set to 3, the size of a dot witha value greater

than 20 is shown as the size of a dot with the value of Type 3.
= Trajectory Size{Small To Large))

Type 2 Type 3

Trajectory D.08
Width




Data

e
—_-—

¢ Trajectory Layer

Trajectory Layer = Completed

Field Mapping Status

= Configuration
Random i I
completed

Data Source Type

Ctatic Data

type”: "FeatureCollection”
features™: [
{
"geometry™: {
“type”: "LineString”,
"coordinates™: [
]
_I-J
"type": "Feature”,
"properties”: {
"destinationid”: "13€
llidll: .:-‘
"value": 12,
"originid": “"11@e8",

|
J
L
'
-

Data filter:

Auto Data Request: Every Second

The component data is in GeoJSON format. For more information about data formats

and data acquisition, see Map Data format.

geometry : Specifies the value of the type propertytobe LineString .



coordinate s :Specifies multiple coordinates, which are formed by longitudes

and latitudes.

116.235351562499
39.9/771200984396

120.366210937499
31.2409853/7/80213

115.400390625,
25.08559889/7064/

properties : Specifies the values of the originid (representing start points)
properties and the destinatio nid (representing end points) properties in
the adcode format. Specifies the values of the value properties. The value

property determines the width of a trajectory in combination with the Trajectory

Size property in the Style pane. The default value is 1.
Interaction
The component does not have any interaction events.
6.10.14 Earth Layer
Earth Layer is the basic spherical component of a 3D globe.
Style

- Show: Select the Show check box to show the earth layer. Clear the check box to
hide the earth layer.



- Map Type: Click the drop-down list and select the style of the map for the earth

layer.
- Terrain
- Satellite

- Particle

- Administrative Regions

- Customized
il
= | Note:

After selecting Customized as the map type, you can drag an image to the

dashed box or copy and paste the URL of an image in the link box.
Map Type Customized

Customized & hitps:/fimg.alicdn.com/ts/TE

Ma P

- Scale: Drag the slider or enter a number manually to scale the sphere. The value is
from 1to 1.2.

- Light Intensity: Drag the slider or enter a number manually to set the light
intensity for controlling the brightness of the sphere. The value is from 0 to 10.

- Roughness: Drag the slider or enter a number manually to adjust the roughness of
the physically based rendering (PBR). The value is from 0 to 1.

- Metallic Effect: Drag the slider or enter a number manually to adjust the metallic
effect of the PBR material. The value is from 0 to 1.

- Unevenness: Drag the slider or enter a number manually to adjust the unevenness

of the PBR material. The value is from 0 to 1.



Earth Layer

<

Display

Map Type Temain

Metallic Effect

Data
Data configuration is not required for the component.
Interaction

The component does not have any interaction events.

6.11 Media

6.11.1 Image

You can add one or more images as background images for other widgets in a project.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Background Image: You can enter an image URL or drag an existing image to the

dashed line box. You can also set the image style by setting the img field in the

Data pane. If you have set the image style in both the Configuration and Data panes,

settings in the data pane will take effect.



- URL Config: If you have set a URL, when you click the image on the preview or
publish page, the page corresponding to the URL is displayed.

- URL: You can set the URL of the page to be displayed after you click the image.
You can also set the URL by setting the url field in the Data pane. If you have
set the URL in both the Configuration and Data panes, settings in the data pane
will take effect.

- Blank: If you select this option, when you click the image, the image is displayed

on a new tab page.

Background & hitps:fimg.alicdn.com/Afs/T

Image

« URL Config ®

URL

Blank

Data

img : (optional) image to be displayed. This image will replace the image set in
the configuration pane. If this field is empty, the system will display the image you
set in the configuration pane.

url : URL of the page to be displayed after you click the image. The URL you set

here will replace the URL set in the configuration pane.



—
—-—

Image

Single Image Interface s Completed
Field Mapping Status
img = Optional

Data Source Type

Ctatic Data

Interaction

This widget is not connected to any events yet.

6.11.2 Live stream player (RTMP)

You can add one or more live stream players (RTMP) to a project to play video streams

as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Video Stream URL: You can enter or paste a video stream URL as needed.

)
|:| Note:
You can set the video stream URL in the Configuration or Data pane. If you have
set the video stream URL in both the configuration and data panes, settings in the

Data pane will overwrite the settings in the Configuration pane.



- Video Stream Type: You can select a video stream type as needed.

- rtmp/mp4
- rtmp/flv
- Mute Playback: If you select this option, you can mute the video on the preview or

publish page. If you clear this option, you can play the video with sound.

i/}

Live Stream Player (RTMP)

Basic Attnbutes

Position

Video Stream

URL

Video Stream rtimp/mp4

Type

Mute Playback

Data

source : (optional) video stream URL, which corresponds to the Video Stream
URL in the configuration pane. If you set the URL in both the configuration and
data panes, the value of source takes effect.

type : (optional) video stream type, which corresponds to the Video Stream Type
in the configuration pane. If you set the type in both the configuration and data

panes, the value of type takes effect.



—
-

Live Stream Player (RTMP)

RTMP Player Interface s Completed
Field Mapping Status
source = Optional

t-,rpe L] [::Iptilj ﬂal

Data Source Type

Ctatic Data

i)
L L1 L1 TN 1]
source . »
"t:l.l'l':"-;'" . "
JL

]

Interaction
This widget is not connected to any events yet.
6.11.3 Carousel images

You can add one or more carousel images to a project to display the image or images

in rotation.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Settings

- Font Family: Font of the displayed text. Only a font that is installed in your
system can be displayed accurately. If the selected font is not installed in your
system, the default font is displayed.

- Font Size: To change the font size of the displayed text, enter a value or drag the

slider. The value range is from 10 to 100.

Carousel Images

Basic Attnbutes

Position

Others

w Global Settings

Font Family & Microsoft YaHei

Font Size




- Animation

- Interval: To change the time interval between the display of two images, enter a

value, or click + or -. The unit is milliseconds.

- Speed: To change the transition speed of displaying images, enter a value, or

click + or —. The unit is milliseconds.

- Special Effects: animation effect.

Bl Scroll horizontally
Bl Scroll vertically
B Fade in and fade out

Bl Mosaic

= Animation

Interval (ms) 2500
Speed (ms) 500

Special Effects | Scroll Horizontally
Scroll Honzontally
» Image Scroll Vertically

Fade In and Fade Out

» Description

Mosaic




- Image

- Default Image: You can enter an image URL or drag an existing image to the
dashed line box. You can click the Delete icon to delete an image.

- Fill Type: To set the fill type, click the drop-down arrow and select the target
type.
B Stretch to fill the container
B Fill container

B Center
= Image

Default Image ¢ /fimg.alicdn.comfps/TB1ctt

Fill Type Fill Container




- Description: To display the image description, click the Eye icon.
- Background Color

B Fill Style: To set the fill color type, click the drop-down arrow and select the
target type.

B Solid

B Gradient
B Start Color: To change the start color of the gradient colors, see Color picker.
B End Color: To change the end color of the gradient colors, see Color picker.
B Angle: You can change the gradient angle as needed. The setting takes effect

only when Fill Style is set to Gradient. The gradient angle cannot be set when
Fill Style is set to Solid.

- Color: To set the font color of the displayed text, see Color picker.
- Font Weight: To change the font weight of the displayed text, click the drop-
down arrow and select the target font.

- Width: To change the width of the description bar, enter a value, or click + or -.

The unit is %.

- Height: To change the height of the description bar, enter a value, or click + or -.

The unit is %.

- Top: To adjust the spacing between the description bar and the top border, enter

avalue, or click + or -.

- Bottom: To adjust the spacing between the description bar and the top border,

enter a value, or click + or -.
- Align: To change the position of the description text in the description bar, click

the drop-down arrow and select the target position.

B Left
Bl Center
M Right



» Description

= Background Color

Fill Style Gradient

Start Color Il RGBA(19,68

End Color Il RGBA(231,229,2290
Angle 90 .
Color Il #FFFFFF
Font Weight normal

Width (%) y[11]

Height (%) 10

Top

Left

Align

- Pagination Bullets: To display the pagination bullets, click the Eye icon.

- Inactive color: To change the color of the pagination bullets corresponding to

the images that are not displayed, see Color picker.

- Active color: To change the color of the pagination bullet corresponding to the

displayed image, see Color picker.

= Pagination Bullets

Inactive Color [} #FFFFFF

Active Color [l #70B075




Data

url :image URL, which corresponds to the URL of the Default Image in the
configuration pane. If you have set the URL both in the configuration and data
panes, the value of url takes effect.

3

[:] Note:
Cross-domain settings are required for this image. If you do
not specify the HTTP, for example, //img.alicdn.com/tps/
TB1PH6EPXXXXXXbaFXXXXXXXXXX-4001-2251.png, the system will send a

request to the image according to the access HTTP of the project.
descriptio n :(optional) image description. You can add a pair of HTML a tags

to the value of this field.

Carousel Images

Carousel Interface s Completed

Field Mapping Status

= Matched

url .
Successfully

descri

. = Optional
ption P

Data Source Type

Static Data

" This is, the first picture descriptionii M

| I; L L = - M " = .
i ‘! 1\ descriptiom™—"This
/i \ "url™: “//img.alicdn.
' g
f L)
L]

. "description™: "This i
\ "url®: *//fimg.alicdn.

"description™: "This i
url®: T

Interaction

This widget is not connected to any events yet.



6.11.4 Video

The video widget allows you to add one or more MP4 videos to a project.
Configuration
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Video URL: You can enter the URL for the target MP4 video, for example,
xx.test.com/video.mp4, or set the URL in the Data pane. If you have set a video
URL in both the configuration and data panes, settings in the Data pane will
overwrite the settings in the Configuration pane.

- Autoplay: If you select this option, the video will be automatically played on the

preview or publish page.

Notice:
If you are using the latest Chrome browser, you need to enable the autoplay

function in Chrome. For more information, see https:/developers.google.com/web/

updates/2017/09/autoplay-policy-changes.

Method: Open the Chrome browser, enter chrome://flags/#autoplay-policy, and set
Autoplay policy to No user gesture is required.
- Loop: If you select this option, the video is played in a looped sequence on the
preview or publish page.
- Control Bar: If you select this option, the control bar is displayed at the bottom of

the preview or publish page.


https://developers.google.com/web/updates/2017/09/autoplay-policy-changes
https://developers.google.com/web/updates/2017/09/autoplay-policy-changes

- Empty Video Text: The system will remind you to edit the text for the widget when

there is no video.

Basic Attnbutes

Position

Others

Video URL @

Autoplay

Loop
Control Bar

Empty Video Please enter the video playbac

Text

Data

url : (optional) video URL. If you have set a video URL in both the Configuration

and Data panes, settings in the Data pane will overwrite the settings in the

Configuration pane.



MP4 Format Video = s Matching

Field Mapping Status

url = = Matching

Data Source Type

Ctatic Data

Interaction

This widget is not connected to any events yet.

6.12 Text
6.12.1 Carousel list Il

The carousel list IT widget allows you to customize the carousel list style, the

animation and display of content in the carousel list, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global

- Number of Rows: To change the number of rows in the carousel list, enter a
value, or click + or -.

- Loop: If you select this option, content in the carousel list will be automatically
displayed in a looped sequence on the preview or publish page. If you clear this
option, you cannot set the animation style.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Animation

- Mode: To set the animation mode, click the drop-down arrow and select the

target mode.

H Scroll all
B Scroll one by one

- Interval: To change the time interval between the display of two pages, enter a
value, or click + or -. The unit is seconds.

- Single Page Stop: If you select this option, content in the list is displayed only
once when there is only one page.

- Hide Empty Row: If you select this option, the row or rows with no data are hidden.



- Overflow Text Scrolling

- Scrolling: If you select this option, the overflow text will be automatically
scrolled on the preview or publish page.
- Animate Interval: To change the scroll duration, enter a value, or click + or -.

The unit is seconds.
= Global

Mumber of

Rows

Loop

Font Family @ Microsoft Yahei
Animation

Mode Scroll All

Interval (sec)

Single Page

StCrp

Hide Empty

Row

Owerflow Text Scrolling

Scrolling

Animate

Interval (sec)




- Header: To display the table header, click the Eye icon.

- Header Height: To change the proportion of the header in the list, enter a value
or drag the slider. The value range is from 0 to 100, and the unit is %.
- Background Color: To change the background color of the table header, see Color

picker.

- Text Style

B Text Align: To set the text alignment method, click the drop-down arrow and

select the target method.

B Align left
B Center alignment
H Align right
Bl Font Family: To set the font of the table header text, click the drop-down
arrow and select the target font. The default font is Microsoft YaHei.
H Font Color: To change the font color of the table header text, see Color picker.
B Font Size: To change the font size of the table header text, enter a value or
drag the slider. The value range is from 0 to 200.

B Font Weight: To change the font weight of the table header text, click the

drop-down arrow and select the target font weight.



~ Header

Header Height ——H
(%) 0

Background #ODBAFF

Color

Text Align Align Left

Font Family @ Microsoft YaHei
Font Color I #FFFFFF

Font Size |

Font Weight normal

- Row Options

- 0dd Rows Background: To change the background color of the odd rows, see

Color picker.

- Even Rows Background: To change the background color of the even rows, see

Color picker.

- Callback ID: You can set the values of a row as the callback IDs as needed.

+» Row Options

Odd Rows #003B51

Background

Even Rows #OA2TI2

Background

CallbackI




- Index: To display the index numbers, click the Eye icon.

- Background Color: To change the background color of the index numbers, see

Color picker.

- Width: To change the width of the index numbers, enter a value or drag the

slider. The value range is from 0 to 100, and the unit is %.

- Radius: To change the radius of the space occupied by the index numbers, enter
a value or drag the slider. The value range is from 0 to 100, and the unit is %.

- Text Style

H Font Color: To change the font color of the index numbers, see Color picker.

B Font Size: To change the font size of the index numbers, enter a value or drag

the slider. The value range is from 0 to 50.

B Font Weight: To change the font weight of the index numbers, click the drop-

down arrow and select the target font weight.

~ Index

Background #OOBAFF

Color

Width (%)

Radius (%)

Font Color Bl #FFFFFF

Font Size —n
0

Font Weight normal




- Columns: To add a label, click +. To delete a label, click the Trash icon.

@ Note:



A column is an array. You can set two or more columns as needed, and the Editor
traverses and renders the data through the column settings. To set data in a

specific format, sort the data manually.

Name in Data: You can set a name for the column as needed. The column name

of each label corresponds to a field in the data pane.

Displayed Name: You can customize the displayed name of a column as needed.
The displayed name of a label is displayed as the table header of a column in the

carousel list.

Width: To change the spacing between the labels, enter a value or drag the

slider. The value range is from 0 to 100, and the unit is %.

Data Type: To set the display format of the data, click the drop-down arrow and

select the target format.

B Text
B Image

Wrap Automatically: If you select this option, the label content is wrapped
automatically.

Text Style

B Text Align: To set the text alignment method, click the drop-down arrow and

select the target method.

W Align left
B Center alignment
B Align right
Bl Font Size: To change the font size of the label text, enter a value or drag the
slider. The value range is from 0 to 200.
B Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To change the font weight of the label text, click the drop-down

arrow and select the target font weight.



» Columns

Label 2 Label 3

Mame in Data

Displayed

Name &

Width (%)

Data Type

Wrap

Automatically

Text Align Align Left

Font Size -

Font Color [} RGBA(255,2552550 @

Font Weight normal

Data

- You can set the fields in the data pane as needed. Values of these fields must
correspond to the column name of each label set in Columns. You can add a pair of

HTML a tags to the value of these fields.



=
—_—

Carousel List II

Carousel Table Interface = Completed

Field Mapping Status

= Configuration
Random d
completed

Data Source Type

Ctatic Data

Area Tra‘ﬁcﬂﬂiﬂiﬂherhdﬂi:r 2B0; "China",

D China 588 H000000000000000000(

2 Amencd 688 XBO00O0000000000000K
L ]
3 Russia 688 ¥O0000000000000000! v

2 »
3 . tribute”:
& Germam688 XO00000000000000000

2 KyrgyzstoE8 000000000000000000
-
.

“attribute™:

Interaction

To enable the interaction function, select Enable. For more information, see Configure

callback IDs for ticker boards.



6.12.2 Table

The table widget allows you to customize the table style and data arrangement as

needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Table
- Responsive

B If you select this option, the display format of the data in the table is
automatically adjusted based on the table style and size when the table cells

do not expand beyond the table border.

« Table

The first One

Respons Ve

The Second One - .
= = =Horder Line

valuel . . .
Line Width 0

value?

Line Color - #5TD2FE

value3
w» Text Shyle

valued

- Font Fan'|i|'_-,-' @ Microsoft YaHei

B If you clear this option, the display format of the data in the table is no longer

automatically adjusted based on the table style and size.

- Table

The first One

Responsive

The Second One )
= e = « Border Wine

valuel
Ling# Width 0

Line Color Il #57D2FE

w Text Style

Font Fan'|i|'_-,-' @  Microsoft YaHei
- Border Line

B Line Width: To change the width of the border lines, enter a value, or click +
or -.
H Line Color: To change the color of the border lines, see Color picker.

- Text Style



H Font Family: To set the font of the displayed text, click the drop-down arrow
and select the target font. The default font is Microsoft YaHei.

» Border Line

Line Width

Line Color Il #57D2FE

Font Family & Microsoft YaHei

- Cell

- Margin

B Left and Right Margins: To change the left cell border margin and right cell
border margin, enter a value or drag the slider. The value range is from 0 to
50.

B Top and Bottom Margin: To change the height of a cell, enter a value or drag
the slider. If you select Responsive and the table cells do not expand beyond
the table border, then your setting will be applied to the table header, and
the height of the other cells will be automatically adjusted based on the table
style and size. The value range for the table height is from 0 to 50.

« Table Cell

~ Margin

| eft and Right ————#
Margins

Top and

Bottormn

Margin

- Table Header

- First Row As Table Header

B After you select this option, the first row of the table is styled as the table

header. You can only set the table header text after you select this option.



If you do not need to set the table header text, you can clear this option and

remove the label and value fields from the data pane.

B Text Style

B Font Color: To change the font color of the table header text, see Color
picker.

Bl Font Size: To change the font size of the table header text, enter a value
or drag the slider. The value range is from 0 to 100.

B Font Weight: To set the font weight of the table header text, click the

drop-down arrow and select the target font weight.

B Background Color: To change the background color of the table header,

see Color picker.

First Row for

The Second One Table Head

valuel w Text Style

Font Color - #FFFFFF

Font Size —a
0

Font Weight normal

Background #O0BAFF

Color

B If you clear the First Row As Table Header option, the first row of the table is
not styled as the table header.

- -
Support two kands of The first One
data format « Table Head

keyD The Second One
- First Row for

Lz " Table Head

¥ Column

» Row




+ Column

- Width Percentage: To change the width of the first row, enter a value, or click +
or —.
- Split Line
B Line Width: To change the width of the line between two columns, enter a
value, or click + or —.

B Split Line Color: To change the color of the line between two columns, see

Color picker.

- First Column
B Text Style

B Font Color: To change the font color of the text in the first column, see Color
picker.

B Font Size: To change the font size of the text in the first column, enter a
value or drag the slider. The value range is from 0 to 100.

B Font Weight: To set the font weight of the text in the first column, click the
drop-down arrow and select the target font weight.
B Background Color: To change the background color of the first column, see

Color picker.
B Text Align: To set the text alignment method, click the drop-down arrow and
select the target method.
B Align left
B Align right

B Center alignment



- Second Column: For more information about how to set the second column, see

First Column.

» Column

Percentage

Width (%)
Split Line

Line Width

Split Line Il #57D2FE

Color

First Column

Font Color [l RGBA(255,255,

Font Size

Font normal

Weight

Background

Color
Text Align Align Left

S econd Column




- Row

- Split Line
B Line Width: To change the width of the lines between the rows, enter a value,

or click + or —.

B Line Color: To change the color of the lines between the rows, see Color picker.
- 0dd-Even

B If you select this option, the rows are displayed in alternating colors. You can

configure the colors used to alternate between odd and even rows.

B Odd Row Color: To change the background color displayed in odd rows, see

Color picker.

B Even Row Color: To change the background color displayed in even rows,

see Color picker.

w Split Line

fine Width 4

Line Color Il #57D2FE

Odd-Even

©dd Row Il #FFC53D

Color

Even Row Il #23C636

Color

B If you clear this option, rows are no longer displayed in alternating colors.

The color displayed in the rows is the column background color.



Data

- -
Support two kinds of The first One
data format

« Split Line

Line Width 4 =

The Second One
Line Color Il #57D2FE

Odd-Even

label : (optional) text in the first column of the table header
value : (optional) text in the second column of the table header
il
[:] Note:
The values of 1label and value are displayed as the table header only when
you select First Row for Table Head.
The data format in the table is as follows: {"key in the first column":"value in the
second column",...}.
You can customize other fields as needed and display the actual data in sequence in

corresponding rows.



Key Table Interface
Field Mapping
label

value

Data Source Type

Static Data

I
i

"key2"

Interaction

This widget is not connected to any events yet.

6.12.3 Title

"key3™:

"label™:
“value ™ :

"key8":
"keyl™:

s Completed
Status
» Optional

» Optional

"Support two ki
“The Tirst One

"The Second One’
"waluel”,
value2"™,

The title widget allows you to customize the title style, the title text, and other options

as needed.
Style

- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.

- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Title Name: You can enter letters, numbers, and special characters for the title as

needed. You can also enter the title in the data pane.

-

Note:

- If you have set the title in both the Data and Configuration panes, the setting in
the data pane takes priority.

- The value of Title Name in the Configuration pane is used only when you delete

the value set for the value field in the Data pane.

- Text Style

- Font Family: To set the font of the title text, click the drop-down arrow and select
the target font. The default font is Microsoft YaHei.

- Font Size: To change the font size of the title text, enter a value, or click + or -.

- Font Color: To change the font color of the title text, see Color picker.

- Font Weight: To set the font weight of the title text, click the drop-down arrow
and select the target font weight.

- Text Align: To set the text alignment method, click the drop-down arrow and select

the target method.

- Align left

- Align right

- Center alignment
Title Name (&

= lext 5'[]!"[‘

Font Family @ Microsoft YaHei

Font Size

Font Color I #FF

Font Weight normal

Text Align Center Alignment




- Hyperlink: To go to the page corresponding to the URL, click the title area.

- URL: You can enter a URL for the title as needed.
- _blank

Bl If you select this option, you can open a web page on the preview or publish
page.
B If you clear this option, the page corresponding to the URL is directly

displayed.

Data

value : (optional) title name. The title name set here will overwrite the title name
set in the configuration pane.
O3
= | Note:
You can leave this field empty, and the system will obtain the title from the
configuration pane.
- URL: (optional) title URL. The URL set here will overwrite the URL set in the

configuration pane.



Title

Common Title Interface (O

ptional, Get from the Con... I

Field Mapping Status
Value Field | value s Field not found

Data Source Type

Ctatic Data

"This Is Title

This Is Title

"wvalue”:
“url .
JL

]

Interaction
This widget is not connected to any events yet.

6.12.4 Marquee

The marquee widget allows you to customize the text to be displayed, the text style,

the loop time, the loop speed, and other options as needed.

Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Text Style

- Font Color: To change the font color of the displayed text, see Color picker.

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Font Size: To set the font size of the displayed text, enter a value or drag the
slider.

- Font Weight: To set the font weight of the displayed text, click the drop-down
arrow and select the target font weight.

- Loop: If you select this option, the text is continuously displayed in a loop. If you

clear this option, the text is displayed only once.

- Fixed Speed: If you select this option, you can set the animation interval. If you

clear this option, you can set the animation duration.

- Duration: To set the time for displaying the text once, enter a value, or click + or -.

The unit is milliseconds.

- Pre-Animation Stop Time: To set the pause time before the text is displayed, enter a

value, or click + or -.

- Post-Animation Stop Time: To set the pause time after the text is displayed, enter a

value, or click + or -.



Marquee

Basic Atinbutes

Size

Position

Others

» Text St}!‘lE

Font Color Il #rrFDs66

[j)ataV Visus

Font Family 3 Microsoft YaHei

Font Size a

Font Weight

Loop
Fixed Speed
Duration

Pre-Animation

Stop Time

Post-Amimation 0

Stop Time




Data

—
-

Marquee

Marquee Interface » Completed

Field Mapping Status

= Matched
value -
Successtully

Data Source Type
Static Data

r

-L m m " L] -
value™: "DataV visuali:

1

i

] |

Data filter:

Auto Data Request: Every Second

value :text to be displayed
Interaction

This widget is not connected to any events yet.



6.12.5 Word cloud

The word cloud widget allows you to customize the style and shape of the word clouds

and the data values as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.
- Max Font Size: To set the maximum font size of the displayed text, enter a value
or drag the slider.
- Min Font Size: To set the minimum font size of the displayed text, enter a value
or drag the slider.
- Shape: To display the shape of the word cloud, click the Eye icon.

- Image: To delete the image, click the Delete icon in the dashed line box. You can
enter an image URL or drag an existing image to the dashed line box from your

local server.

« Global Settings

Font Family @ Microsoft YaHei

Max Font Size —H

12

laodaiwang.com

.l-:;gZa lipay.com

Min Font Size -l

L
=
H
10

_dlipayobjects_comfrms




- Series: To add or delete a series, click + or click the Trash icon.

- Series Color: To change the font color of the text of each series, see Color picker.

Ceries 2 Cenes 3

Bl #94E08A

Data
name :The name displayed in the widget.

value :The weight of a name. This field determines the font size of the text.



—
-

Word Cloud

Word Cloud Interface s Completed

Field Mapping Status

= Matched
Successfully
= Matched
Successfully

name

value

Data Source Type

Ctatic Data

"name" :
"value”:
‘lt}pr" . i

"name" :
"walue™: 1,
m t }fpe L1 : 5

"name" :

"wvalua":
‘lt}fpe L1

Data filter:

Auto Data Request: Every

)
|:| Note:
The widget sorts the data and then renders the series style according to the data

sequence.



The following is an example:

[

‘l{; name 1. n l n
. b

" value ": 321

1,

{

n name ll: n 2 II’

" value ": 21

1,

‘l{; name 1" . n 3 n
. b

" value ": 2

1,

{

n name ll: n 4 II’

" value ": 1

}

]

The configuration items are as follows: series 1:"red", series 2:"blue", series 3:"yellow

"
The rendering result is as follows: name:1 => "red", name:2 => "blue",;name:3 =>"
yellow",name:4 => "red".
Interaction
This widget is not connected to any events yet.

6.12.6 Carousel list |

The carousel list I widget allows you to customize the carousel list style, the

animation and display of content in the carousel list, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Settings

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Duration: To change the animation duration, enter a value, or click + or -. The
unit is milliseconds.

- Padding: To adjust the spacing between the rows, enter a value, or click + or -.

- Quantity: To change the number of rows to be displayed on each page, enter a
value, or click + or —.

- Loop

B If you select this option, text in the carousel list is automatically displayed in
rotation.
B If you clear this option, text in the carousel list is displayed only once.
il
= | Note:
The loop function will take effect a few seconds after you select it.
- Loop Time: To change the time interval between the display of two pages, enter a

value, or click + or —. The unit is milliseconds.

~ Global Settings

Font Family & Microsoft YaHei

Duration (ms) 500
Padding
Quantity
Loop @

LCH]p Tirn e

(ms)




- Index: To display the index numbers, click the Eye icon.
- Text Style

B Font Size: To change the font size of the index numbers, enter a value, or click
+or-.

B Font Color: To change the font color of the index numbers, see Color picker.

B Font Weight: To set the font weight of the index numbers, click the drop-down
arrow and select the target font weight.

- Width: You can customize the width of the space occupied by the index numbers

as needed. The unit is pixels.

- Padding: To adjust the spacing between the index numbers and the displayed

text, enter a value, or click + or -.

Font Size 16

Font Color I #FFF

Font Weight normal
Width auto

Padding 10




- Content
- Text Style

B Font Size: To change the font size of the displayed text, enter a value, or click +
or -.

B Font Color: To change the font color of the displayed text, see Color picker.

B Font Weight: To set the font weight of the displayed text, click the drop-down
arrow and select the target font weight.

- Marquee: To display the marquee style, click the Eye icon.

B Duration: To change the time for displaying the text that exceeds the length of

the row, enter a value, or click + or -. The unit is milliseconds.

= Content

Font Size

Font Color I #FFF

Font Weight  normal

Duration (ms) 2000

- Bar: To display the row style, click the Eye icon.

- Color: To change the color of the rows, see Color picker.

- Height: To change the height of the rows, enter a value, or click + or -.

» Bar

Color #ODBAFF

Height




- Light: To display the light style, click the Eye icon.

- Color: To change the color of the light sweep, see Color picker.

- Width: To change the length of the light sweep, enter a value, or click + or -.

- Height: To change the height of the light sweep, enter a value, or click + or —. The
part of the light sweep that exceeds the dimensions of the row is not displayed.

- Duration: To change the time interval between the display of two light sweeps,

enter a value, or click + or -. The unit is milliseconds.

Color Il #25FsFF

Width
Height

Duration (ms)

- Segment: To display the segments, click the Eye icon.

- Color: To change the color of the segments, see Color picker.

- Height: To change the height of the segments, enter a value, or click + or -.
« Segment

Color Il RGBA(D,186.2550.1) @

Height

Data

value :value in each row of the carousel list. The value of this field corresponds

to the length of each row with data being displayed according to the corresponding
values.

content :text displayed in each row of the carousel list.



Data Source Type
Static Data
I}
L

et "walue”: "203711893.83",
NO.1 1 rectangular length of the variab “content”: "Sector Grapf

. ]

NO.2 aph, Also known as ( Pie Graph )
|

. “value”: "193691138.91",
NO.3 scatter diagram “content”: "Lint Chart™

NO.4 Lint Chart "value": "2937110893.63",
| "content”: “scatter diag

fNrJ.S I b

| L. .. e . i
I\ o value”: 3128534.18",
“content™: "Leaderboard:

Interaction
This widget is not connected to any events yet.

6.12.7 Ticker board

The ticker board widget allows you to customize the ticker board style, the displayed

content, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Settings
- Text Style

B Font Family: To set the font of the displayed text, click the drop-down arrow
and select the target font. The default font is Microsoft YaHei.
- Arrangement: To set the position of the title, click the drop-down arrow and

select the target position.

B Top
B Left
B Bottom
- Margin: To adjust the spacing between the title and the number, enter a value or

drag the slider. The value range is from -100 to 500.

+ Global Settings

Font Family & Microsoft YaHei
Arrangement | Top

Margin
0




- Title

- Title Name: You can set a title for the ticker board as needed. The system can

also obtain the title name from the data pane.

- Text Style

B Font Size: To change the font size of the title text, enter a value, or click + or -.

H Font Color: To change the font color of the title text, see Color picker.

B Font Weight: To set the font weight of the title text, click the drop-down arrow
and select the target font weight.

=~ Title

Title Name &  Title Name

Font Size

Font Color [l RGBA(255,255,

Font Weight normal




- Ticker Board

- Font Family: To set the font of the text on the ticker board, click the drop-down

arrow and select the target font. The default font is Microsoft YaHei.

- Horizontal Alignment: To set the horizontal alignment method of the text on the

ticker board, click the drop-down arrow and select the target alignment method.

B Align left
B Align right
B Center alignment

- Prefix

B Content: You can customize the prefix of the number on the ticker board as

needed. The default prefix is $.
B Text Style

B Font Family: To set the font of the prefix, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

B Font Color: To change the font color of the prefix, see Color picker.
B Font Size: To change the font size of the prefix, enter a value, or click + or -.

B Font Weight: To set the font weight of the prefix, click the drop-down arrow
and select the target font weight.



= Ticker Board

Font Family & Microsoft YaHei

Hornzontal Align Left

Alignment

= Prefix

Content

Font Family ~Microsoft YaHei

Font Color [} #FFFFFF

Font Size 43

Font normal

Weight

- Numbers
B Text Style

B Font Color: To change the font color of the number, see Color picker.

B Font Size: To change the font size of the number, enter a value, or click + or
B Font Weight: To set the font weight of the number, click the drop-down
arrow and select the target font weight.

B Margin Right: To adjust the spacing between the digits, enter a value or drag
the slider. The value range is from 0 to 100.

B Background Color: To change the color of the blocks under the number, see
Color picker.

B Background Radius: To change the radius of the blocks under the number,

enter a value or drag the slider. The value range is from 0 to 100.



B Thousands Separator Background: If you select this option, the block under
the thousands separator is displayed. If you clear this option, the block under
the thousands separator is not displayed.

B Default Digits: To change the number of digits to be displayed, enter a value

or drag the slider. The value range is from 0 to 100.

Note:
If the set value is smaller than the number of the actual digits, the system
will hide the first N digits. If the set value is greater than the number of
the actual digits, the system will add N zeros to the data value. (N is the
difference of the set value and the number of the actual digits.)
B Rounding: If you select this option, the data value is rounded. If you clear this
option, the data value is not rounded.
B Thousands Separator: If you select this option, a thousands separator is
displayed. If you clear this option, no thousands separator is displayed.
B Thousands Separator Symbol: You can customize the thousands separator

symbol as needed.

Note:
Only one character is allowed. If more than one character is input, the first

character will be used. Numbers cannot be used as separators.

B Decimal Symbol: You can customize the decimal symbol as needed.

Note:



Only one character is allowed. If more than one character is input, the first

character will be used. Numbers cannot be used as separators.

~ Text Style

Font Color [l #00COFF
Font Size 48 +

Font bolder
Weight

Margin Right

Background [l RGBA(51,51,51,0) [

Color
Background

Radius

Thousands
Separator

Background

Default Digits

Rounding

Thousands

Separator

B Always Animation: If you select this option, the ticker board scrolls regardless
of whether the data changes. If you clear this option, the ticker board does
not scroll when the data does not change.

3
=] Note:



The animation always turns on even the input data does not change.
B Animation Duration: To change the animation duration, enter a value, or click

+ or —. The unit is milliseconds.

B Data Correction: If you select this option, only the data rise trend is displayed.

If you clear this option, both the data rise and fall trends are displayed.



- Suffix

- Content: You can customize the suffix of the data value on the ticker board as
needed. The default suffix is Dollar.

- Text Style

B Font Family: To set the font of the suffix, click the drop-down arrow and select

the target font. The default font is Microsoft YaHei.
H Font Color: To change the font color of the suffix, see Color picker.
B Font Size: To change the font size of the suffix, enter a value, or click + or —.

B Font Weight: To set the font weight of the suffix, click the drop-down arrow
and select the target font weight.



Thousands
Separator

Symbol @

Decimal

Symbol @&
Fixed Width

Always

Animation @

Animation

Duration (ms)

Data

Correction (@
Suffix

Content Dollar

Font Family Microsoft YaHei

Font Color [} #FFFFFF

Font Size 30

Font bolder
Weight

- Interaction: You can set the callback ID for the widget as needed. You can use a
field specified in the data pane to implement data interaction between different

widgets.

@ Notice:

The interaction function has been migrated from the Configuration pane to the

Interaction pane. Please upgrade your widget as soon as possible.



« Interaction

Callback ID &

Data

name : (optional) title of the ticker board. The title you set here will overwrite the
title you set in the configuration pane.

value :datavalue on the ticker board.

prefix : (optional) prefix of the data value on the ticker board. The prefix you set
here will overwrite the prefix you set in the configuration pane.

suffix :(optional) suffix of the data value on the ticker board. The suffix you set

here will overwrite the suffix you set in the configuration pane.

Ticker Board

Ticker Board Number Interf

» Completed
ace

Field Mapping Status

name = Optional

» Matched

value ~
Successfully

prefi = Optional

suffix = Optional

Data Source Type
Static Data

r
L m Ll
name"™ :
“value”:
JL

]




Interaction

To enable the interaction function, select Enable. For more information, see Configure

callback IDs for ticker boards.

6.12.8 Text box

Style

The text box widget allows you to enter and style the body text in a project.

- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.

- Content: You can customize the content to be displayed. The system can also obtain

content from the data pane. If you set content in both the configuration and data

panes, only the content set in the data pane is displayed.

- Text Scroll

- Overflow Scroll: If you select this option, when text is displayed, the text will be
automatically scrolled if text exceeds the dimensions of the text box. If you clear
this option, you need to move your pointer over the text box to view text that
exceeds the dimensions of the text box.

- Duration: To set the scroll duration, enter a value, or click + or -. The setting

takes effect only when you select Overflow Scroll.

- Text Style

Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Font Size: To change the font size of the displayed text, enter a value, or click + or

- Font Color: To change the font color of the displayed text, see Color picker.

- Font Weight: To set the font weight of the displayed text, click the drop-down

arrow and select the target font weight.

- Line Height: To adjust the line spacing, enter a value or drag the slider.

- Text Align: To set the text alignment method, click the drop-down arrow and select

the target method. The align method includes Align Left, Align Right, and Center
Alignment. The default method is Align Left.



- Text Indent: To adjust the indentation, enter a value or drag the slider.

¥ Text Scroll

~ Text Style

Font Family
Font Size

— _ e ———— . Font Color Il #FFF
| DataV provides a variety of scene

i L Font ".."\"Eight |ighter
templates such as dynamic live

j)rnﬂdcasting, comprehensive data Line Height

idisplay, and equipment monitoring

;and early warning. With a few

Text Align Align Left

Text Indent |




Data

—
-

Text Box

Paragraph Interface (Optio

nal, Get from the Configu... ST

Field Mapping Status

value = Optional

Data Source Type
Static Data

"walue"”: "DataV provide:
1
J

] |

Data filter:

Auto Data Request: Every

value :content displayed in the widget. Specific HTML tags, for example, a and
br, are supported. The content you set here corresponds to the Content in the
configuration pane. If you set the content in both the configuration and data panes,

only the content set for the value field in the data pane is displayed.



DataV provides a variety of scene

templates such as dynamic live Content @
j)rnadcasting, comprehensive data y Text Scroll

Hisplay, and equipment monitoring
: w Text Style

éand early warning. With a few

SR— - E— Font Family & Microsoft YaHei
Interaction
This widget is not connected to any events yet.
6.12.9 Percentage bar chart

The percentage bar chart widget allows you to customize the chart style, the

percentage value, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global Options

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Bar Padding: To adjust spacing 1 (spacing between the percentage bar and the
left border) and spacing 2 (spacing between the percentage bar and the right
border), enter a value or drag the slider. The value range is from 0 to 100.

- Spacing of Text and Bar: To adjust the spacing between the text and the
percentage bar, enter a value or drag the slider. The value range is from -50 to

50.

+ Global Options

Font Family & Microsoft Yahei

Bar Padding W

Spacing of

Text and Bar




- Tip

- Font Size: To change the font size of the percentage value, enter a value or drag
the slider. The value range is from 10 to 100.

- Font Color: To change the font color of the percentage value, see Color picker.

- Font Weight: To set the font weight of the percentage value, click the drop-down
arrow and select the target font weight.

- True Value: If you select this option, the data value corresponding to the
percentage value is displayed. If you clear this option, the percentage value is
displayed.

- Show Border: If you select this option, the border of the prompt box is
displayed. If you clear this option, the border of the prompt box is not displayed.

- Decimal

B Decimal Point: If you select this option, the numerical value of the percentage
value is displayed as a decimal number. If you clear this option, the numerical
value is displayed as a whole integer.

B Decimal Num: To change the number of digits to the right of the decimal

point, enter a value or drag the slider. The value range is from 1 to 4.

Note:



The Decimal Num option is displayed only when Decimal Point is selected.

= Tip

Font Size

Font Color I #FFF

Font Weight  normal
True Value
Show Border

= Decimal

Decimal Point

Decimal Num B

- Percentage Bar

- Gradient Range: To set the gradient range of the percentage bar, click the drop-

down arrow and select the target range.

B Global gradient
B Local gradient

- Start Color: To change the start color of the gradient colors, see Color picker.

- End Color: To change the end color of the gradient colors, see Color picker.

- Density: To change the number of segments in the percentage bar, enter a value
or drag the slider. The value range is from 1 to 50.

- Border Hidden: If you select this option, the borders of the percentage bar are

hidden. If you clear this option, the borders of the percentage bar are displayed.

- Sum: To set the value to be displayed when the percentage value is 100%, enter a

value, or click + or -.

@ Notice:



The percentage value = Value/Sum. The value is obtained from the Data pane.

= Percentage Bar

Gradient Local Gradient

Range

Ctart Color #ODBAFF

End Color I #3DE7CO

Decsity

Border Hidden

Sum (@
Data
value :numerical value in the percentage bar. The percentage value = Value/Sum.

Data Source Type

Static Data

R " 750% 4

Interaction

This widget is not connected to any events yet.



6.12.10 Status card

The status card widget allows you to customize the card style, the content of different

statuses, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Global Settings

- Auto: If you select this option, the statuses are displayed in the same row. If you

clear this option, the statuses are displayed randomly.

- Row Number: To set the number of statuses displayed in a row, enter a value, or

click + or -.

E] Note:

The Row Number parameter is displayed only when Auto is not selected.

« Global Settings

Row Number 2




- Margin

- Horizontal: To adjust the horizontal spacing between the statuses, enter a value
or drag the slider. The value range is from 0 to 100.

- Vertical: To adjust the vertical spacing between the statuses, enter a value or

drag the slider. The value range is from 0 to 100. The setting takes effect only

when Auto is not selected.

~ Margin

Honzontal |

0

- Text Style

- Font Family: To set the font of the displayed text, click the drop-down arrow and
select the target font. The default font is Microsoft YaHei.

- Font Size: To change the font size of the displayed text, enter a value, or click + or

- Font Color: To change the font color of the displayed text, see Color picker.

- Font Weight: To set the font weight of the displayed text, click the drop-down

arrow and select the target font weight.

~ Text Style

Font Family & Microsoft YaHei

Font Size 16

Font Color Il #FFFFFF

Font Weight normal




- Status List: To add or delete a status, click + or click the Trash icon.

- Status Name: You can set a name for a status as needed.

@ Notice:

The status name must match the value field in the Data pane.

- Status Colors: To change the color of the status icon, see Color picker.

« Status List

Status Name (3) SUCCESS

Status Colors Il #00FFo1

- Dot Style

- Position: To set the position of the status block, click the drop-down arrow and

select the target position.

B Front
B Behind
- Radius Size: To change the radius of the status block, enter a value or drag the

slider. By default, the block is a square shape. The value range is from 0 to 1.

w» Dot Style

Position Front

Radius Size

Data
name : title of a status

value :status type. The status type you set in the Data pane must match the Status

Name in the Configuration pane.



Status Card

Status Card Interface s Completed
Field Mapping Status
name = Optional

value = Optional

Data Source Type

Static Data

[ I

“name”: "Support JSON Fr
AA A "value™: "error”

Support JSON Fromat- -8 Suppert.amay format

"Support array format",
"success”

"AAA"
“suspend”

"BBB",

"error”

Interaction
This widget is not connected to any events yet.

6.12.11 Label board

The label board widget allows you to customize the label style, the content of different

label types, and other options as needed.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global

- Auto Mode: If you select this option, the width of the table is automatically
adjusted according to the label content. If you clear this option, the label
content is displayed randomly. You need to set the number of rows and the

margins.

Note:



Options such as Number of Rows, Number of Columns, Margin Right, and
Margin Bottom are displayed only when you clear the Auto Mode option.
Number of Rows: To adjust the number of rows in the label board, enter a value,
or click + or -.
Number of Columns: To adjust the number of columns in the label board, enter
avalue, or click + or -.
Margin Right: You can adjust the horizontal margin between the labels as
needed. The unit is pixels.
Margin Bottom: You can customize the vertical margin between the labels as
needed. The unit is pixels.

Text Style

B Font Family: To set the font of the displayed text, click the drop-down arrow
and select the target font. The default font is Microsoft YaHei.

~ Global

Auto Mode

Mumber of

Rows

Mumber of

Columns

Margin Right

Margin

Bottom

tyle

Font Family & Microsoft YaHei




- Default Label

- Padding: You can customize the padding between the label content and the label

borders as needed. The unit is pixels.

- Border Radius: You can customize the border radius of each label as needed.

The unit is pixels.

- Background Color: To change the background color of the default labels (that is,

labels that do not have the type value in the data pane), see Color picker.

- Text Style

B Font Size: To change the font size of the text of the default labels, enter a value

or drag the slider. The value range is from 0 to 100.
H Font Color: To change the font color of the text of the default labels, see Color

picker.

B Font Weight: To change the font weight of the text of the default labels, click

the drop-down arrow and select the target font weight.

w» Default Label

Padding
Border Radius

Background #O0BAFF

Color
.tﬂ .

Font Size

Font Color Il RGBA(255,255,2550 @

Font Weight normnal

- Series: To add or delete a series label, click + or click the Trash icon.

- Label Type Name: You can set a name for a series label as needed.

@ Notice:



The label type name must match the data format of the type field in the Data
pane.
- Background Color: To change the background color of the labels of the same

type, see Color picker.

- Text Style

B Font Size: To change the font size of the label text, enter a value or drag the

slider. The value range is from 0 to 100.
H Font Color: To change the font color of the label text, see Color picker.

B Font Weight: To change the font weight of the label text, click the drop-down

arrow and select the target font weight.

Label Type

Mame (&

Ba cl-::gr:::und - #3IDETCO

Color

Font Size

Font Color RGBA(D,0,0,0.8)

Font Weight  normal

Data

content :label content

value :label type (series) name. The value in the Data pane must be match the

Label Type Name in the Configuration pane.



=
4

Label Board

Text Label Interface = Completed

Field Mapping Status

conten = Matched
t Successfully

type = Optional

Data Source Type
Static Data

Sports pion...

[ r
": "Baby in Hou:
"seriesl”

": "Fashionista'
"series1”

“content”™: "Foodie”

Interaction
This widget is not connected to any events yet.

6.12.12 Timer

You can add one or more timers to a project to record the time.
Style
Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Icon Style

- Size: To set the size of the icon, enter a value or drag the slider. If no icon is
needed, set the value to 0.

- Color: To change the color of the icon, see Color picker.

- Margin: To adjust the spacing between the icon and the timer, enter a value or

drag the slider.

« Icon Style

S ——

Y 2018-11-08 15:22:47

ssafpesasansas

Color Il RGBA(93

Margin = |




- Timer

- Text Style: You can customize the text style of the timer as needed, including the

font, the font size, the font color, and the font weight.

- Format: You can customize the time format as needed. The default format is
yyyy-MM-dd HH:mm:ss (that is, 24-hour time format). hh:mm:ss indicates the

12-hour time format.

- Duration: You can set the interval at which the widget updates the time. The
unit is milliseconds. For example, if you set this parameter to 10000, the time

changes at an interval of 10 seconds.

w» Timer
= Text Style

Font Size

Font Color - #FFFFFF

Font Weight normal

Font Family @ Microsoft YaHei
Format & HH:mm:ss
Duration (ms) 1000

Stop Time

(ms)

Stop Show

Time (ms)

- Stop Time: You can set the time when the recording stops. The time format must

be the same as that you set for Format.

- Stop Show Time: You can set the time to be displayed when the recording stops.

The time format must be the same as that you set for Format.
Data
You do not need to configure data for this widget.
Interaction

This widget is not connected to any events yet.



6.13 Networks
6.13.1 Network diagram

This topic uses the network diagram widget as an example to describe how to

configure networks widgets.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.
- Others: Set the rotation angle and opacity of the widget.

- Background Color: To change the background color of the network diagram, see

Color picker.



- Force

- Margin: To adjust the position of the force-directed graph in relation to the
borders, enter a value, or click + or -.

- Charge: To adjust the force of the nodes, enter a value, or click + or -. The larger
the value is, the denser the nodes are clustered.

- Charge Distance: To adjust the margin between the nodes, enter a value, or click
+or-.

- Gravity: To adjust the gravity of the nodes, enter a value, or click + or -. The
larger the gravity is, the denser the nodes are clustered.

- Friction: To adjust the friction between the nodes, enter a value or drag the

slider. The value range is from 0 to 1.

Background

Color
+ Force
* -~ Margin

Top

Bottom

aﬂﬁq el

. ..hl!"| lod et

helloS hello

helio] Right
Charge
hello3
Charge

Distance
Gravity

Friction




- Label

- Font Color: To change the font color of the label text, see Color picker.

- Font Size: To set the font size of the label text, enter a value or drag the slider.

- Font Weight: To set the font weight of the label text, click the drop-down arrow
and select the target font weight.

- Text Align: If you select this option, the label text is set in a position relative to

the center of the nodes.

« Label

. . Font Color Il RGBA(255,2552550 @
hellofeliohglio2

.I. Font Size

hgﬁ ® hellog 02

hellol

. Font Weight  normal
hello3

- Text Align [v]




- Link Options

- Stroke Color: To change the color of the lines, see Color picker.

- Stroke Width: To change the width of the lines, enter a value or drag the slider.

- Distance Default: To change the length of the lines, enter a value, or click + or -.

- Distance Min: To change the minimum length of the lines, enter a value, or click
+or-.

- Distance Max: To change the maximum length of the lines, enter a value, or

click+ or —-.

w Link Options

Ctroke Color

Ctroke Width

= o hellaT

. Frelio

heelll

@r--: hellal Distance

hellos Default

Distance Min

Distance Max




- Node Options

- Class Name: You can enter a name for the center node.
- Radius: To change the radius of the center node, enter a value or drag the slider.

- Fill: To change the fill color of the center node, see Color picker.
- Stroke Color: To change the outline color of the center node, see Color picker.

- Stroke Width: To change the outline width of the center node, enter a value or

drag the slider.

~ Node Options

Class Name default

hellogg . Radius el |
hellojhello 0

hellpghell

. ellos
el ‘ Fill - #EDEDED

hellod

Stroke Color #F5222D

Stroke Width




- Series Options: To add or delete a node, click + or click the Trash icon.

- Class Name: You can enter a name for the type. If the name is not set for the type
field in the data pane, the default name is used.

- Radius: To change the node radius of the same type, enter a value or drag the
slider.

- Fill: To change the fill color of the nodes, see Color picker.
- Stroke Color: To change the outline color of the nodes, see Color picker.

- Stroke Width: To change the outline width of the nodes, enter a value or drag the

slider.
« Series Options

L] Senes 1

I

hello _Ilc. Class Name group2

heliog el i
Radius — N1

. ‘l lo5 o

hellol hellod

hellc9
Fill Il #FFA39E

Stroke Color Il #3DE7CO

Stroke Width




Data

—
-

Network Diagram

Metwork Diagram Interface s Completed

Field Mapping Status

= Matched
Successfully
= Matched
Successfully

nodes
links

Data Source Type

Ctatic Data

llimgpathll: IIIIJ‘
"name”: "hellol™,
..t}fpen : "Er‘-c'up"

"imgPath": »
"name”: "hello2™,
..t}fpen : "Er‘-ﬂup'l”

"imgPath": »
"name”: "hello3™,
..t}fpen : "Er‘-ﬂup'l”

Data filter:

Auto Data Request: Every




nodes :node in the network diagram. The following fields are included:

imgPath :image URL. If this field is empty, the nodes are displayed as circles
by default.

name :node name.

type :node type. You can set the type in Class Name in the configuration pane.
As shown in the preceding figure, the node whose type issetto groupl uses

the name of groupl .

= Series Options

Class Name group 1

links :links in the network diagram. The following fields are included:

Data Source Type

Ctatic Data

"imgPath™: N
"name™: "hello2™,
..t}fpel.: llgrlclup.lll

"imgPath™: N
"name™: "hello3™,
..t}fpel.: llgrlclup.lll

"imgPath™: N
"name™: "hello4™,
..t}fpel.: llgrlclupzll

source :source node of the lines. The value of this field is the same as the

name of the source node.

target :destination node of the lines. The value of this field is the same as the

name of the destination node.

value :line length.



Interaction

This widget is not connected to any events yet.

6.14 Materials
6.14.1 Customized background

The customized background widget allows you to add a background to one or more
widgets.
Style
- Basic Attributes
- Size: Set the size of the widget by adjusting its width and height.

- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Custom Style: If you select this option, you can customize the background style
as needed. If you clear this option, you can customize the background color and

border radii.

1/}

Customized Background

Basic Attnbutes

Hze

Position

Others

Custom Style
» Custom Background Style
» Filter

¢ Backdrop Filter @




{1

Customized Background

Basic Attnbutes

Position

Others

Custom Style

Background RGBA(D

Color
b Border Radius

¢ Filter

¢ Backdrop Filter &

- Background Color: This option is displayed when you do not select Custom Style.

To change the background color of the widget, see Color picker.

- Border Radius: This option is displayed when you do not select Custom Style. To
adjust a border radius, such as the radius in the top left corner, bottom left corner,

top right corner, and bottom right corner, enter a value or drag the slider.



- Custom Background Style: This option is displayed when you select Custom Style.

- Border Image Source: To change the image in the box, click the Trash icon and
upload a local image. To use an image from the Internet, enter the URL of the
image.

- Slice: If you select this option, the borders of the image are cropped to fit.

- Border Image Style: To adjust the width of the borders of the image, enter a

value. The setting takes effect only when you select Slice.

- Border Style: To change the border style, click the drop-down arrow and select

the target style. The borders can be solid, dashed, or dotted.
- Border Width: To adjust the border width, enter a value. The unit is pixels.

- Inner Background: To change the color of the inner background, see Color picker.

- Background Color: To change the color of the outer background, see Color picker.

w» Custom Background Style

Border Image ¢ hitps:/fimg.alicdn.com/tps/T

Source

Shice

Border Image

St}’lE!
Border Style solid
Border Width  14px

Inner #TAZTAD

Background

Background Il #rFD666

Color

- Filter: To adjust the blurring of the widget border, enter a value. The unit is pixels.



- Backdrop Filter: To adjust the blurring of the widget background, enter a value.
The unit is pixels. This option takes effect only when you enable Experimental Web

Platform features for your Chrome browser.

Note:

To enable Experimental Web Platform features, follow these steps:

1. Open the Chrome browser and enter chrome: //flags/#enable-experimental-

web-platform-features.

2. Click the drop-down arrow next to Experimental Web Platform features and

select Enabled.

3. Restart the browser.
Data

You do not need to configure data for this widget.

Note:

This widget can be extended to be a line.
Interaction
This widget is not connected to any events yet.
6.14.2 Border
The border widget allows you to add a border to one or more widgets.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Border: To set the border style, click the drop-down arrow next to Style, and select

the target style. Currently, 11 styles are available.

Border

Basic Attributes

Position

Others

« Border

St}’ltﬂ

Data
You do not need to configure data for this widget.
Interaction

This widget is not connected to any events yet.



6.14.3 Decoration

The decoration widget allows you to add a decoration to one or more widgets.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global

- Decorations: To add a decorative element for a widget, click the drop-down
arrow and select the target element. Currently, 10 decorative elements are

available.

Decoration

Basic Attnbutes

Position

Others

w Global

Decorations

Opacity

- Opacity: To adjust the widget opacity, enter a value or click the drop-down

arrow.
Data

You do not need to configure data for this widget.
Interaction

This widget is not connected to any events yet.



6.14.4 Logo wall

You can add one or more logo walls to a project to display different logos.
Style
- Basic Attributes

- Size: Set the size of the widget by adjusting its width and height.
- Position: Set the position of the widget by adjusting its abscissa and ordinate.

- Others: Set the rotation angle and opacity of the widget.



- Global

- Border Radius: To adjust the border radius of each logo, enter a value or drag
the slider.

- Border Width: To change the border width of each logo, enter a value or drag the
slider.

- Border Color: To set the border color of each logo, see Color picker.

- Fill Type: To set the fill color type, click the drop-down arrow and select the
target type. The fill color can be one of the following types: default, contain, and
stretch.

- Row Number: To adjust the number of rows on a wall, enter a value, or click + or

- Column Number: To adjust the number of columns on a wall, enter a value, or
click + or -.

- Horizontal Interval: To adjust the horizontal spacing between the logos, enter a
value or drag the slider.

- Vertical Interval: To adjust the vertical spacing between the logos, enter a value

or drag the slider.

‘E - glﬂbﬂ

€ 2waces
Border Radius W

Border Width —H
1]

€] g oo

Border Color #1E3B55
Fill Type Default
Row Number

Colum
MNumber
Honzontal

Interval

Vertical

Interval




- Animate: You can customize the animation effect when multiple pages are

displayed on the wall.

- Loop: If you select this option, multiple pages on the wall are automatically
displayed in a loop.
- Pause: To change the time interval between the display of two pages, enter a

value, or click + or —. The unit is seconds.



- Dot: You can set the dot style as needed. To display the dots, click the Eye icon next
to Dot.

« Dot

Non-current

Color

Current Color [l #FFFFFF

Size

Paddin g

Vertical

Interval

- Non-current Color: To change the color of the dot corresponding to page that is
not displayed, see Color picker.

- Current Color: To change the color of the dot corresponding to page that is
displayed, see Color picker.

- Size: To adjust the dot size, enter a value or drag the slider.

- Padding: To adjust the spacing between the dots, enter a value or drag the slider.

- Vertical Interval: To adjust the spacing between the dots and the wall, enter a
value, or click + or -. If the value is a positive number, the dots move upwards. If

the value is a negative number, the dots move downwards.

« Dot

Mon-current
Color

Current Color [l #7FFFFF

Size — N

Paddin g

Vertical

Intendal




- Background Color: To add or delete a background color, click + or click the Trash

icon.

To change the background color of each logo, see Color picker.

E] Note:

If you add two or more background colors, DataV will distribute the colors among

the logos evenly.

» Dot

- i ]
- ] . : BaCkground -

Colorl Color2

L
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Data
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-

Logo Wall

Logo Wall Interface » Completed

Field Mapping Status

s Matched

value c
Successfully

Data Source Type

Ctatic Data

L
“"value™: "https://img.

“"value™: "https://img.
“"value™: "https://img.
“"value™: "https://img.

“"value™: "https://img.

Data filter:

Auto Data Request: Every Second

value : URL of each logo on the wall. Cross-domain configuration is required. We

recommend that you specify logo access through either HTTP or HTTPS. However,
note that HTTPS access cannot be used for a logo with an HTTP URL.

Interaction

This widget is not connected to any events yet.



7 Advanced skills

7.1 Configure VPC data source in DataV
DataV supports configuring a VPC-based database as a data source. For more
information, see VPC documents.
1. Log on to the DataV console, select Data Sources > Add Source.
2. Select RDS  for  MySQL fromthe Type drop-down list.

3. Click the secondary drop-down list and select Intranet .


https://www.alibabacloud.com/help/product/27706.html
http://datav.alibabacloud.com/

4. Turn on the VPC button and enter the relevant information in the required fields.

Type

RDS for MySQL

Intranet north east

Instance ID

Password




Instance ID

Password

Before submitting, please ensure:

1. the database is accessible to Intemet. (IP Whitelist
is not supported. Check detail:

2. the domain of the database can be parsed.

3. the database has been enabled and not blocked by
the firewall.

In addition to conventional database configurations, you must configure the VPC
ID and instance ID for the VPC database. Both IDs can be found in Alibaba Cloud

console.

If all the parameters are configured, the system will test the data source

connection automatically.

5. Click OK when the connection is verified.

You can now use the VPC database as a widget data source.



7.2 Widget interaction
Widgets can interact with each other through related callback IDs, see Configure

widget interaction. By using callback IDs, if you click a widget, data of a widget with the

corresponding callback ID will change accordingly.

Using a timeline widget as an example, with a callback ID, after you click a timestamp
the map widget displays detailed information of this timestamp, see Configure widget

interaction.

Timeline

Basic Atiributes

Size

Position

» Background

» Interaction

Set a callback ID

A callback ID can be considered as a parameter variable that is used to control the
transmission of parameters between widgets, and realize interactions between them
(that is, if data of one widget is updated, other widgets with the same callback ID are
also updated).

E] Note:

Callback ID is not supported if the Data Source Type is Static Data or
a CSv file .

For instance, if you click a scattered point in a map, click a row in a list, or select a
time point on a time table, the system temporarily stores the designated callback ID,

for example, name, into the name variable.



. Widget B:
Widget A Callback ID:

name select A,B from table

fields: name, value, ... where shop = :name

Set variable input

When the Data  Source Type is SQL or API, you can directly input the variable.

select : name as value
select A from table where year = : name

If you are using an API data source, the system directly assigns value to the variable

parameters with the same name.

7.3 Cross-origin data configuration
Background
If user A creates a visualization project in DataV, and selects API from the Data

Source  Type drop-down list (shown in the following figure), depending on where

the API is hosted, the following situations may occur.



Data Source Type

API

URL :

Configure callback parameter to URL, for
instance: http://api.test?value=:value

Initiate a request from a server (HTTP
proxy )

Cookie required (For use when proxy is
not selected and cookie is required)

- If the API is on a remote server and has access to a public network, select Initiate a
request from a server (HTTP proxy). The DataV backend server initiates a request
to the API at the same time. The request has a 10-second timeout and cannot be
changed.

- If the API is on a local server, deselect Initiate a request from a server (HTTP
proxy), and the interface needs to be configured across origins. The API is accessed
by alocal browser and the timeout duration is also determined by the local

browser.
What is an issue related to cross-origin data configuration

Assume that user A’ s website needs to include data from their own website and from
user B’ s website. Data on user A’ s website can be accessed by the website interface

<http://userA.com/pagel>. The website interface for user Bis <http://userB.com/



page2>. If user A uses a Javascript AJAX request to gain access to user B’ s website,

user A cannot retrieve data from userB.com.

If, for example, a Chrome browser is opened during the preceding request, the

following is displayed:
XMLHttpReq uest cannot load http :// userB . com / page2 .
Because no ¢ Access - Control - Allow - Origin ’ header is
present on the requested resource . Origin ¢ http :// userA

com /¢ s not allowed access .

This means we encountered a cross-domain issue.
Reason

Because each website contains various interfaces, such as user interface, order
interface and article interface, each user can put the data returned from those
interfaces on their own website. This means the browsers have a same-origin policy,

which restricts a script from one origin to obtain resources from another origin.

Note:
Same origin: If two pages have the same protocol (HTTP), port (80) and host

(userA.com), these two pages are considered to be from the same origin.
Solution
- Cross-origin between A.x.com and B.x.com

If the sub-origins for two sites are different, such as http://xyz.userA.com/ and http

://123.userA.com/, the cross-origin issue still exists.
To solve this issue, you must declare the page to a higher-level origin.

< script >
document . domain =" x . com ";
</ script >

- JSONP

Although JSONP is a commonly applied solution, it is vulnerable to Cross-Site
Scripting (XSS) attacks. Therefore, DataV does not support this method.
- Cross-Origin Resource Sharing (CORS)

Note:



Cross-Origin Resource Sharing (CORS) was introduced to solve issues related to

the sharing of restricted resources. Most new browsers are compatible with CORS.
Concept

Add the custom header information HTTP to user B’ s website (local API) so that

its resources can be accessed by other websites.
Example

- Header information returned from a data server includes the following basic

content:

Access - Control - Allow - Origin : http :// www . example . com

- Ifuser B’ s website interface data are used by many specified websites, the
header information must be generated dynamically. The following example uses
PHP:

<? php
if ( is_my_bast ard ($ _SERVER [' HTTP_ORIGI N '])) {

header (" Access - Control - Allow - Origin : {$ _SERVER ['
HTTP_ORIGI N 'J}");

+
? >
[73082)

- Ifuser B’ swebsite interface data are used by all the other websites, use

Access - Control - Allow - Origin : *

Cookie

By default, CORS does not contain cookie information. If you want to add cookies,

follow these steps:

1. Add the withCredentials parameter, such as jquery:

$. ajax ({
url : " http :// userB . com / disdad ",
xhrFields : {
withCreden tials : true
}
1)

2. Configure the server to allow headers with credentials and disallow the wildcard

7308

character , as follows:

<? php

if ( is_my_bast ard ($ _SERVER [' HTTP_ORIGI N '])) {
header (" Access - Control - Allow - Origin : {$ _SERVER ['
HTTP_ORIGI N 'J}"); // Disallow “x”



header (" Access - Control - Allow - Credential s : true ");
+
?

2 >

For more information, see HTTP access control (CORS).

7.4 DataV proxy configuration in Linux

With DataV data proxy services, you can configure safer data queries without the

need to apply database permissions or write APIs. The DataV data proxy services pass

encrypted SQL query strings and database ID values to applications that can connect

to the database, get query results, and return the results to the DataV page.

Click here to download a sample application published on GitHub. The application can

be deployed to an ECS instance. Before performing the following procedure, you need

to prepare the MySQL database and tables that need to be displayed.

The following procedure uses a Node.js sample application, or you can use a new

developed application.

1.

2.
3.
4.

Buy an ECS instance. You can use the lowest possible configuration and upgrade it

based on your requirements.

Deploy the code and start the service.
Configure the database.

Configure the database to DataV.

Purchase an ECS server

To purchase a cost-effective ECS server, we recommend you:

- Select Pay-As-You-Go as a billing option.

- Select Public Image from the Images section, and select CentOS 7.4 64-bit.

- Select PayByTraffic from the Network Billing Method section.

- Select a data disk if you have any special requirements.

- Select other configurations and complete the purchase according to the preceding

figure.

Deploy the code and start the service

1.

Implement the following commands to download the DataV proxy sample

application and extract it.

wget https :// files . alicdn . com / tpsservice / 3b30abflb9
f8a2056¢ccl 35d2a6587b b9 . zip


https://files.alicdn.com/tpsservice/3b30abf1b9f8a2056cc135d2a6587bb9.zip

unzip 3b30abflb9 f8a2056ccl 35d2a6587b b9 . zip
cd { decompress ed directory }

Notice:
If the system displays unzip command is not found, you need to first implement

yum dinstall unzip and then continue the following commands.

2. Implement the following commands to install Node.js and dependencies.

wget - g0 - https :// raw . githubuser content . com /
creationix / nvm / v@ . 33 . 11 / dinstall . sh | bash

bash

nvm install 8 .9

npm install pm2 - g

npm install -- registry = https :// registry . npm . taobao .
org

3. Implement the following command to run the DataV proxy sample application.
pm2 start app . js

4. Implement the following command to view the running status of the application.

pm2 status

If the running status is online, it indicates that the application is activated

successfully, and you can continue with the following steps:

- Implement node ./ bin / dinfo . js toview the domain name, port, Key,

Secret, and configured database information of the Data proxy.

Notice:



You need to save the information that is used when configuring a DataV data

source.
- To change the Key, use node ./ bin / genkv . js togenerate a new one.

- Access http :// domain name : port / status to verify server status.

The domain name is the public network IP of your ECS instance. The port is the

port you have identified, which usually is 9998 .
Configure the database

1. Database whitelist settings and authorize remote connections.
2. In the directory where DataVProxy is located, implement vim config . js ,

open config . js ,andadd a database tothe database filed, as shown in the

following example.

databases : [
{
id : ' test ', // Make sure that there are no
repeated IDs . Then , Anput them into the DataV
backend “ database ” fHield .

type : ' mysql ', // rds , ads
host : ' 127 . 0 . 0@ . 1 ', // Domain name and IP
address
user : ' root ', // User name
password : ' root ', // Password
database : ' test ', // Database name
port : 3306 // Port
s
{
//
b
//... Enter the database you want to add here .

]

3. After the configuration is complete, perform the following commands separately

and restart the MySQL database and the DataV proxy application.

systemctl restart mysqld . service
pm2 restart 0]

Configure the data source to DataV

1. Use the HTTP protocol to enter the DataV console.
2. Select Data Sources > Add Source.

3. On the New Data Source page, go to the Type drop-down list and select DataV Data

Proxy Service.


http://datav.alibabacloud.com/

4. Enter the information from the previous Deployment section (outlined in red) into

the following input box. For more information about the parameters, see Add DataV

Data Proxy Service.

Type

Diata\/ Diata Proxy Service

Mame

datav_proxy

Secret

Database

This approach requires you deploy open source code
nn FCE Thack fudansl-




5. In the data settings field, go to Data Source Type and select Database. Custom the

data source based on the preceding figure.
Data Source Type
Database
Select Data Source :

datav_proxy

Data filter:

Auto Data Request: Every

‘Wiew Data Response

Note:

- This service SDK only provides HTTP services. If you need HTTPS services, you
must apply for an HTTPS certificate recognized by Google Chrome.

- We recommend you enable HTTP services until the HTTPS certificate is applied.



o&M

- Check real-time logs

pm2 logs

- Check history logs

1s - al . /{ the directory
}/ logs

- Restart

pm2 restart all

- Start service

pm2 start app . js

where

DataVProxy

is

located
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